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머 리 말 

 

위대한�령도자�김정일원수님께서는�다음과�같이�말씀하시였다.�

《현대과학기술의 기초는 콤퓨터입니다. 콤퓨터가 출현하고 그에 따라 정보기술이 발전하면서 

사람들이 환상적으로만 생각하던 문제들이 현실로 되고있으며 자연을 정복하고 세계를 개조하는 

인간의 창조적힘은 더욱더 위력한것으로 되고있습니다.》 

현시대는�정보산업의�시대,�콤퓨터시대이다.�

이제는�누구나�다�콤퓨터기술을�배워�콤퓨터를�능숙하게�다룰줄�알아야�한다.�

위대한�령도자�김정일원수님의�현명한�령도에�의하여�우리의�과학과�기술은�급속히�

발전하고있으며�인민경제�여러�부문에�콤퓨터기술이�널리�도입되여�커다란�성과가�이룩되

고있다.�

나라의�인재양성에�커다란�관심을�돌리고계시는�위대한�령도자�김정일원수님께서는�

우리�학생들이�배움의�나래를�활짝�펴고�사회주의강성대국의�밝은�앞날을�떠메고나갈�유능

한�인재로�자라날수�있도록�크나큰�사랑과�은정을�돌려주고계신다.�

3학년�《콤퓨터》에서는�먼저�콤퓨터에서�정보의�표현방법과�그�원리,�콤퓨터의�

기본구성부분인�하드웨어와�쏘프트웨어�그리고�콤퓨터비루스의�종류와�그�방지대책에�

대하여�배운다.�

다음으로�통합사무처리프로그람�《우리》의�문서편집프로그람�《글》에서�문서를�

만드는�방법,�표계산프로그람�《표》에서�자료처리방법에�대하여�배우며�자료기지관리

프로그람�《자료기지》에서�양식을�리용한�자료기지의�만들기와�자료기지에서�질문작

성,�보고서�만드는�방법에�대하여�배운다.�

또한�다매체제작프로그람인�Flash�MX를�리용하여�동화상작품을�만드는�방법에�대

하여�배운다.�

우리들은�콤퓨터에�대한�학습을�열심히�하여�정보산업시대의�능력있는�과학자,�기술

자들로�준비함으로써�위대한�령도자�김정일원수님의�크나큰�믿음과�기대에�높은�실력으

로�보답하여야�한다.�

�

�
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제1장. 콤퓨터에 대한 기초지식 

제1절. 콤퓨터에서의 정보처리 

1. 콤퓨터에서 정보의 표현 

�

�

�

�

콤퓨터는�전자회로로�구성되여있으므로�모든�작업이�전기에�의하여�진행된다.�

콤퓨터에서�자료를�나르는것은�전기모선이다.��

�

그림과�같이�8개의�전기모선에서�1로�표시된�전기가�흐르는�모선에는�불이�오고�0으

로�표시된�전기가�흐르지�않는�모선에는�불이�오지�않는다.�

이와�같이�콤퓨터에서�전자회로의�상태는�전기가�흐르는가(1)�흐르지�않는가(0)�하는�

두가지�상태만을�가진다.�그러므로�콤퓨터는�우의�그림과�같이�0과�1로�표시되는�자료들

을�가지고�동작한다.�그것은�전기로는�0과�1을�실현하는것이�가장�합리적이기때문이다.�

이렇게�콤퓨터회로에서�취급하는�신호는�모두�0과�1로�되여있으며�콤퓨터회로를�조종

하는�신호(언어)도�0과�1로�되여있다.�콤퓨터에서�0과�1만을�기록할수�있는�한자리�기록

위치를�비트(bit)라고�한다.�즉�콤퓨터에서�가장�작은�정보단위는�bit이다.�

비트는�0�또는�1만을�기록하기때문에�그�한개는�많은�정보를�담을수�없지만�그것들을�

여러개씩�묶으면�많은�정보를�기억할수�있다.�

콤퓨터는�기본적으로�8bit를�리용하여�하나의�문자나�수자를�표현한다.��

8개의�비트를�묶은것을�바이트(byte)라고�한다.�즉�

1byte�＝�8bit�

그러므로�그림에서�01111001은�1byte를�이룬다.��

1byte는�8bit로�구성되므로�2
8
＝256가지의�정보를�나타낼수�있다.�즉�1byte로는�영

어문자,�수자,�특수기호�등�256개를�표현할수�있다.�

바이트의�매�비트들은�오른쪽에서�왼쪽으로�가면서�0부터�7까지의�번호를�붙이도록�

약속한다.�

생각하기 

콤퓨터에서는�자료나�정보를�전기로�어떻게�표현하는가?�
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비트를�여러개�묶어서�바이트를�정의한것처럼�바이트를�묶어서�새로운�자료마당을�정

의한다.�

단어:���������2byte(16bit)�

배단어:�������4byte(32bit)�

4배단어:������8byte(64bit)�

파라그라프:��16byte(128bit)�

일반적으로�콤퓨터에서�쓰이는�정보단위는�다음과�같다.�

키로바이트(kB):��210byte(1�024byte)�

메가바이트(MB):�220byte(1�024kB)�

기가바이트(GB):�230byte(1�024MB)�

테라바이트(TB):�240byte(1�024GB)�

������…���������…��������…���������…�
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정보란 무엇인가? 

정보에�대한�정확한�개념은�한마디로�정의하기�어렵다.�그것은�형식이�다종

다양하며�사람이�감각기관을�통해서�직접�느낄수�있는�사물과�같은�실체가�아니

기때문이다.��

우리들이�늘�말하는�정보는�사물�그자체를�가리키는것이�아니라�사물이�직

접�나타내거나�사물에�의하여�전해지는�자료와�신호에�의해서�표현되는�내용들

이다.�례를�들어�이러저러한�자연환경을�볼�때�거기에는�아주�풍부한�정보가�담

겨져있다는것을�알수�있다.�

사람들이�글로�써서�전하는�문자자료도�정보이며�비행기,�배로부터�반사되

여오는�전자기파나�초음파�역시�정보이다.�

지진이�일어나기�전에�새가�울거나�개가�짖는것은�새나�동물들이�사람들이�

직접�느끼지�못하는�지진예보정보를�감수하기때문이다.�

하늘에서의�우뢰,�번개,�땅껍데기의�운동과�땅속의�광물,�우주의�천체들�등�

모든것들은�사람들에게�정보를�가져다준다.�

주위세계를�자세히�둘러보면�다종다양하게�변화되는�모든것은�모두�명확히�

우리들에게�어떤�정보를�준다.�그러므로�정보는�에네르기,�공기,�태양�등과�같

은�자연계와�사회,�사람들의�지식속에�존재한다.�

정보는�사물의�고유한�특징을�표시하는�보편적인�한�형식으로서�이것은�물

질세계의�하나의�주요측면이다.�통속적으로�간단히�말하면�신호를�통하여�전달

되며�리용될수�있는�소식,�자료,�지식의�총체가�바로�정보인것이다. 

알아두기 
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2. 수체계 

수자기호들로�임의의�수를�표시하는�방법의�총체를�수체계라고�한다.�

�

�

�

�

�

수체계에는�수자기호들이�놓이는�위치에�따라�수값이�달라지는�자리수체계와�수값이�

달라지지�않는�비자리수체계가�있다.�

비자리수체계는�수값이�수기호들이�놓여있는�자리에�의해서가�아니라�주로�수기호에�

의해서만�결정되는�수체계를�말한다.�

비자리수체계의�실례로서는�수기호들이�다음과�같은�로마수체계를�들수�있다.�

Ⅰ,�Ⅱ,�Ⅲ,�Ⅳ,�Ⅴ,�Ⅵ,�Ⅶ,�Ⅷ,�Ⅸ,�Ⅹ,�…�

자리수체계는�수들을�일정한�개수의�수기호들을�써서�표시하며�이�수기호들이�놓여있

는�자리에�따라�다른�값으로�표시하는�수체계를�말한다.�사람들은�흔히�자리수체계를�리용

한다.�자리수체계는�수를�표시하는데�쓰이는�수기호들의�개수에�따라�10진수체계,�2진수

체계,�8진수체계,�16진수체계�등으로�나뉘여진다.�

1) 10진수체계(Decimal Digit System) 

10진수체계는�우리가�보통�쓰고있는�수체계이다.��

10진수체계에서는�0,�1,�2,�3,�4,�5,�6,�7,�8,�9의�10개의�수기호로�모든�수를�표시

하며�9�다음에�자리올림이�생긴다.�또한�모든�수를�10의�제곱들의�합으로�표시할수�있다.��

x=a×10n-1+b×10n-2+…+p×101+q×100�

이때�10
n
을�무게,�10을�밑수라고�한다.�실례로�

76.52＝7×101＋6×100＋5×10-1＋2×10-2�

에서�101,�100,�10-1,�10-2들은�수�76.52의�무게이고�10은�밑수이다.��

그러므로�10진수체계는�10을�밑수로�하는�수체계라고�말할수�있다.��

우리는�어릴�때부터�10진수체계를�리용하는데�습관되여있다.�

사람들이�10진수체계를�써서�수를�표시하게�된것은�사람의�손가락수가�10개이기때문

이라고�생각한다.�

2) 2진수체계(Binary Digit System) 

2진수체계는�0과�1의�두가지�수기호로�모든�수를�표시하며�1�다음에�자리올림이�생긴

다.�례하면�10진수에서는�1+1=2이지만�2진수에서는�1+1=10이다.�즉�1�다음에�자리올림이

우리가�쓰고있는�수체계에는�어떤것들이�있는가?�

생각하기 
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생겨�10으로�되였다.�또한�모든�수를�2의�제곱들의�합으로�표시할수�있다.�즉�

x=a×2n-1+b×2n-2…+p×21+q×20�

이때�2
n
을�무게,�2를�밑수라고�한다.�실례로�

1101=1×23＋1×22＋0×21＋1×20�

101.11=1×22＋0×21＋1×20＋1×2-1＋1×2-2�

들에서�23,�22,�21,�20,�2-1,�2-2�등은�무게이며�2는�밑수이다.��

콤퓨터를�비롯한�수자회로에서는�2진수를�쓰고있다.�

콤퓨터에서는�전류가�흐른다,�흐르지�않는다라는�두가지�상태에서�흐르고있는�상태를�

1,�흐르지�않는�상태를�0에�대응시킬수�있으므로�회로를�실현하기�매우�편리하다.�즉�구별

할수�있는�두가지�물리적상태를�표현하는데�2진수체계를�리용하며�2진수체계에서의�더하

기,�덜기,�곱하기,�나누기와�같은�산수연산이�다른�수체계들에�비해�대단히�간단하므로�연

산회로를�구성하기�쉽다.�바로�이러한�리유로�하여�콤퓨터는�2진수체계를�리용하는�전자식

기계이다.�

3) 8진수체계(Octal Digit System) 

8진수체계에서는�0,�1,�2,�3,�4,�5,�6,�7의�8개의�수기호를�리용하여�모든�수를�표시

하며�수기호�7�다음에�자리올림이�생긴다.�즉�8진수체계에서는�10진수�8이�10으로�된다.�

또한�모든�수들을�8의�제곱들의�합으로�표시할수�있다.�실례로�

7362�=�7×83�+�3×82�+�6×81�+�2×80�

또한�23=8이므로�매�8진수자는�3자리의�2진수로�표시할수�있다.�실례로�

73628=111�011�110�0102�

4) 16진수체계(Hexadecimal Digit System) 

16진수체계에서는�0,�1,�2,�3,�4,�5,�6,�7,�8,�9와�A,�B,�C,�D,�E,�F로�된�16개

의�수기호를�써서�모든�수를�표시하며�F(10진수로�15)�다음에�자리올림이�일어난다.�또한�

모든�수를�16의�제곱들로�표시할수�있다.�실례로�

3AD7=3×163＋A×162＋D×161＋7×160�

24＝16이기때문에�매�16진수자는�4자리의�2진수와�같다.�대다수�콤퓨터에서�2진자료

는�4bit의�배수로�되며�따라서�16진수자의�배수로�된다.�실례로�

1010�1111�0110�00112=AF6316�

실례에서�보는바와�같이�주어진�2진자료를�맨�마지막자리부터�4자리씩�묶어서�4자리
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의�2진수를�16진수자로�변환하면�16진수자료가�얻어진다.�그러므로�콤퓨터에서�16진수체

계를�쓰게�된다.�프로그람언어에서는�10진수는�그대로,�8진수는�수앞에�예약어인�o,�16진

수는�0x를�붙여�수체계를�표현한다.�

8진수나�16진수는�콤퓨터에서�2진수를�간단히�표현하기�위하여�리용한다.�

매�진수들사이�대응표는�아래와�같다.�

�

10진수� 2진수� 8진수� 16진수�

0� 0000� 0� 0�

1� 0001� 1� 1�

2� 0010� 2� 2�

3� 0011� 3� 3�

4� 0100� 4� 4�

5� 0101� 5� 5�

6� 0110� 6� 6�

7� 0111� 7� 7�

8� 1000� 10� 8�

9� 1001� 11� 9�

10� 1010� 12� A�

11� 1011� 13� B�

12� 1100� 14� C�

13� 1101� 15� D�

14� 1110� 16� E�

15� 1111� 17� F�

�

16진수에서의�연산은�16개의�기호를�리용한다는것을�고려해야�한다.�

례:��������������������2FD.A1���������������������343.5D�

����������������＋���45.BC�������������������-��45.BC�

��������������������343.5D���������������������2FD.A1��

�

5) 수체계의 호상변환 

-�10진수를�r진수로�변환�

①�10진옹근수를�r진수로�변환�

주어진�10진옹근수를�r진수의�밑수�r로�나눈다.�이때�나머지를�써준다.�

얻어진�상을�다시�r로�나누어�상과�나머지를�얻는다.�이�과정을�상이�0으로�될�때까지

반복한다.��

나온�나머지들을�마지막에서부터�거꾸로�올라가면서�차례로�써주면�얻으려는�r진수가�

된다.�

례:�10진수�122를�2진수,�8진수,�16진수로�변환하여라.�
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�

�

�

�

�

�

�

�

�

�

�

2진수를�구하면�8진수,�16진수를�쉽게�구할수�있다.�2진수로부터�8진수,�16진수에로

의�변환은�콤퓨터에서�매우�중요한�자리를�차지하고있다.�

8진수는�3자리의�2진수와�같으며�16진수는�4자리의�2진수와�같다.�그러므로�2진수의�

맨�아래자리에서부터�3bit,�4bit씩�묶어서�8진수,�16진수로�넘길수�있다.��

앞의�실례에서�12210⇒011110102⇒1728⇒7A16과정을�보면�011110102을�제일�아래자

리에서부터�3bit씩�묶으면�012⇒18,�1112⇒78,�0102⇒28이므로�8진수�172로�되며�마찬가

지로�4bit씩�묶으면�16진수�7A가�된다.�

②�10진소수를�r진수로�변환�

주어진�10진소수에�r진수의�밑수인�r를�곱한다.�이때�다음자리로�자리올림하는�값이�

있으면�그것을�써주고�없으면�0을�써준다.�

얻어진�결과에서�소수부만을�따내여�다시�r를�곱한다.�이런�과정을�곱한�결과가�0이�

될�때까지�반복한다.(무한소수인�경우에는�적당한�자리수까지�반복진행한다.)��

얻어진�값들을�우에서�아래방향으로�내려오면서�순서대로�써준다.�

례:�10진소수�0.6875를�2진소수로�변환하여라.�

�

�

�

�

�

�

�

�

�

�

�

�

2��122�����0�

2����61�����1����배�

2����30�����0����렬�

2����15�����1����순�

2�����7�����1����서�

2�����3�����1�

2�����1�����1�

0�

�2진수�01111010�

8��122�����2�

8���15�����7�

8����1�����1�

����0�

��8진수�172�

16�122����A�

16���7�����7�

�����0��

���16진수�7A�

������0�.�6�8�7�5�

×���������������2��������� 쓰�

������1�.�3�7�5�0���������� 기�

×���������������2��������� 방�

������0�.�7�5�0�0���������� 향�

×���������������2�

������1�.�5�0�0�0�

×���������������2�

������1�.�0�0�0�0��

��0.687510��������0.10112�
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-�r진수를�10진수로�변환�

주어진�r진수의�자리수를�확정한다.�총�자리수를�n이라고�할�때�매개�자리수자에�해

당한�무게�ri-1(i=1,�…�,�n)을�결정한다.�

주어진�r진수의�매개�수기호에�그에�해당한�무게를�곱하고�곱한�값들을�모두�더한다.�

례:�2진수�1011001을�10진수로�변환하여라.�

10110012=1×26+0×25+1×24+1×23+0×22+0×21+1×20=8910�

례:�16진수�D3AB를�10진수로�변환하여라.�

D3AB16=13(D)×163+3×162+10(A)×161+11(B)×20=5418710�

�

련습문제 

1.�16�-�63까지의�10진수에�대응한�2진수,�8진수,�16진수를�표로�작성하여라.�

2.�다음의�2진수를�10진수로,�10진수를�2진수로�변환하여라.�

�

ㄱ)�1011102���������ㄴ)�11101012��������ㄷ)�1101101002�

ㄹ)�123110�����������ㅁ)�67310������������ㅂ)�199810��

�

3.�다음의�10진수를�8진수로,�8진수를�10진수로�변환하여라.�

�

ㄱ)�19510������������ㄴ)�25610������������ㄷ)�102410�

ㄹ)�1958������������ㅁ)�2568�������������ㅂ)�10248�

�

4.�다음의�10진수를�16진수로,�16진수를�10진수로�변환하여라.�

�

ㄱ)�204810������������ㄴ)�12810������������ㄷ)�308510�

ㄹ)�3F7816������������ㅁ)�FFFF16����������ㅂ)�100016�

�
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3. 코 드 

�

�

�

�

콤퓨터회로에서는�처리하는�내용뿐아니라�처리를�조종하는�신호도�0과�1로�기호화되

여있다.�이�0과�1의�2진수를�일정한�규칙으로�조합하여�뜻을�부여한것을�코드라고�한다.�

콤퓨터에서�리용되는�코드에는�수들을�관리하는�2진코드,�BCD코드,�3증가코드,�그레이코

드,�문자들을�관리하는�아스키(ASCII)코드,�유니코드(UCS)�등이�있다.�

1) BCD코드(Binary Coded Decimal Code) 

우리가�쓰고있는�10진수는�10진코드라고�볼수�있다.�콤퓨터회로에서는�10진코드를�2

진수로�바꾸어�취급한다.�

BCD코드란�10진수의�매개�자리를�2진수로�표시하여�배렬한것을�말한다.�2진수와�10

진수의�호상변환은�자리수가�많은�경우�품이�많이�들고�불편하다.�BCD코드는�10진코드를�

2진코드로�바꿀�때�10진수의�매�자리를�독립적으로�바꾸면�되기때문에�매우�간단히�바꿀

수�있다.�그러므로�콤퓨터를�비롯하여�실제�전자장치들에서는�BCD코드를�많이�쓰고있다.�

례를�들어�10진수�13은�0001�0011로,�725는�0111�0010�0101로�된다.�

이와�같은�방법을�쓰면�아무리�큰�10진수도�간단히�2진수로�표시할수�있고�2진수를�

쉽게�10진수로�변환할수�있으므로�편리하다.�

2) 아스키(ASCII)코드 

콤퓨터에서�계산된�결과자료들은�사용자들이�볼수�있도록�화면에�현시되여야�한다.�즉�

콤퓨터내부에서�연산된�자료들은�2진수이므로�결과는�10진수�또는�문자로�바꾸어야�한다.�

현시될�자료로서는�수값자료뿐만아니라�문자자료들도�있다.�콤퓨터는�이러한�수값기호나�

문자기호에�대한�그림(문양)자료들을�미리�주기억기(ROM)에�기억(이것을�문자발생기라고�

한다.)시켜놓고�매�문양을�식별하기�위한�번호를�붙였다.�그러므로�문양번호를�지정하면�

그�번호에�대응한�ROM의�해당�위치에�가서�그림자료를�꺼내여�화면에�현시하게�한다.�이

것이�바로�아스키코드가�가지는�의미이다.�

1byte로는�영어문자,�수자,�특수기호�등�256개를�표현할수�있다.�이렇게�만들어진것

이�바로�아스키코드표이다.�

건반에�표시할수�있는�기호들은�10개의�10진수기호와�26개의�영어문자,�$,�+,�=,�%,�

…�등의�특수문자들과�방향건�및�기능건들을�비롯한�조종문자들을�포함하여�최대로�128개

를�넘지�못한다.�그러므로�아스키코드는�128개를�식별할수�있는�번호를�가져야�하므로�

1byte크기(28=256)이면�충분하다.�

아스키코드는�다음과�같다.�

코드라는것은�무엇인가?�

생각하기 
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00� � 20� � 40� @� 60� ?� 80� � A0� à C0� � E0� α�
01� � 21� ！� 41� A� 61� a� 81� Й� A1� Ì C1� � E1� β�
02� ·� 22� "� 42� B� 62� b� 82� 'e� A2� 'o C2� � E2� Γ�
03� ♥� 23� #� 43� C� 63� c� 83� а̂� A3� 'u C3� � E3� π�
04� ♦� 24� $� 44� D� 64� d� 84� "a� A4�

~
n C4� � E4� Σ�

05� ♣� 25� %� 45� E� 65� e� 85� à� A5� ~N C5� � E5� σ�
06� ♠� 26� &� 46� F� 66� f� 86� a� A6� a C6� � E6� µ�
07� � 27� `� 47� G� 67� g� 87� � A7� ゜ C7� � E7� γ�
08� � 28� （� 48� H� 68� h� 88� ê� A8� � C8� � E8� φ�
09� � 29� ）� 49� I� 69� i� 89� ё� A9� ┌ C9� � E9� θ�
0A� � 2A� *� 4A� J� 6A j� 8A è� AA ┐ CA� � EA� Ω�
0B� � 2B� +� 4B� K� 6B k� 8B "I� AB� ½ CB� � EB� δ�
0C� � 2C� '� 4C� L� 6C l� 8C Î� AC ¼ CC� � EC� ∞�
0D� � 2D� -� 4D� M� 6D m� 8D Ì� AD i� CD� � ED� φ�
0E� � 2E� .� 4E� N� 6E n� 8E "A� AE 《 CE� � EE� �

0F� � 2F� /� 4F� O� 6F o� 8F A� AF� 》 CF� � EF� ∩�
10� ▶� 30� 0� 50� P� 70� p� 90� 'E� B0� D0� � F0� ≡�

11� ◀� 31� 1� 51� Q� 71� q� 91� ae� B1� D1� � F1� ±�
12� ?� 32� 2� 52� R� 72� r� 92� AE B2� D2� � F2� ≧

13� ！！� 33� 3� 53� S� 73� s� 93� Ô� B3� D3� � F3� ≦

14� ¶� 34� 4� 54� T� 74� t� 94� "O� B4� D4� � F4�

15� §� 35� 5� 55� U� 75� u� 95� ò� B5� D5� � F5�
∫�

16� � 36� 6� 56� V� 76� v� 96� û� B6� D6� � F6� ÷�
17� ?� 37� 7� 57� W� 77� w� 97� ù� B7� D7� � F7� ≈�

18� ↑� 38� 8� 58� X� 78� x� 98� "y� B8� D8� � F8� ゜

19� ↓� 39� 9� 59� Y� 79� y� 99� "o� B9� D9� � F9� ·�
1A� � 3A� :� 5A� Z� 7A z� 9A "u� BA� DA� � FA� ·�
1B� � 3B� ;� 5B� [� 7B ｛� 9B � BB� DB� � FB� √�
1C� ┕� 3C� <� 5C� ＼� 7C ｜� 9C � BC� DC� � FC� n�

1D� ?� 3D� =� 5D� ]� 7D ｝� 9D ＼� BD� DD� � FD� 2�

1E� ▲� 3E� >� 5E� ^� 7E ~� 9E pt� BE� DE� � FE� ■�
1F� � 3F� ?� 5F� _� 7F � 9F f� BF� DF� � FF� �

3) 유니코드(UCS) 

아스키코드를�가지고는�각�나라�글자들을�다�표기할수�없다.�

화면에�영문자뿐아니라�각�나라의�글자들과�수학기호,�문양�등을�표시할�요구로부터�
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국제표준화기구(ISO)에서는�UCS규격을�내놓았다.�

UCS(Universal�Multiple�Octet�Coded�Character�Set)는�통합적인�코드문자묶음

으로서�세계의�모든�언어형태뿐아니라�부가적인�기호까지�표현하는데�적용된다.�

UCS는�128개의�묶음(group)으로�이루어졌으며�매�묶음은�256개의�판(plane)으로�

되여있다.�모든�판은�256개의�행(row)으로,�매�행은�256개의�렬로�이루어졌으므로�매�판

에는�256×256개의�기호세포(cell)를�설정할수�있다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

UCS에서는�임의의�코드를�지적하는데�묶음,�판,�행,�렬을�표시하는�4byte이면�충분

하다.�이것을�UCS-4로�표현한다.�특별히�000묶음의�0번판은�기본적으로�리용되는�판

(BMP:�Basic�Multilingual�Plane)으로서�일반적으로�유니코드라고�한다.��

유니코드는�묶음번호와�판번호를�생략할수�있다.�즉�2byte로서�행과�렬번호를�지정한

다.�이것을�UCS-2로�표시한다.�

�

련습문제 

�

1.�다음의�10진수를�16진수로,�16진수를�10진수로�변환하여라.�

ㄱ)�204810��ㄴ)�12810��ㄷ)�308510���ㄹ)�3F7816��ㅁ)�FFFF16��ㅂ)�100016�

2.�다음의�아스키코드들에�대한�문자렬을�작성하여라.�

ㄱ)�(68,�65,�72,�78)��ㄴ)�(48,�49,�52,�55)��ㄷ)�(44,�34,�56,�66)�

3.  다음의�문자들에�대한�아스키코드렬을�작성하여라.�

ㄱ)�abcdef��ㄴ)�Computer��ㄷ)�535-1775��ㄹ)�#1992/4/5#��ㅁ)�ABCDEF�

묶음�000의�0번판�

묶음�000의�255번판�

묶음�000�

묶음�001의�0번판�

묶음�001� 묶음�127의�0번판�

묶음�127�
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제2절. 하드웨어와 쏘프트웨어 

1. 하드웨어 

콤퓨터는�물리적장치인�하드웨어와�그�운영기술인�쏘프트웨어로�이루어졌다.�

�

�

�

�

�

하드웨어(Hardware)란�영어로�굳은(Hard)�물건(Ware)이라는�

뜻인데�콤퓨터를�이루고있는�실제적인�부분품들의�모임과�그것을�만

드는�기술의�총체를�의미한다.�즉�콤퓨터를�구성하고있는�회로,�소

자,�기억장치,�주변장치�등�모든�기계적�및�전자적인�장치와�그것을�

만드는�기술을�가리킨다.�

콤퓨터하드웨어의�5대요소는�입력장치,�조종장치,�기억장치(주

기억기,�외부기억장치),�연산장치,�출력장치이다.�

하드웨어는�외형상�크게�본체와�주변장치들로�되여있다.�

1) 본체 

본체는�모든�계산과�처리를�진행하는�장치이다.�

본체에는�중앙처리장치,�기억장치,�디스크구동장치,�주기판,�전원장치가�들어있다.�

① 중앙처리장치 

중앙처리장치는�콤퓨터의�가장�중요한�부분으로서�실제로�자료처리를�하는�곳인데�조

종장치와�연산장치로�이루어진다.�

조종장치(Control�Unit)는�콤퓨터의�모든�장치들의�동작을�조종하는�장치이다.�

조종장치는�주기억장치에�보관된�명령들을�하나씩�받아들여�그것을�수행하는데�필요

한�모든�조종신호를�발생시키는�역할을�한다.�조종장치는�프로그람계수기,�명령등록기,�프

로그람상태등록기,�명령해신기�등으로�구성된다.�

연산장치는�조종장치의�조종밑에�연산수(연산대상과�연산결과)의�이동과�산수�및�론리

연산�등�실제적인�자료처리를�담당하는�장치이다.�

연산장치는�더하기,�덜기,�곱하기,�나누기와�같은�산수식과�함께�큰가,�작은가,�옳은

가,�옳지�않은가�등을�판단하는�론리연산을�수행한다.�연산장치는�연산수들을�일시�보관하

는�일반등록기들과�산수�및�론리연산을�수행하는�산수/론리장치�그리고�그것들사이를�련결

하는�모선으로�구성된다.�

현재�많이�쓰이고있는�개인용콤퓨터들에서는�조종장치와�연산장치의�정보처리기능을�

중앙처리소자�CPU(Central�Processing�Unit)가�담당한다.�

하드웨어라는�말의�뜻은�무엇인가?�

생각하기 
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CPU는�콤퓨터의�모든�기능을�조종하며�연산을�진행하는�극소형처리소자이다.��

현재�중앙처리장치의�동작속도�즉�동작주파수를�표시하는�단위는�Hz(헤르쯔)이다.�

대체로�CPU가�어떤것인가에�따라�동작속도가�정해진다.�실례로�CPU가�Pentium�

III(펜티움�3)인�콤퓨터는�800MHz로부터�1.3GHz정도이다.�즉�1초동안에�수십억번의�연

산처리를�진행한다.(1kHz�=�1�000Hz,�1MHz�=�1�000kHz,�1GHz�=�1�000MHz)�

CPU는�이�동작주파수에�맞추어�모든�처리를�진행한다.�마치도�합창단의�지휘자가�지

휘하는�박자에�맞추어�합창단이�노래하고�연주가들이�악기를�연주하는것과�마찬가지이다.�

지휘자가�지휘를�빨리하면�이�모든것이�빨라지고�천천히�하면�늦어지게�된다.�이와�마찬가

지로�CPU도�이�동작주파수에�맞추어�연산도�하고�자료도�신속히�처리하며�동작주파수가�

높을수록�이와�같은�처리가�빠르게�된다.��

중앙처리장치가� 콤퓨터하드웨어에서� 가장� 중요한� 부분이므로� 콤퓨터의� 발전은� 곧�

CPU의�발전이다.�

개인용콤퓨터에�사용되는�중앙처리소자의�동작속도는�1년반～2년에�2배씩�증가되여�

2000년에는�초당�10
9
회(1GHz)이상에�이르렀다.�

CPU의�자료처리비트수는�쉽게�말하여�자료의�통과능력이�얼마나�큰가를�나타내는�지

표이다.�CPU와�기억기사이에서�자료를�주고받을�때의�모선의�비트수를�외부처리비트수라

고�하며�CPU내부에서의�모선의�비트수를�내부처리비트수라고�한다.�

등록기의�자료들이�연산을�위해�연산장치로�넘어가거나�연산된�값이�등록기로�넘어가

려면�통로가�필요한데�이때�사용되는�통로를�모선이라고�한다.��

우리가�사용하는�콤퓨터에는�각종�모선들이�많이�존재하는데�크게�두가지로�나눌수�있

다.�내부모선과�외부모선이�바로�그것이다.�이가운데서�CPU가�사용하는�모선을�내부모선

이라고�하며�CPU와�주변장치들사이에�존재하는�모선을�외부모선이라고�한다.�

넓은�도로에서는�좁은�도로에�비해�많은�자동차들이�통과할수�있다.�이와�마찬가지로�

자료모선의�수가�많으면�많은�자료를�동시에�빨리�전송할수�있다.�자료는�byte단위로�자

료모선을�따라�전송된다.�이�자료모선이�몇개인가에�따라�CPU의�내부와�외부의�자료처리

비트수가�결정된다.�
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중앙처리장치의�내부�및�외부처리비트수,�동작주파수는�앞으로�계속�성능을�높이는�방

향에서�발전할것이다.�

② 기억장치(Memory Storage) 

기억장치는�프로그람과�자료를�보관하여두는�장치이다.�

기능에�따라�내부기억기(주기억기)와�외부기억기로�나눈다.�

내부기억기는�기억된�자료를�가지고�CPU와의�자료처리조작에�직접�참가하여�주되는�

역할을�한다는�의미에서�주기억기라고�한다.��

주기억기는�본체내부에�설치되여있으며�CPU에�고속으로�자료를�전송하도록�프로그람

과�자료를�보관하는데�리용된다.�

주기억기는�프로그람이나�자료정보를�받아�2진수로�보관하는�수많은�기억세포들로�구

성된다.�

주기억기에는�읽기전용기억기�ROM과�임의접근기억기�RAM이�있다.�

읽기전용기억기(Read�Only�Memory)는�그의�내용을�읽기만�하고�수정할수�없는�기

억기이다.�

읽기전용기억기에는�전원이�끊어져도�내용이�그대로�남아있다.�그러므로�여기에는�콤

퓨터를�기동할�때�자체검사와�초기설정을�진행하기�위한�프로그람이나�자료들이�기억되여

있다.�말하자면�콤퓨터에�전원을�넣을�때�RAM의�상태�그리고�건반과�구동기의�상태를�검

사한�다음�하드웨어정보를�읽어들여�작업할수�있는�환경을�마련하여주는�프로그람들은�그�

어떤�경우에도�변화되지�말아야�하므로�ROM에�기억되여있다.�

ROM은�콤퓨터의�입출력관리를�진행하는�프로그람인�BIOS와�체계정보설정프로그람,�

자체검사프로그람�POST,�체계장입프로그람들을�보관하고있다.�

BIOS(Base� Input�Output� System)는�기본입출력체계로서�조작체계와의�결합밑에�

자료의�입력,�출력을�보장하는�프로그람묶음이다.�

POST(Power�OneSelf�Test)는�장치에�대한�자체검사프로그람으로서�콤퓨터의�기동

과정에�물리적장치를�검사하는�프로그람이다.�즉�콤퓨터의�작업과정에�최소로�필요한�주변

CPU� 개발년도� 비트수�
연산속도(회/초)�
및�동작주파수�

4004�
8080�
8086�
8088�
80286�
80386�
80486�

Pentium��
Pentium�Pro�
Pentium�Ⅱ�
Pentium�Ⅲ�
Pentium�4�

1971�
1974�
1974�
1978�
1982�
1985�
1989�
1992�
1995�
1998�
2000�
2001�

4�
8�
16�

외부�8,�내부�16�
16�

내부�32,�외부�16�
32�

내부�32,�외부�64�
내부�32,�외부�64�
내부�32,�외부�64�
내부�32,�외부�64�
내부�32,�외부�64�

60�000�
290�000�
333�000�
3�333�000�
2�000�000�
7�000�000�
15�000�000�
100�000�000�
200�000�000�

동작주파수�850MHz�
1.1~1.3GHz�
1.4~2.7GHz�
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장치들의�물리적련결이�정상인가를�검사하는�프로그람이다.�

임의접근기억기(Random�Access�Memory)는�CPU가�처리하려는�자료나�명령들이�

기억되는�대규모집적회로소자형식의�기억기이다.�이�기억기는�읽기와�쓰기가�가능한�기억

기로서�사용자가�작성한�프로그람이나�자료들을�마음대로�기억시킬수도�있고�또�기억된�내

용을�꺼낼수도�있는데�일단�전원이�꺼지면�기억된�내용이�모두�지워지는�기억기이다.�

�

중앙처리장치와�주기억기사이의�동작속도가�대체로�차이나는데�이때에는�주기억기보다

도�속도가�대단히�빠른�고속완충기억기가�리용된다.�일명�캐쉬라고�하는�고속완충기억기는�

중앙처리장치와�함께�붙어있거나�밖에�설치되여있을수도�있는데�함께�붙어있는것을�1차고

속완충기억기,�밖에�설치되여있는것을�2차고속완충기억기라고�한다.�

일반적으로�고속완충기억기는�중앙처리장치와�주기억기사이에�있으면서�중앙처리장치

의�전송속도는�빠르고�주기억기의�속도가�뜰�때�이�속도차이를�메꾸어준다.��

중앙처리장치가�요구하는�자료가�고속완충기억기안에�존재하면�그�자료를�고속완충기

억기조종기가�중앙처리장치에�넘긴다.�

Pentium의�고속완충기억기는�512kbyte의�용량을�가지는데�1차고속완충기억기는�중

앙처리장치의�내부에�포함하고있다.�Pentium�II인�경우에는�2차고속완충기억기까지�중앙

처리장치에�포함되여있다.�

중앙처리장치내부에�2차고속완충기억기를�넣으면�중앙처리장치와�같은�동작주파수로�

고속완충기억기를�동작시키기때문에�기억기의�성능이�올라간다.�

CPU는�오직�RAM우에�적재되여있는�프로그람이나�명령들을�자기의�처리대상으로�한

다.�그런데로부터�보통�주기억기라고�할�때�RAM을�의미한다.�그런데�RAM은�전원이�끊

어지면�거기에�기억된�내용이�모두�지워지므로�그것을�저장하기�위한�별도의�보조기억장치

(외부기억장치)가�필요하다.�

외부기억기는�주기억기밖에�설치되여�연산에�참가하지�않는�프로그람과�자료들을�보관

하는데�리용되는�기억장치이다.�

외부기억기에�기억된�자료는�콤퓨터의�주기억기에�들어간�다음에야�콤퓨터의�자료처리

과정에�참가할수�있으므로�보조기억장치라고도�한다.�

외부기억장치에는�플로피디스크,�하드디스크,�빛디스크,�빛자기디스크,�수자식다목적

기록디스크,�휴대용기억기�등이�있다.�
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플로피디스크(FD:�Floppy�Disk)는�얇은�수지판에�자성물

질을�입혀�만든�직경이�3.5inch인�자기원판이다.�

하드디스크(HD:�Hard�Disk)는�알루미니움합금으로�된�디

스크를�여러개�묶은�디스크묶음으로서�콤퓨터의�본체안에�들어

있다.�

하드디스크는�Hard(굳은)라는�단어와�Disk(원판)라는�단어

의�결합이다.�비교적�견고하며�용량은�대단히�크다.�보통�20～

120Gbyte�등이�쓰인다.�

�

�

�

�

�

�

�

�

빛디스크는�빛성질을�리용하여�자료를�읽거나�쓰

는�디스크이다.�

빛디스크에는�CD와�DVD�등이�있다.�

CD에는�CD-ROM,�CD-R,�CD-R/W가�있다.�

CD-ROM은�읽기만�할수�있으며�CD-R는�CD쓰

기장치를�리용하여�한번만�쓰기할수�있는�디스크이다.�

CD-R/W는�읽기,�쓰기를�자유롭게�할수�있는�디

스크이다.�

CD는�한면에만�자료를�기억할수�있는데�기억용량

은�650～800Mbyte이다.�

수자식다목적기록디스크(DVD:�Digital�Versatile�Disk)는�문자정보도�기억시키고�화

면의�질이�아주�높은�영상이나�음성까지도�기억시킬수�있는�디스크이다.�

DVD는�CD와는�달리�량면에�기억할수�있으며�기억용량은�4.9GB이상으로서�CD의�6

～8배,�플로피디스크의�3�000배정도이다.�

빛자기디스크(MO:�Magnetic�Optical�Disk)는�빛자기성질을�리용하여�자료를�읽기,�

쓰기할수�있으며�3.5inch,�5.25inch�두가지가�있다.�

기억용량은�128MB,�230MB이다.�

디스크의�론리적구조는�다음의�그림과�같다.�
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�

디스크는�크게�여러개의�자리길과�분구로�되여있고�한개�분구를�단위로�하여�자료를�

기억시킨다.�

한개�분구의�기억용량은�디스크마다�다르다.�

매개�자리길에는�가장�바깥쪽에�놓이는것으로부터�시작하여�원의�중심으로�들어가면

서�0부터�번호를�붙인다.�디스크의�뒤면에도�마찬가지이며�앞면은�0,�뒤면은�1로�붙인다.�

디스크의�종류에�따라�내부구조가�규정되며�따라서�자리길과�분구수,�분구길이,�등록

할수�있는�프로그람이나�자료의�총�등록개수와�총�기억용량이�결정된다.�

디스크의�기억용량은�다음과�같이�결정된다.�

디스크용량＝면의�개수×마당기록자리길수(track)×자리길당�분구수(sector)×분구의�크기�

휴대용기억기는� Flash� Memory(휘발성기억기)의�

원리를�리용하여�나온�외부기억기들이다.�크기가�아주�

작고�자료읽기�및�쓰기속도가�대단히�빠른것이�특징이

다.�그�기억용량은�과학기술이�발전함에�따라�급속히�

늘어나고있다.�

③ 디스크구동장치 

디스크구동장치는�주기억기에�들어있는�프로그람

이나�자료를�디스크에�보관하거나�이미�보관된�프로그람이나�자료를�주기억기에�넣기�위한�

장치이다.�

디스크구동장치에는�FD구동기,�CD구동기,�DVD구동기,�MO디스크구동기,�휴대용기

억기포구�등이�있다.�

④ 주기판  

주기판은�콤퓨터의�기본요소들이�실지�조립된�기판이다.�

⑤ 전원장치 

전원장치는�모든�장치들에�전원을�공급하기�위한�장치이다.�출구전압은�±5V,�12V이다.�
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2) 주변장치(Peripheral Equipment) 

주변장치는�본체와�련결하는�모든�장치들을�말한다.�

주변장치에는�입력장치와�출력장치가�있다.�

①�입력장치는�콤퓨터의�내부로�정보를�받아들이는�장치이다.�

건반,�마우스,�광학식문자읽기장치(OCR),�광학식표식읽기장치(OMR),�자기잉크문자

읽기장치(MICR),�음성인식장치,�마이크,�화상입력장치�등이�입력장치에�속한다.�

≤

≤

≤

≤

≤

≤

≤

≤

≤

≤

≤

≤

②�출력장치는�콤퓨터내부에서�처리된�정보를�사용자들이�볼수�있고�들을수�있도록�외

부로�변환하여�내보내는�장치이다.�

현시장치(Display),�인쇄기(Printer),�음성출력장치(Speaker),�X-Y작도기�등이�출

력장치에�속한다.�이밖에도�주변장치에는�콤퓨터망통신을�위한�망기판이나�모뎀�등�여러가

지가�있다.�

�

�

�

�

�

�

�

인쇄기는�대표적인�출력장치로서�처리결과를�종이우에�찍어내는데�쓴다.�인쇄기에는�

인쇄방식에�따라�레이자인쇄기,�점인쇄기,�잉크분사식인쇄기�등이�있다.�

레이자인쇄기는�콤퓨터에서�받은�자료들을�페지별로�모아서�보관한�다음�단번에�찍어

주며�레이자원리로�인쇄하기때문에�인쇄속도가�높고�소음이�없으며�인쇄질도�대단히�높다.�
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점인쇄기는�종이우에�점을�찍어서�글자를�완성하는�방식의�인쇄기이다.�

점인쇄기에서는�인쇄머리가�좌우로�이동하면서�침으로�종이와�잉크리봉을�때려�점을�

인쇄하며�이런�점들이�모여�하나의�글자를�완성한다.�점인쇄기에는�타자침이�몇개인가에�

따라�9pin,�24pin,�48pin인쇄기가�있다.�

잉크분사식인쇄기는�점인쇄기와�동작원리가�비슷하다.�잉크분사식인쇄기에서는�인쇄

머리가�종이와�잉크리봉을�때리는�대신�인쇄머리에�해당되는�핀에서�여러�색갈로�된�잉크를�

뿜어내여�글자와�그림을�찍어낸다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

콤퓨터상식 �

고유한�의미에서의�콤퓨터는�1946년에�출현한�전자관식콤퓨터�ENIAC부터이다.

콤퓨터의�발전과정을�세대에�따라�분류하면�다음과�같다.�

－1세대콤퓨터(1946년 - 1958년) 

1세대콤퓨터는�전자관을�리용한�콤퓨터로서�1940년대에�출현하여�콤퓨터가�실용

화되기�시작한�시기이다.�1세대콤퓨터에서�사용된�언어는�기계어인것으로�하여�콤퓨

터전문가가�아니면�콤퓨터를�리용할수�없었다.�이외에도�여러가지�결함으로�하여�일

반화되지�못하였다.�

－2세대콤퓨터(1958년 - 1964년) 

2세대콤퓨터는�전자관대신�반도체소자를�리용하여�만든것으로�하여�1세대콤퓨터

에�비하여�체적과�질량이�작아지고�전력소비가�적어졌다.�특히�연산속도가�빨라지고

믿음성도�보다�높아졌다.�이때부터�고급언어가�리용되기�시작하였고�쏘프트웨어개발

이�본격화되였다.�

－3세대콤퓨터(1964년 - 1971년) 

3세대콤퓨터는�반도체대신�집적회로를�리용하였다.�2세대콤퓨터에�비해�연산속도

는�1�000배이상�빨라지고�소형화되였으며�믿음성이�높아지고�가격이�더욱�눅어졌다.�

한편�새로운�입출력장치들과�각종�고급언어들이�개발되였다.�

－4세대콤퓨터(1971년 - 1980년대말) 

4세대콤퓨터는�집적회로의�집적도를�더욱�높인�대규모집적회로와�초대규모집적회

로를�리용한�콤퓨터이다.�3세대콤퓨터에�비하여�연산속도는�1�000배이상�빨라지고�주

기억�및�외부기억용량이�보다�커졌으며�믿음성이�높고�가격이�눅어졌다.�이�시기에

극소형콤퓨터가�출현하였다.�

－5세대콤퓨터(1980년대말 - 현재) 

4세대때에� 쓰던� 초대규모집적회로는� 물론� 더욱� 집적화된� GSI(Grand� Scale

Integrated)소자를�리용하였으며�초고속연산속도(10-18～10-15초)를�보장하고있다.��

5세대콤퓨터는�이전�콤퓨터와는�달리�인공지능의�원리를�받아들여�지식정보를�처

리하는�지능콤퓨터이다.�



�

� 21

2. 쏘프트웨어 

�

�

�

�

�

쏘프트웨어(Software)는�영어로�부드러운(Soft)�물건(Ware)이라는�뜻인데�하드웨어

를�동작시키는�기능과�콤퓨터를�리용하는�모든�기술의�총체이다.�즉�콤퓨터를�직접�조종하

거나�사용자가�입력한�지령을�해득하고�집행하는�프로그람기술의�총체이다.�

쏘프트웨어는�다음과�같이�분류한다.�

1) 체계쏘프트웨어  

사용자가�입력한�지령이나�자료들을�접수하면�그에�맞게�각�장치들을�동작시켜�해당한�

결과를�낼수�있도록�조종을�실현하여주며�다른�응용프로그람과의�대면을�보장하여주는�프

로그람묶음을�체계프로그람�혹은�체계쏘프트웨어라고�한다.�

① 조작체계(OS: Operating System) 

조작체계는�콤퓨터체계의�모든�장치들을�효과적으로�관리하여�그�성능을�최대로�발휘

하게�함으로써�사용자들에게�보다�편리한�콤퓨터사용환경을�보장해주는�체계쏘프트웨어이

다.�조작체계는�콤퓨터를�이루고있는�모든�주변장치들과�콤퓨터가�처리하려고�하는�프로그

람들을�관리하며�콤퓨터와�사용자사이에�초보적인�대화수단을�마련하여주는�프로그람묶음

이다.�조작체계는�콤퓨터의�체계자원들을�믿음직하게�관리하여�콤퓨터장치의�성능을�보다�

높이도록�한다.�사용자는�콤퓨터장치들이�내부적으로�어떻게�구성되여있으며�그�기능들이�

어떤지�구체적으로�잘�알지�못하고서도�단순한�체계지령들에�의하여�장치들을�쉽게�리용할

수�있다.�

체계자원(System�Resource)이란�프로그람을�실행하는데�필요한�장치자원과�정보자

원들을�말한다.�장치자원에는�CPU,�기억기,�입출력장치�등이,�정보자원에는�조작체계를�

구성하고있는�프로그람과�자료구조체들이�속한다.�

조작체계는�또한�프로그람작성자들이�조작체계의�기능을�호출하여�프로그람작성을�쉽

게�그리고�빨리�하도록�하며�조작체계에서�제공하는�지령들을�리용하여�자기의�작업요구를�

쉽게�실현하도록�한다.�

모든�조작체계들이�같지는�않지만�현대적인�조작체계들이�가지고있는�일반적인�요소

기능들을�보면�프로쎄스(주기억기에�적재되여�실행중에�있는�프로그람)관리,�주기억기관

리,�파일(련관된�자료들을�일정한�규칙에�따라�하나로�묶어놓은것)관리,�입출력장치관

리,�2차기억기(디스크)관리,�망관리,�체계보호�등과�같다.��

조작체계의�기능가운데서�가장�기본적인�기능인�프로쎄스관리,�파일관리,�입출력장치

관리,�디스크관리,�망관리를�수행하는�부분을�핵심부(Kernel)라고�한다.�핵심부는�체계가�

기동할�때�기억기에�적재되며�체계를�운영하는데�필요한�많은�중요한�함수들을�가지고있다.��

쏘프트웨어라는�말의�뜻은�무엇인가?�

생각하기 
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콤퓨터체계의�기본적인�형태와�능력은�핵심부에�의하여�결정된다.�이로부터�흔히�《조

작체계》라는�말은�《핵심부》라는�말과�같은�뜻으로�쓰인다.��

콤퓨터는�조작체계가�있어야�작업을�할수�있다.�

대표적인�조작체계로는�MS-DOS(단일사용자/단일과제처리용체계),�Windows(단일사

용자/다중과제처리용체계),�Unix,�Linux�및�우리�식�조작체계�《붉은별》(다중사용자/

다중과제처리용체계)�등을�들수�있다.�

② 봉사프로그람(Service Program) 

조작체계의�개별적기능(디스크관리,�기억기관리,�건반,�현시장치,�인쇄기�등의�주변장

치관리�등)들을�더�편리하게�사용할수�있도록�해주는�프로그람이다.�여기에는�편의보장프

로그람,�오유수정프로그람,�문서편집과�비루스제거프로그람�등이�속한다.�

《붉은별》조작체계가�지원하는�봉사프로그람에는�다음과�같은것들이�있다.�

보조프로그람으로서는�암호화도구,�화면확대기,�정보편람,�디스크관리자,�체계감시기,�

조종판,�오림판,�전자우편,�탁상형페지작성기,�파일압축기,�본문편집기,�팍스송신기,�도움

말편람기,�문자선택프로그람�등이�있다.�망프로그람으로서는�《내나라》열람기,�망상태감

시기,�망접속기,�방화벽�및�VPN말단프로그람이�있으며�다매체프로그람으로서는�다매체재

생기�《별무리》,�음성록음기,�음향혼합기가�있다.�화상�및�도형처리프로그람에는�PDF열

람기,�화상입력기,�화상열람기,�화상편집기가�있다.�

이밖에도�Windows환경지원프로그람과�체계설정,�유희오락프로그람,�프로그람개발도

구�Kdevelop를�제공한다.�그리고�련결편집프로그람이나�조작체계환경설정프로그람�등이�

있다.�

③ 장치구동프로그람(Device Driver Program) 

주변장치들에�대하여�조작체계와의�론리적련결을�실현하여주는�프로그람이다.�

④ 언어처리프로그람 

콤퓨터사용자들이�작성한�프로그람들을�콤퓨터가�리해하고�실행할수�있는�프로그람으

로�변환해주는�프로그람을�언어처리프로그람�또는�언어처리기라고�한다.�

콤퓨터는�1과�0의�2진수코드로�되여있는�기계어밖에�리해하지�못한다.�

기계어를�쓴�1세대콤퓨터는�사람들이�광범히�리용하지�못하였다.�

그것은�기계어로는�프로그람을�작성하기�힘들고�작성된�프로그람을�리해하기도�힘들

기때문이였다.�이러한�제한성을�극복하여나온�언어가�기호언어와�자연언어에�가까운�고급

언어이다.�그러나�고급언어로�작성한�프로그람은�기계어로�변환해주어야�콤퓨터가�리해할

수�있다.�이러한�기능을�수행하는것이�바로�언어처리프로그람이다.�

언어처리프로그람에는�기호언어프로그람,�해석프로그람,�번역프로그람이�있다.�

- 기호언어프로그람 

기호언어는�기계어명령을�사람이�리해할수�있는�영어략어로�표현한�프로그람작성언어

이다.�아쎔블리언어라고도�한다.�

기호언어는�기계어보다는�사용자들이�리해하기�쉽다.�

례를�들어�기계어로�01111000�00011001이라고�하면�그�뜻을�리해하기�어려우나�기
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호언어로�ADD�A,�B라고�하면�《A와�B를�더하다》라는�뜻으로�쉽게�리해할수�있다.�기

호언어는�이렇게�기계어보다�리해하기�쉬우며�기계어와�약속된�코드가�같기때문에�기계어

로�변환시켜주는�처리를�하지�않아도�된다.�

- 해석프로그람(Interpreter) 

해석프로그람은�사용자가�작성한�프로그람을�문장단위로�기계어로�변환해주는�언어처

리프로그람이다.�

해석프로그람은�건반으로�입력된�프로그람을�기계어로�변환해주며�또한�프로그람행별

로�변환하면서�오유가�있으면�행별로�알려주고�집행한다.�

만일�프로그람이�150행(문장행수)으로�되였다면�150번�변환,�오유찾기,�오유수정을�

해야�한다.�이로부터�해석프로그람은�집행시간이�다른�처리프로그람보다�길어지는�결함이�

있다.�

- 번역프로그람(Compiler) 

번역프로그람은�변환을�한다는�측면에서는�해석프로그람과�같지만�변환방식이�다르다.�

즉�해석프로그람은�프로그람을�한개�행씩�기계어로�변환하지만�번역프로그람은�프로그람을�

단위로�하여�기계어로�변환해주는�프로그람이다.�

프로그람을�150행으로�작성하였다면�150개�행을�단번에�변환한�다음�수정하며�오유가�

없으면�집행하여�결과를�내보낸다.�

이렇게�하면�변환시간이�해석프로그람보다�적게�든다.�

해석프로그람의�변환과정을�외국어통역원의�역할과�비유할수�있다면�번역프로그람의�

변환과정은�외국서적번역원의�역할에�비유할수�있다.�

2) 응용쏘프트웨어(Application Software) 

응용쏘프트웨어는�어떤�특별한�목적을�수행하기�위하여�작성된�프로그람이다.�

사람들이�조작체계환경우에서�사용하는�대부분의�프로그람들은�응용쏘프트웨어에�해

당된다.�

응용쏘프트웨어에는�문서편집프로그람�《글》,�표계산프로그람�《표》와�같은�사무처

리프로그람과�통계처리프로그람,�《환상》과�같은�화상편집프로그람�등과�같이�누구나�광

범히�리용할수�있도록�개발된�일반용프로그람들과�설계지원프로그람이나�건강진단프로그람�

등과�같이�전문령역에서만�쓰이는�전문가용프로그람들이�속한다.�

�

련습문제 

�

1. 본체안에는�어떤것들이�들어있는가?�

2.�주변장치에는�어떤것들이�있는가?�

3.  ROM과�RAM의�공통점과�차이점에�대하여�설명하여라.�

4.�고속완충기억기가�왜�필요한가?�

5.�입력장치와�출력장치의�기능을�한마디로�이야기하여라.�
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6.�외부기억장치의�종류와�차이점을�설명하여라.�

7.�디스크는�왜�사용하며�디스크의�종류에는�어떤것들이�있는가?�

8.�하드웨어와�쏘프트웨어의�차이점은�무엇인가?�

9.�체계쏘프트웨어란�무엇이며�어떤것들이�있는가?�

10.�조작체계는�무슨�역할을�하는�프로그람인가?�

11.�조작체계에는�어떤것들이�있는가?�

12.�봉사프로그람은�어떤�기능을�수행하는가?�

13.�번역프로그람과�해석프로그람의�기능상차이를�설명하여라.�

14.�응용프로그람이란�무엇이며�어떤것들이�있는가?�

15.�우리가�많이�리용하는�응용쏘프트웨어들을�꼽아보아라.�

�

�

콤퓨터상식

�

콤퓨터는�처리속도,�기억용량,�입출력장치의�수,�쏘프트웨어의�성능과�크기�등을

고려하여�초대형콤퓨터,�대형콤퓨터,�소형콤퓨터,�극소형콤퓨터로�분류한다.�

-�초대형콤퓨터(Super Computer) 

초대형콤퓨터는�많은�량의�자료를�신속정확히�처리하기�위하여�출현하였다.��

초대형콤퓨터는�수십개의�중앙처리장치(CPU)들을�그물모양으로�배렬함으로써�초

당�1억개의�명령을�수행한다.�초대형콤퓨터는�기상예보�등�방대한�량의�자료를�취급

하는�일부�기관들에서만�리용한다.�

-�대형콤퓨터(Main Frame) 

보통�대형콤퓨터는�일반업무용으로�제작된것으로서�대학,�연구기관�등�규모가�큰

기관들에서�리용한다.�대형콤퓨터는�방대한�계산능력과�기억용량,�다양한�입출력장치

를�갖추고있으며�동시에�100명이상이�사용할수�있다.�

-�소형콤퓨터 

소형콤퓨터는�극소형콤퓨터와�대형콤퓨터사이에�있는�콤퓨터로서�사용방법과�처

리방법은�대형콤퓨터에�많이�치우치고있다.�

소형콤퓨터는�대형콤퓨터에�비해�소형화되였지만�성능이�그렇게�떨어지지�않는것

으로�하여�여러�기관들에서�많이�리용하고있다.�소형콤퓨터는�단독으로�리용되기도

하고�대형콤퓨터와�망을�형성하여�자원을�공유하기도�한다.�

-�극소형콤퓨터 

극소형콤퓨터는�말그대로�크기와�외형이�매우�작은�콤퓨터이다.�극소형콤퓨터들

은�크기에�따라�탁상형(desktop)과�휴대형(laptop,�notebook,�palmtop)으로�나눈

다.�지금�흔히�사용하고있는�콤퓨터가�바로�이�극소형콤퓨터이다.�
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제3절. 콤퓨터비루스제거 

1. 콤퓨터비루스에 대한 개념 

�

�

�

�

�

사람의�몸에�사람에게�해로운�비루스나�세균이�침습하면�몸이�아프고�열이�나거나�건

강이�파괴되여�정상적인�일을�할수�없을뿐만아니라�다른�사람들도�감염시킨다.�

이와�같은것들은�의학이나�생물학에서�말하는�비루스나�세균이다.�

콤퓨터비루스는�생물학적인것이�아니라�콤퓨터안에�기억되여있는�프로그람이나�자료

를�파괴시키면서�이런�현상을�다른�콤퓨터에�전염시키는�프로그람이다.�다시말하여�콤퓨터비

콤퓨터의�성능을�평가하는데서�중요한�지표는�중앙처리소자의�성능,�콤퓨터의�기

억용량�등이다.�

①�중앙처리소자의�성능�

콤퓨터는�CPU의�동작주파수에�맞추어�모든�처리를�한다.�따라서�동작주파수가

클수록�연산속도,�자료처리속도�등�모든�처리를�빨리�진행한다.�

중앙처리소자(CPU)의�처리속도:�자료전송비트수(모선의�비트수)로�결정한다.��

자료전송비트수가�클수록�CPU의�처리속도가�빨라진다.��

자료전송비트수를�론할�때�내부처리비트수(CPU안에서의�모선의�비트수)와�외부

처리비트수(CPU와�기억기사이에서�자료를�주고받을�때의�모선의�비트수)를�확인하여

야�한다.�

②�콤퓨터의�기억용량�

CPU에�따라�RAM의�기억용량이�결정된다.�RAM이�클수록�많은�자료들과�프로

그람들을�고속으로�처리할수�있다.�또한�하드디스크의�용량이�클수록�좋다.�

이외에도�콤퓨터의�성능은�어떤�주변장치를�가지고있는가,�어떤�장치를�더�접속

할수�있는가�등에�의해서도�결정할수�있다.�

사람이�비루스에�감염되면�어떤�증상이�나타나는가?�

생각하기 
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루스는�콤퓨터안의�프로그람이나�자료에�대한�파괴,�변경,�삭제작용�등�비정상적인�동작을�

하게�하는�프로그람이다.�콤퓨터비루스는�사용하던�콤퓨터를�갑자기�비정상적인�상태에�들

어가게�하거나�작업하던�내용을�없애버리는�등�콤퓨터의�리용에�큰�지장을�준다.�

일반적으로�콤퓨터비루스는�하드디스크나�플로피디스크와�같은�기억매체들에�다른�프

로그람이나�자료들을�넣을�때�또는�망을�통하여�콤퓨터에�끼여들어와�잠복해있다가�어떤�

프로그람을�실행시킬�때�동작하면서�파괴작용을�한다.�그러므로�콤퓨터비루스는�콤퓨터장

치(하드웨어)를�파괴시키는것이�아니라�콤퓨터에�기억되여있으면서�어떤�조건이�주어지면�

콤퓨터체계나�응용프로그람,�자료들을�파괴시켜�콤퓨터가�제대로�동작하지�못하게�하여�사

용자들에게�혼란을�가져온다.�

우리는�콤퓨터비루스증상을�잘�알고�어떤�형태의�비루스에�감염되였는가를�옳게�판단

하고�대책을�세워야�한다.�

비루스에�감염되면�일반적으로�콤퓨터에서�다음과�같은�증상들이�나타난다.�

∙�알지�못할�음악,�잡음,�경고음�등이�울린다.�

∙�파일의�크기,�작성날자�등이�변경된다.�

∙�쓰기보호가�된�플로피디스크에�쓰기하려�한다는�통보가�표시된다.�

∙�콤퓨터를�재기동시킨다.�

∙�응용프로그람의�실행시간이�여느때보다�길어진다.�

∙�콤퓨터망에서�자료통신이�진행되지�않거나�비정상적으로�진행된다.�

∙�문서파일을�비롯한�사무처리프로그람파일들에�암호가�걸린다.�

∙�주변장치가�동작하지�않는다.�

∙�기억기가�모자란다는�불필요한�통보가�표시된다.�

∙�화면에�이상한�그림이나�통보가�반복적으로�나타나거나�계속�이동하여�작업을�할수

없게�한다.�

2. 콤퓨터비루스의 종류와 방지대책 

1) 콤퓨터비루스의 종류 

콤퓨터비루스에는�DarkAverager비루스,�Stoned비루스,�체르노빌비루스를�비롯하여�

여러가지가�있다.��

어떤�비루스는�조작체계에�붙어서�콤퓨터체계를�파괴하는�비루스,�실행파일에만�붙는�

비루스,�파스칼이나�VB와�같이�지정된�언어로�짠�프로그람에만�붙는�비루스�등�여러가지

가�있다.��

콤퓨터비루스는�각종�응용프로그람들과�정보자료들을�파괴하는�정도에�따라�악성비루

스와�량성비루스로�나눈다.�또한�동작범위와�동작방식에�따라�Virus(비루스),�Worm(웜),�

Trojan�Horse(트로쟌호스)로�나눈다.�

①�Virus�-�콤퓨터망이나�개인용콤퓨터에�침습하여�파일들을�감염시키거나�자료들을�

파괴하는�작용을�한다.�
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②�Worm�-�통신망으로�접속된�콤퓨터들사이로�자기와�꼭�같은것을�만들어내는�프로

그람이다.�이�Worm비루스가�증식하여�수가�급격히�불어나면�망에�큰�부하가�걸리며�이로

하여�나중에는�망을�사용할수�없게�된다.�

③�Trojan�Horse�-�겉으로�보기에는�해로운�작용이�없는것�같지만�자료의�위조,�파

괴�또는�비법적인�수집을�하는�매우�교묘한�프로그람이다.�

우의�3가지�종류의�비루스들가운데서�Virus는�파괴작용이�더�강하고�로골적이므로�보

통�콤퓨터비루스라고�하면�이�경우를�말한다.�

2) 콤퓨터비루스방지대책 

∙�외부기억매체(플로피디스크,�CD,�하드디스크,�USB기억기,�MP3,�MP4�등)를�쓰

는�절차를�엄격히�지켜야�한다.�여기저기에서�쓰던�기억기에�대하여서는�꼭�비루스검사를�

하고�콤퓨터에�접속하여야�한다.�

∙�콤퓨터가�비루스에�감염되였다고�생각되면�비루스제거프로그람을�리용하여야�한다.�

수많은�형태의�비루스를�모두�발견하고�없애는�만능왁찐은�없으며�시기적으로�이전에�

나온�왁찐은�그보다�이후에�발견된�비루스를�제거하지�못한다.�

이로부터�일부�비루스왁찐제작자들은�새로�나오는�비루스를�주문받아서�비루스제거프

로그람을�계속�갱신하여�봉사하고있다.�

따라서�새로�만들거나�갱신된�최신판비루스제거프로그람들을�정기적으로�구입하여�사

용하여야�한다.�

∙�비루스를�예방하기�위하여�모든�콤퓨터사용자들은�비루스의�해독성과�그것을�막기�

위한�일정한�지식을�가져야�한다.�

모든�실행프로그람들에�대하여�비루스검사를�정상적으로�진행하며�철저히�보호하여야�

한다.�

�

�

�

�

�

�

�

�

�

�

�

�

왁찐프로그람�

콤퓨터비루스�
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3. 비루스발견 및 제거 

대표적으로�쓰이고있는�비루스발견�및�제거프로그람에는�《비루스왁찐프로그람�1.0》,�

《클락새2.0》,�KJAV�등이�있다.��

여기서는�《클락새2.0》에�대하여�보기로�한다.�

이�프로그람은�콤퓨터에�대한�비루스의�피해를�막는것을�기본사명으로�하는�《붉은

별》사용자용체계�2.0판용�비루스왁찐이다.�

1) 기능 

이�프로그람은�부트감염형,�파일감염형,�웜비루스들을�비롯하여�여러가지�비루스들에

대하여�발견�및�치료할수�있으며�비루스자료기지를�계속�갱신하여�최신�비루스들에도�신속

히�대응할수�있다.�

발견된�비루스들에�대하여�사용자가�설정한�값에�따라�자동적으로�혹은�사용자에게�문

의하는�방식으로�처리를�진행한다.�

이�프로그람은�실시간감시기능을�가지고있어�비루스를�제때에�발견하여�처리할수�있다.�

이�프로그람은�예약검사기능도�지원하고있으며�여러가지�압축파일들과�실행압축파일

들에�대한�비루스검사도�진행한다.�

2) 기동과 사용방법 

《시작》→《응용프로그람》→《보조프로그람》→《클락새2.0》지령을�실행한다.�

�

그러면�다음과�같이�《클락새2.0》대화칸이�나타난다.�

응용프로그람 

보조프로그람

클락새2.0 



�

� 29

�

�

�

�

�

�

�

�

�

�

�

�

왼쪽칸에서는�파일검사,�실시간감시,�검사�및�격리리력관리,�비루스왁찐갱신,�동작설

정들을�진행한다.�

-�파일검사에서는�사용자가�지정한�서류철에�대한�비루스검사를�진행할수�있다.�《검

사》단추를�찰칵하면�비루스검사를�진행한다.��

�

�

�

�
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�

�

�
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�

�

파일검사대면부에서는�파일검사를�《림시정지/정지》할수�있으며�검사진행과정을�%로

볼수�있다.�또한�현재�설정되여있는�검사설정값을�간단히�열람할수�있다.��

비루스가�발견되면�발견된�파일의�정보를�표시하여준다.�

그림기호로�된�《정지》단추를�찰칵하면�비루스검사를�정지한다.��

그림기호로�된�《림시정지》단추를�찰칵할�때�비루스검사가�림시정지상태이면�계속�진행

하고�비루스검사중이면�림시정지한다.�《닫기》단추를�찰칵하면�비루스검사창문을�닫는다.�
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-�실시간감시는�체계에서�사용자나�다른�응용프로그람들에�의하여�변경되는�파일들에�

대한�비루스검사를�진행하는�기능으로서�비루스의�감염을�막는다.�
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《경로》항목에서는�비루스검사를�진행하려는�서류철을�선택한다.��

《설정》항목에는�현재�설정되여있는�파일검사설정값을�간단히�표시하며�설정값을�상

세히�보려고�하거나�다시�설정을�하려면�《설정》항목을�찰칵하여�비루스검사설정대면부를

표시하여야�한다.��

간단한�표시항목에는�《기정》과�《사용자정의》가�있는데�그에�대한�내용은�동작설

정의�파일검사설정도움말에�상세히�밝혀져있다.�

《처리결과》항목에는�《총�검사개수/처리�못한�개수》형식으로�실시간감시의�처리결

과를�표시한다.��

《시작》단추를�찰칵하면�실시간감시를�시작한다.��

《중지》단추를�찰칵하면�실시간감시를�중지한다.��

실시간감시리력창문에는�발견된�비루스들의�리력을�보여주며�《리력지우기》단추를�

찰칵하여�리력들을�삭제할수�있다.��

《설정》에는�실시간감시설정을�간단히�표시하며�이�부분을�마우스로�찰칵하여�설정

값을�변경할수�있다.��

설정값표시부분에�《기정》과�《사용자정의》가�있는데�이에�대한�내용은�동작설정의�

실시간감시설정도움말에�상세히�밝혀져있다.��

-�보고부분에서는�《파일검사결과》와�《격리결과》를�보여준다.�

《파일검사결과》에서는�파일검사와�예약검사에서�발견된�비루스파일들의�처리리력을�

관리한다.�
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《모든�리력삭제》단추를�찰칵하면�모든�파일검사리력이�삭제된다.��

《삭제》단추를�찰칵하면�선택한�파일검사리력이�삭제된다.��

《격리결과》에서는�비루스검사에서�격리된�파일들을�관리한다.�
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《전체선택》단추를�찰칵하면�격리된�모든�파일들을�선택한다.��

《복원》단추를�찰칵하면�선택한�격리파일들을�본래의�위치로�복원한다.��

《삭제》단추를�찰칵하면�선택한�격리파일들을�삭제한다.��

-�갱신에서는�비루스왁찐패턴들에�대한�갱신을�진행한다.�만일�패턴을�구입하였다면�

갱신경로에�패턴이�있는�서류철을�추가하고�《갱신》단추를�찰칵한다.�
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《갱신》단추를�찰칵하여�패턴갱신을�진행한다.��

《추가》단추를�찰칵하여�갱신경로항목에�패턴이�있는�경로를�추가할수�있다.�

《삭제》단추를�찰칵하여�선택한�갱신경로를�삭제할수�있다.��

《정보》에서는�패턴의�최종날자를�표시하여준다.�

3) 동작설정 

《클락새2.0》프로그람에서는�파일검사,�실시간감시,�예약검사,�패턴갱신에�대한�동

작설정을�진행한다.�

�

검사준위

압축파일검사

감염되였을 때의 동작

치료불가능한 경우 처리방식:

주기:한달에 한번, 날자:1, 시간: 12시

치료 문의

기정(2) 

변경(G) 

기정(1) 

 

파일검사설정 

MByte�

예약검사
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① 파일검사설정�

여기에서�진행하는�설정은�파일검사와�예약검사에�사용한다.�

《검사준위》설정은�비루스검사를�진행하려는�파일을�결정한다.��

《기정(1)》설정은�압축파일검사를�진행하지�않는것이다.�

《사용자정의》설정은�기정이�아닌�설정을�의미한다.�

《감염되였을�때의�동작》에서는�처리방식과�치료불가능한�경우의�처리방식을�설정하

도록�되여있다.�

《기정(2)》설정은�설정된�방식을�본래의�《치료》,�《문의》방식으로�만든다.��

∙�처리방식��

처리방식에는�《치료》와�《검사만》하는�방식이�있다.�

《치료》는�비루스를�발견하는�경우에�자동적으로�치료를�진행한다.�

《검사만》은�비루스검사만�진행한다.�

∙�치료불가능한�경우��

치료불가능한�경우�처리에는�격리,�삭제,�문의,�무시가�있다.�

《격리》는�치료불가능한�파일을�격리한다.�

《삭제》는�치료불가능한�파일을�삭제한다.�

《문의》는�치료불가능한�파일에�대한�처리를�사용자에게�문의한다.�

《무시》는�치료불가능한�파일을�무시한다.�

《예약검사》항목에는�현재�설정되여있는�예약검사설정값을�표시하며�《변경》단추를�

찰칵하여�나타나는�《예약검사설정》대화칸에서�예약검사설정을�변경할수�있다.��
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여기에서는�예약검사를�위한�시간설정과�검사를�위한�경로설정을�진행한다.�

∙�예약검사시간설정��

예약검사시간설정에는�《주기》,�《요일》,�《날자》,�《시간》설정이�있다.�

《주기》는�《한달에�한번》,�《한주에�한번》,�《하루에�한번》으로�설정할수�있다.�

주기를�《한달에�한번》으로�설정하면�날자와�시간을�설정하여야�한다.�다음으로�주기를�

《한주에�한번》으로�설정하면�요일과�시간을�설정하여야�한다.�또한�주기를�《하루에�한

번》으로�설정하면�시간을�설정하여야�한다.�

∙�예약검사경로설정��

예약검사경로설정은�크게�《모든�경로》설정과�《특정한�경로》설정으로�되여있다.�

예약검사경로를�《모든�경로》로�설정하면�콤퓨터안의�모든�파일들에�대하여�비루스검

사를�진행하도록�한다.�

예약검사경로를�《특정한�경로》로�설정하면�사용자가�추가한�서류철에�대하여�비루스

검사를�진행하도록�한다.�

② 실시간감시설정�

여기에서는�실시간감시에�필요한�설정을�진행한다.�

�

《프로그람기동시에�실시간감시�시작》은�프로그람이�기동하면�자동적으로�실시간감시

를�진행하도록�한다.��

�

�

실시간감시 설정 

검사준위

압축파일검사

감염되였을 때의 동작

처리방식

치료 문의

치료불가능한 경우 

기정(1) 

기정(2) 

프로그람기동시에 실시간감시 시작(Y)

MByte 
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련습문제 

1.�콤퓨터비루스란�무엇이며�비루스감염증상에�대하여�말하여라.�

2.�콤퓨터비루스방지대책에는�어떤것들이�있는가를�말하여라.�

3.�콤퓨터비루스가�콤퓨터하드웨어를�물리적으로�파괴하거나�손상시킬수�있는가를�말하여라.�

4.�콤퓨터비루스는�왜�완전히�방지할수�없으며�《만능》의�왁찐을�개발할수�없는것은�무

엇때문인가를�말하여라.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

미래의 콤퓨터 

① 초병렬콤퓨터(Massively Parallel Computer) 

수십개�혹은�수백개의�주변장치를�병렬로�련결하여�콤퓨터의�성능을�훨씬�높인�병

렬처리콤퓨터를�초병렬콤퓨터라고�한다.�

고도의�안전기능과�확장성,�인간의�화상인식과�비슷한�처리속도를�가진�초병렬콤

퓨터는�그�우점으로�하여�그�응용분야가�계속�넓어지고있다.�

② 신경콤퓨터(Neuro-Computer) 

인간의�두뇌와�비슷한�내부구조를�가진�콤퓨터를�신경콤퓨터라고�한다.�

콤퓨터기술이�발전하면서�사람처럼�말하고�사고하며�듣고�처리하는�콤퓨터를�개발

할것을�요구하였다.�이러한�요구로부터�신경콤퓨터가�출현하였다.��

과학과�기술의�발전과�함께�사고하는�콤퓨터,�사람과�류사한�신경콤퓨터를�곧�개

발해낼것이다.�

③ 량자콤퓨터 

량자콤퓨터는�원자를�처리소자와�기억소자로�하는�콤퓨터이다.��

반도체소자의�집적도가�앞으로�극한점에�달하게�되는�조건에서�현재방법으로서는

콤퓨터의�성능을�더�높이기가�어렵다.�이러한�제한성을�극복하기�위해�개발되고있는것

이�바로�량자콤퓨터이다.�

④ 빛콤퓨터(Optical Computer) 

빛콤퓨터는�빛특성을�리용하여�자료의�기억이나�연산을�진행하는�콤퓨터이다.�

�

알아두기 
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제2장. 문서만들기 

제1절. 문서의 형식화 

문자렬의�정확한�배치와�보다�쉽고�보기�좋은�문서를�작성하기�위한�각이한�항목의�설

정,�표나�그림�및�각종�점선이나�테두리선치기�등�문서의�형태를�잘�만드는것은�문서작성

에서�중요한�부분을�이룬다.�

문자렬의�배치나�글자의�모양과�크기�등�문서의�형태를�설정하는것을�문서의�형식화

(혹은�서식화)라고�한다.��

문서의�형식화는�문서입력이�끝난�다음�문서의�형식을�갖추는�방법으로�할수도�있고�

문서의�형식화를�먼저�설정하고�문서입력을�할수도�있다.�

1. 문자렬의 들여쓰기와 맞추기 

단락단위로�왼쪽과�오른쪽의�여백을�변화시키기�위하여서는�들여쓰기(Indent)기능을�

리용하여야�한다.��

여러행에�달하는�본문에서�매개�문자렬의�첫�위치를�맞추기�위해서는�Tab건을�리용하

는것이�편리하다.�

1) 문자렬의 들여쓰기설정 

《글》창문의�도구띠에는�들여쓰기설정단추� 들이�있으며�수평자에는�왼쪽과�

오른쪽의�들여쓰기설정자� ,� 들이�있다.��

들여쓰기단추들가운데서� 단추를�찰칵할�때마다�한�단락씩�들여쓰기를�진행하며�

단추를�찰칵할�때마다�한�단락씩�들여쓰기가�해제된다.�또한�수평눈금자의�왼쪽에�있

는�왼쪽�들여쓰기설정자� 를�오른쪽으로�끌기하면�그만한�간격으로�왼쪽들여쓰기가�진행

된다.�

왼쪽�들여쓰기설정자의�아래3각형을�끌기하면�왼쪽�들여쓰기설정자들이�동시에�끌기

되면서�본문의�왼쪽이�같은�수직선상으로�옮겨진다.�

단락의�첫�행을�들여쓰기�위해서는�왼쪽�들여쓰기설정자의�웃3각형(웃줄의�설정자)을�

끌기한다.�그러면�단락의�첫�행에�공백을�넣지�않아도�자동적으로�들여쓰기가�진행된다.�

두행이상으로�된�단락의�두번째�행부터�왼쪽맞추기를�하기�위해서는�그�단락에�유표를�

옮기거나�단락을�선택하고�왼쪽�들여쓰기설정자의�아래3각형을�끌어서�조절한다.�
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�

차림표지령을�리용하여서도�들여쓰기를�진행할수�있다.�

차림표에서�《서식》→《단락》지령을�실행한다.�혹은�지름차림표에서�《단락》

지령을�실행한다.�그러면�《단락》대화칸이�나타난다.�

�

�

�

�

�

�
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�

�

본문앞을�들여쓰기�위해서는�《본문앞》칸에�단락의�왼쪽들여쓰기할�간격을�직

접�입력하거나�우아래화살단추를�찰칵하여�설정한다.�

만일�0보다�작은�즉�부수를�입력하면�기본구역밖으로�단락이�이동된다.�

본문뒤의�들여쓰기를�설정해주기�위해서는�《본문뒤》칸에�단락의�오른쪽들여쓰

기를�진행할�간격을�설정한다.��

첫�행을�들여쓰기�위해서는�《첫�행》칸에�해당�값을�설정해준다.�

서체크기와�행간격에�따라�단락을�자동적으로�들여쓰기�위해�《자동》을�선택해

주면�《첫�행》칸의�설정은�무시된다.�

대화칸에서�설정한�내용들은�대화칸의�오른쪽에�있는�미리보기칸을�통하여�확인

할수�있다.�

알아두기 
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2) 문자렬맞추기 

여러행으로�된�본문에서�매개�문자렬의�첫�위치를�맞추기�위해서는�Tab를�리용하는것

이�좋다.��

Tab건을�누르면�미리�설정한�위치로�유표가�옮겨진다.�

한번�Tab건을�사용하여�얼마나�이동하겠는가를�자유롭게�설정할수�있다.�

Tab를�삽입하려는�위치에�유표를�옮기고�Tab건을�누르면�미리�설정된�너비만큼�유표

가�옮겨지면서�그뒤의�본문도�밀리운다.�

아래의�그림은�단락의�첫�위치에서�Tab건을�한번�눌렀을�때�세�글자분의�너비만�한�

Tab가�삽입되였다는것을�보여주고있다.�

�

�

�

�

�

�

�

Tab는�문자와�같이�취급되므로�문자렬의�도중에�유표를�놓고�Tab건을�누르면�그�위

치에�문자렬을�맞출수�있다.�

Tab위치의�설정과�변경은�수평눈금자에서�지정하려는�자리를�찰칵하여�진행할수�있는

데�이때�표시된�Tab표식자를�끌기하여�위치를�이동할수�있다.�또한�추가된�Tab표식자를�

수평자로부터�바깥으로�끌기하면�삭제할수�있다.�

입력된�Tab는�Delete건�혹은�거꾸로지우기(BackSpace)건을�리용하여�삭제할수�있다.�

Tab에는�Tab표식자의�모양에�따라�왼쪽맞추기(┖),�중심맞추기�(┷),�오른쪽맞추기

(┚),�소수점맞추기(⊥.)가�있다.�

�

�

�

�

�

�

�

�

�

�

�

�

왼쪽맞추기� 가운데맞추기 오른쪽맞추기 소수점맞추기�

여기를� 찰칵하면� Tab�

표식자가�변한다.�
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처음�Tab를�추가하면�왼쪽맞추기(┖)로�된다.�이것을�다

른�형태의�맞추기로�변경시키려면�변경시키려는�표식자우에서�

오른쪽찰칵한다.�이때�나타나는�표식자목록에서�해당한�표식

자를�선택하여�변경한다.�

�

�

�

�

�

��

Tab표식자의�형태를�바꾸거나�위치와�Tab간격을�변화시키려면�수평자의�아무런�Tab

표식자를�두번찰칵하거나�《서식》→《단락》지령을�실행하여�《단락》대화칸을�열기한다.�

�

이�대화칸의�《표쪽》표쪽을�찰칵하여�Tab의�위치,�류형,�채움문자를�설정하고�《새

로�만들기》단추를�찰칵한다.�여기서�채움문자는�Tab의�왼쪽공백을�점선이나�실선�또는�

어떤�문자로�채우기�위한것이다.��

�

이미�설정된�상태에서�Tab표식자를�변경시키자면�어떻게�해야�하

는가?�

생각하기 
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2. 항목부호와 단락기호붙이기 

1) 항목부호불이기 

서식지정도구띠에는�항목별로�번호�또는�부호를�자동적으로�붙여주는�도구들이�있다.�

도구띠의��항목부호�적용/해제도구� ,�번호매김�적용해제도구� 는�항목별로�번

호�혹은�부호를�붙이려고�할�때�리용한다.�

항목부호붙이기를�하려면�다음과�같이�한다.�

①�항목부호를�붙이려는�문자렬범위를�선택한다.�

②�항목부호붙이기도구를�찰칵한다.�그러면�번호�혹은�항목부호가�붙여진다.�

항목부호붙이기기능을�설정한�상태에서�Enter건을�눌러�행을�바꾸면�다음행에도�항목

부호가�붙는다.�항목부호붙이기기능을�해제하려면�두번이상�행바꾸기를�해야�한다.�

자기가�요구하는�형태의�항목부호를�붙이려면�다음과�같은�조작을�진행한다.�

①�《서식》→《항목부호�및�번호매김》지령을�실행한다.�그러면�《항목부호�및�번호

매김》대화칸이�나타난다. 

 

②�대화칸에서�《항목부호》표쪽을�찰칵하고�요구되는�항목부호형태를�선택한다.�

③�《확인》단추를�찰칵한다.�

대화칸에서는�또한�《번호매김격식》,�《도형》,�《위치》,�《사용자정의》표쪽을�찰

칵하여�번호매김격식들과�도형기호,�항목부호의�표시위치,�새로운�항목부호를�사용자가�정

의하여�붙이기�등을�진행할수�있다.�
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이미�붙인�항목부호나�번호를�해제하려면�범위를�선택한�다음�항목부호나�번호매김격

식표쪽을�선택하고�해당한�형식을�설정한�다음�《제거》단추를�찰칵하면�된다.�

2) 단락기호붙이기 

문서에서�단락은�Enter건을�누르기한�사이에�들어있는�작은�《본문묶음》을�말한다.�

문자렬을�입력할�때�행의�오른쪽끝에�이르면�자동적으로�다음행에로�유표가�이동된다.�

이렇게�련속되다가�Enter건을�눌러야�다음행이�새�단락의�시작으로�된다.�

도구띠의�인쇄하지�않는�문자그림기호� 를�찰칵하면�매�단락의�끝에�단락기호가�삽

입되며�다시�찰칵하면�단락기호가�해제된다.�단락기호는�문서의�단락상태를�알수�있게�해

준다.�

한�단락안에서�새로운�행을�시작하려고�할�때에는�Shift+Enter건을�눌러준다.�그러면

유표는�한�단락안에서�다음행의�선두로�이동한다.�

�

�

�

�

�

�

 

 

 

 

 

 

 

 

 

 

3. 행과 단락 및 글자사이의 간격설정 

①�간격을�설정하려는�범위(행,�단락)를�선택한다.�

②�차림표띠의�《서식》→《단락》지령을�실행한다.�혹은�지름차림표에서�《단락》지

령을�실행한다.�이때�나타나는�《단락》대화칸에서�《들여쓰기�및�간격》표쪽을�찰칵한다.�

Shift�+�Enter�
Enter�

�

콤퓨터상식

사람의�말을�듣고�그것을�동시에�그대로�받아쓰는�이�콤퓨터는�3만개까지의�단어

들을�정확히�분간하며�1분동안에�24～40개의�단어들을�받아쓴다.��

이�콤퓨터는�단어와�단어사이의�시간간격을�0.25초정도로�하여도�정확하게�받아

쓸수�있는데�이것은�보통�방송원이�시사보도를�할�때�말하는�속도보다�2배나�빠른�속

도라고�한다.�
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�

③�단락과�단락사이의�아래,� 우간격을�설정해주기�위해서는�

《간격》부분에서�《단락웃쪽》,�《단락아래》칸에�해당한�값을�설

정해준다.��

값입력은�해당�칸의�내리화살단추� 를�찰칵하든가�혹은�직접�

입력한다.�

④�행과�행사이간격을�설정한다.�

이�간격은�《행간격》부분에서�내리화살단추� 를�찰칵하고�이때�펼쳐지는�내리펼침

목록에서�행간격을�설정해준다.�

《1행》:�현재�선택된�본문의�행사이�간격을�1행�간격으로�설정한다.(표준설정)�

《1.5》행:�행간격을�1.5행만�한�간격으로�설정한다.�

《2행》:�행간격을�2개�행만�한�간격으로�설정한다.�

《비례》:�행간격을�백분률값으로�설정한다.�100%는�1행에�해당된다.�

《최소》:�칸에�입력한�값으로�행간격을�최소행간격으로�설정한다.�

한�단락안에서�서로�다른�서체크기를�사용하였을�때�《글》은�행간격을�자동적으로�사

용된�최대서체크기에�맞게�조종한다.�모든�행에�대하여�같은�행간격을�보장해야�할�경우에�

최대서체에도�《최소》에서�지정하여�보장할수�있다.�

《앞서기》:�두�행사이에�삽입된�세로간격의�높이를�설정한다.�

《고정》:�칸에�입력한�값과�정확히�일치하는�행간격을�설정한다.�
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문자들사이의�간격을�설정하기�위하여서는�다음과�같이�한다.�

①�문자들사이간격을�조절하려는�문자렬을�선택한다.�

②�《서식》→《문자》지령을�실행(혹은�지름차림표에서�《문자》지령을�실행)하여�나

타나는�《문자》대화칸에서�《위치》표쪽을�찰칵한다.�

�

③�《간격》부분에서�간격을�어떻게�하겠는가�즉�표준으

로�하겠는가,�넓게�혹은�좁게�하겠는가를�선택한다.�

④�《간격》칸에�간격값을�설정해준다.�

⑤�《확인》단추를�찰칵한다.�

글자들의�방향도�설정해줄수�있다.�이를�위해서는�《배률》부분에서�문자들의�방향�즉�

각도를�선택해주면�된다.�

�

그리고�《너비배률》칸에서는�문자들의�배률을�％로�설정해준다.�

《문자》대화칸에서는�또한�선택한�문자의�우�혹은�아래배치를�설정하여�줄수도�있다.�

이를�위해서는�대화칸의�《위치》부분에서�해당�위치�즉�웃첨자로�하겠는가,�아래첨자로�

하겠는가�또는�보통으로�하겠는가를�설정해주면�된다.�
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4. 문서의 렬가르기 

문서를�작성할�때�본문을�둘�또는�그이상의�렬로�배치하여야�할�경우가�있다.�이런�경

우에는�렬을�설정하면�쉽게�여러렬로�편성할수�있다.��

렬은�문서의�전체�또는�일부�또는�부분마다에�설정할수�있다.�

렬을�구성하는�방법은�다음과�같다.�

①�《서식》→《렬》지령을�실행한다.�그러면�《렬》대화칸이�펼쳐진다.�

�

②�《설정》부분에서�《렬》칸에�렬의�개수를�설정해준다.�

③�《너비와�간격》부분에서�《자동너비》선택을�해제하고�《너

비》칸과�《간격》칸에�해당�값을�입력하여�렬의�너비와�렬들사이의�

간격을�설정해줄수�있다.�이때�미리보기칸에서�설정상태의�렬을�미

리보기할수�있다.�

④�《구분선》부분에서�렬구분선의�격식을�선택해준다.�구분선을�사용하지�않으려면�

《없음》을�선택한다.�그리고�《높이》칸과�《위치》칸에서�구분선의�높이와�수직맞추기를�

선택해준다.�

⑤�《확인》단추를�찰칵한다.�
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련습문제 

 

1.� 콤퓨터교과서의� 머리말내용을� B5호용지의� 크기에� 왼쪽여백과� 오른쪽여백을� 각각�

1.5cm,�아래와�우의�여백을�각각�2.05cm로,�행사이간격�1.5행,�첫�행�들여쓰기�

0.5cm,�오른쪽들여쓰기�0.25cm로�설정하고�편집하여라.�

2.�문서의�렬가르기기능을�리용하여�다음과�같은�문서를�작성하여라.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

위대한�령도자�김정일원수님의�현

명한�령도에�의하여�오늘�우리�나라에

서는�인민경제�여러�부문의�콤퓨터화

가�실현되고�모든�작업이�콤퓨터에�의

하여�진행되므로�이제는�누구나�콤퓨

터를�능숙하게�다루어야�한다.�

우리�식의�정보기술,�프로그람기

술을�주체적립장에서�발전시키기�위

하여서는�우리�식의�조작체계프로그

람인�《붉은별》을�기초로�한�새로운

응용프로그람들을�적극�개발하고�널

리�리용해나가야�한다.�

���

모든�학생들은�콤퓨터의�자료를

관리하는�초보적인�지식과�콤퓨터문

서편집프로그람인�《글》을�리용하여

여러가지�문서를�만드는�방법을�잘

알아야�한다.�우리는�콤퓨터에�대한

학습을�열심히�하여�지식경제의�시

대,�정보산업시대의�능력있는�과학

자,� 기술자후비들로� 준비함으로써

위대한�령도자�김정일원수님의�크

나큰�믿음과�기대에�높은�실력으로

보답하여야�한다.�

�

 

문서의 형식화속성복사 

형식화를�진행한�문서의�부분과�꼭같은�형식화를�해야�할�부분이�있을�때에는

매번�조작을�반복하지�않고�형식화속성복사도구� 를�리용하여�간단히�진행할수

있다.�

먼저�이미�형식화한�부분(단어,�문장,�행,�단락�등�문자렬)을�선택하고�표준도

구띠의�형식화속성복사도구를�선택한다.�

다음�같은�형식화를�진행하려는�문자렬이나�행에�마우스지시자를�옮기면�지시자

의�모양이�색감통모양� 으로�변하는데�이때�형식화를�진행하려는�위치까지�끌기

한다.�

이렇게�하면�문자렬배치와�서체,�문자렬맞추기,�글자나�행�또는�단락사이간

격�등의�형식화를�매번�하지�않고도�이미�진행한�형식화상태를�그대로�다른�부분

에�설정할수�있다.�

알아두기 
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제2절. 객체를 리용한 문서작성 

1) 표작성 

표는�행과�렬번호로�식별할수�있는�칸들로�이루어진다.��

표를�이루는�개개의�칸들을�세포라고�한다.�

-�표의 삽입 

①�표를�삽입하려는�위치에�유표를�이동한�다음�표준도구띠의�표그림기호� 를�

찰칵한다.�그러면�《표삽입》대화칸이�나타난다.�

�

②�《이름》칸은�기정으로�《표1》로�되며�이�칸에�사용자의�의도에�맞게�이름을�

준다.��

③�《크기》부분의�《렬》,�《행》칸에�삽입하려는�표의�렬수와�행수를�준다.�

④�《추가선택》부분에서�필요한�추가선택을�진행한�다음�《확인》단추를�찰칵한다.�

그러면�표가�삽입된다.�또한�표삽입대화칸에서�《자동서식》단추를�찰칵하면�《자동서식》

대화칸이�표시된다.��

�
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《자동서식》대화칸의�《서식》목록에서�서식형식을�지정하여�표의�형식을�변경할수�

있다.�

�

�

�

�

�

표그림기호� 의�내림화살단추를�찰칵하여�표시되는�

표모양의�그림에서�끌기하여�행과�렬의�수를�지적하면�해당한�

위치에�표가�삽입된다.�

- 표의 삭제 

표를�삭제하기�위해서는�표의�앞에�있는�단락의�끝에서부

터�표의�뒤에�있는�단락의�시작까지�선택(표전체�선택)한�다

음�Delete건을�누른다.�또는�표를�선택하고《표》→《삭제》→《표》지령을�실행한다.�

- 행 및 렬의 삽입과 삭제 

(1)�행�또는�렬�선택�

행을�선택하기�위하여서는�행의�시작위치(표밖의�왼쪽여백)에�마우스지시자를�이동

시키고�지시자의�모양이�➡로�되였을�때�찰칵하면�그�행이�선택된다.�같은�방법으로�렬

을�선택하려면�렬의�시작위치(표밖의�웃여백)에�지시자를�옮겨�지시자의�모양이�⬇으로�

되였을�때�찰칵하면�그�렬이�선택된다.�

�

표전체를�선택하기�위하여서는�표의�왼쪽웃모서리에�마우스지시자를�옮겨�지시자의�

모양이����으로�되였을�때�찰칵한다.�

(2)�행�및�렬의�삽입과�삭제�

《보기》→《도구띠》→《표》지령을�실행한다.�그러면�표도구띠가�나타난다.�

�

다른�방법으로�표를�삽입할수는�없겠는가?�

생각하기 
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�

�

�

�

�

�

�

�

1-표도구��2-선격식도구��3-테두리색갈도구��4-테두리도구��5-배경색도구��

6-세포합치기도구��7-세포분할도구��8-최적화도구��9-웃쪽도구��10-가운데도구�

11-아래쪽도구��12-행삽입도구��13-렬삽입도구��14-�행삭제도구��15-렬삭제도구�

16-자동서식도구��17-표속성도구��18-정렬도구��19-합계도구�

�

다음�행�또는�렬을�삽입하려는�위치(표의�해당한�세포)에서�행삽입도구(12)�또는�

렬삽입도구(13)를�찰칵한다.�이때�유표가�있는�세포의�아래에�새로운�행(또는�유표가�

있는�세포의�오른쪽에�렬)이�삽입된다.�

행이나�렬을�삭제하기�위하여서는�제거하려는�행이나�렬을�선택하고�행삭제도구

(14)�또는�렬삭제도구(15)를�찰칵한다.�

- 행높이 및 렬폭의 변경 

변경시키려는�행�또는�렬의�선에�마우스지시자를�가져가면�마우스지시자의�모양이�쌍

방향화살모양으로�변화된다.�이때�끌기하여�행의�높이�또는�렬의�너비를�변경시킨다.�

-�세포의 결합과 분할 

여러개의�세포를�결합하기�위하여서는�결합하려는�세포들을�끌기로�선택하고�표도구

띠의� 세포합치기도구를� 찰칵한다.(또는� 결합하려는� 세포들을� 선택하고� 지름차림표에서�

《세포》→《합치기》지령을�실행한다.)�

한개�세포를�분할하기�위하여서는�해당한�세포에�유표를�놓고�표도구띠의�세포가르기

도구를�찰칵한다.�그러면�《세포가르기》대화칸이�나타난다.�

�

1������2����3�������4�����5������6����7���8

9�10���11���12��13��14��15���16��17���18���19�
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이�대화칸의�《분할》,�《방향》부분에서�가르기수,�분할방향�등을�설정하고�《확인》

단추를�찰칵한다.�또는�지름차림표에서�《세포》→《분할》지령을�실행하여�할수도�있다.�

2) 도형의 작성과 리용 

수학문제집과�같은�문서파일에는�여러가지�도형들과�그림들이�있다.�

이�도형이나�그림은�삽입하거나�그려넣을수�있다.�

- 선의 삽입 

①�표준도구띠의�그리기기능보이기그림기호� 를�찰칵한다.�그러면�다음과�같은�

도구띠가�나타난다.�

�

②�《선》그림기호�／를�찰칵한다.�그러면�마우스지시자의�모양이�+/로�변한다.�

③�선을�그리려는�첫�위치에서부터�마지막위치까지�끌기하여�선을�그린다.�이때�Shift

건을�누른�상태에서�끌기하면�시작위치에서�45°의�각도로�직선이�그려진다.�

선에�해당한�형식을�주려면�선을�선택하고�지름차림표에서�《선》지령을�실행한다.�그

러면�《선》대화칸이�나타나는데�《선》,�《음영》,�《선격식》,�《선끝》표쪽을�찰칵하여�

그리기색,�그리기선의�굵기,�음영,�선의�형식(격식)�등을�설정해줄수�있다.�

�
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선그리기를�끝내려면�문서의�임의의�위치에서�찰칵하거나�Esc건을�누른다.�

그려넣은�직선을�선택하기�위하여서는�도구띠의�선택도구� 를�찰칵하고�해당한�

직선이�있는�부분을�선택할수�있다.�

여러개의�직선을�포함하는�부분을�끌기로�선택하면�여러개의�직선을�동시에�선택할

수�있다.�

그리기도구띠에는�4각형,�원,�타원�등�기초도형들을�그릴수�있는�그림기호들이�있

다.�해당한�그림기호를�선택하고�본문구역에서�끌기하여�그린다.�이때�Shift건을�누른

채로�끌기하면�바른4각형과�원을�그릴수�있다.�

그려진�도형에�대한�외형선과�내부색�등�속성설정은�해당한�도형을�선택하고�오른

쪽찰칵하여�표시되는�지름차림표에서�해당한�지령을�실행하여�진행한다.�

- 기본도형의 삽입 

그리기도구띠에는�직선,� 4각형,�원뿐만이�아니라�둥

근4각형,� 5각형,� 등변4각형,� 6각형,� 원기둥,� 직6면체,�

평행4변형�등�각종�도형들을�그릴수�있는�기본도형도구가�

있다.�

그리기도구를�찰칵하면�도형들이�표시된다.�

여기서�해당한�도구를�선택하고�도형을�삽입하려는�위

치에서�끌기하여�그린다.�

실례로�테두리는�붉은색의�사슬선이고�내부색은�진보라

색인�직4각형을�그려보기로�하자.�

①�그리기도구띠의�기본도형에서�직4각형을�선택한�다음�직4각형을�그린다.�

②�직4각형을�선택하고�지름차림표에서�《선》지령을�실행한다.�

③�이때�펼쳐지는�《선》대화칸의�《선격식》표쪽을�찰칵한다.�

�

④�선격식을�《사슬선3》으로�한다.�
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⑤�《선》표쪽을�찰칵하고�《색갈》칸에서�밝은�붉은색을�선택한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

⑥�《선》대화칸의�《확인》단추를�찰칵한다.�

⑦�직4각형을�선택하고�지름차림표에서�《구역》지령을�실행한다.�그러면�《구역》

대화칸이�나타난다.�

�

⑧�《구역》표쪽을�찰칵하고�《진보라색》을�선택한다.�

⑨�《확인》단추를�찰칵한다.�

《구역》대화칸에서는�다음과�같은�기능들도�설정해줄수�있다.�

∙�그림자를�설정해줄수�있다．�
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그림자를�주기�위해서는�《음영》표쪽을�찰칵하고�《음영사용》을�선택해준�다음�

《색갈》칸에서�색을�선택한다.�

�

《간격》칸에서�도형과�그림자사이�간격을�얼마로�하겠는가를�설정해줄수�있다.�

∙�투명도와�색갈을�줄수�있다．�

이를�위해서는�《투명》표쪽과�《색갈》표쪽을�찰칵하여�해당�값을�설정해준다.�

�
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�

∙�경사도무늬를�설정해줄수�있다．�

《경사도》표쪽을�찰칵하고�해당�설정을�진행한다.�

�
∙�평행선그늘，�비트도무늬를�설정해줄수�있다．�
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《평행선그늘》,�《비트도》표쪽을�찰칵하고�필요한�무늬설정을�해줄수도�있다.�

�

�
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- 도형의 묶기와 배치 

(1)�도형의�묶기�

여러개의�도형이�한곳에�나란히�놓여있는�경우�그것들을�묶어서�하나의�객체로�만들어

놓으면�전체적으로�크기를�변화시키거나�이동시키며�형식화를�하는�등의�조작을�할�때�매

우�편리해진다.��

여러개의�도형을�묶는�방법은�다음과�같다.�

①�그리기도구띠의�선택도구를�찰칵하고�끌기로�묶으려는�도형을�모두�선택한다.�

②�지름차림표에서�《묶음화》지령을�실행한다.�그러면�선택된�여러개의�도형이�하나

의�묶음화된�도형으로�되는것을�볼수�있다.�

(2)�도형의�배치�

문서안에�그려넣은�도형이나�삽입한�그림들은�본문우에�놓이면서�본문을�보이지�않

게�하거나�배치상태가�적당하지�못할수�있다.�때문에�도형을�정확히�배치하여�본문과의�

배치관계를�잘�조절하여야�한다.�

도형배치는�다음의�방법으로�한다.�

①�배치하려는�도형(또는�그림)을�선택한다.�

②�지름차림표에서�《위치�및�크기》지령을�실행한다.�그러면�《위치�및�크기》대

화칸이�나타난다.�

�

③�《위치�및�크기》표쪽을�찰칵하고�《크기》,�《위치》,�《지탱점》부분에서�도

형의�크기와�수평,�수직위치�그리고�배치하기�위한�기준위치�등을�설정한다.�

④�《회전》표쪽을�찰칵하여�회전점의�위치와�회전각도를�설정하여�도형을�임의의�

각도로�회전시켜�배치할수�있다.�
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⑤�지름차림표의�《맞추기》지령에서�맞추기를�왼쪽,�오른쪽,�웃쪽�등�어디로�하겠

는가를�설정한다.�

-�서체장식문자렬의 삽입 

그리기도구띠의�장식문자-화첩도구� 를�리용하면�문서에�여러가지�모양의�장식

문자렬을�삽입할수�있다.�

①�장식문자-화첩도구를�찰칵한다.�그러면�《장식문자-화첩》대화칸이�나타난다.��

�

�

�

�

�

�
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�
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�
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②�요구되는�장식문자형태를�선택한다.�

③�《확인》단추를�찰칵한다.�그러면�서체작업객체가�문서에�삽입된다.�

④�객체를�두번찰칵한다.�그러면�본문편집방식으로�된다.�

⑤�서체장식문자렬을�입력한다.�

서체작업객체를�선택하고�지름차림표에서�추가적으로�서체형식을�설정할수�있다.�

⑥�입력이�끝난�다음�객체밖에서�찰칵하면�만든�장식문자렬이�문서에�표시된다.�

�

3) 여러가지 객체의 삽입(화첩에서 객체삽입, 배경그림지정) 

- 본문과 도형의 삽입 

(1)�본문파일의�삽입�

①�삽입하려는�위치에서�찰칵한다.�

②�《삽입》→《파일》지령을�실행한다.�그러면�《삽입》대화칸이�나타난다.�

③�대화칸에서�삽입하려는�본문파일을�선택한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

④�《삽입》단추를�찰칵한다.�그러면�선택한�본문파일이�삽입된다.�

(2)�그림의�삽입�

①�문서의�삽입하려는�위치에서�찰칵한다.�

②�차림표띠에서�《삽입》→《그림》→《파일로부터》지령을�실행한다.�그러면�

《그림삽입》대화칸이�나타난다.�
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③�삽입하려는�그림을�선택하고�《열기》단추를�찰칵한다.�그러면�선택한�그림이�

본문에�삽입된다.�

《화첩》그림기호를�리용한�그림삽입에�대하여�보기로�하자.�

①�그림을�삽입하려는�위치에서�찰칵한다.�

②�표준도구띠의�화첩그림기호� 를�찰칵한다.�그러면�《화첩》칸이�표시된다.�

�

③�해당한�주제를�선택하면�그옆칸에�그림들이�표시되는데�여기서�그림을�끌기하여�

문서에�삽입하거나�선택한�상태에서�오른쪽찰칵으로�지름차림표를�표시하고�삽입지령을�

실행한다.�

페지에�배경그림을�앉히기�위해서는�지름차림표의�《삽입》→《배경》→《페지》�

지령을�실행하면�된다.  
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《우리》 《글》에서 쓰이는 지름건 

지름건� 효과�

Ctrl+Shift+M� 단락기호의�표시를�적용/해제�

F12건� 번호매김적용�

Ctrl+Shift+T� 표삽입�

Shift+F12� 항목부호적용�

Ctrl+Shift+F12� 번호매김/항목부호�해제�

Ctrl+A� 모두�선택�

Ctrl+J� 량쪽맞추기�

Ctrl+D� 2중밑줄�

Ctrl+E� 가운데�

Ctrl+F� 찾아�바꾸기�

Ctrl+Shift+P� 웃첨자�

Ctrl+L� 왼쪽맞추기�

Ctrl+R� 오른쪽맞추기�

Ctrl+Shift+B� 아래첨자�

Ctrl+Y� 마지막작업을�다시�실행�

Ctrl+Shift+Enter� 여러�렬의�본문에서�렬가르기�

Alt+Enter� 항목부호에서�항목부호없이�새로운�단락삽입�

Ctrl+왼쪽화살표� 단어시작으로�이동�

Ctrl+Shift+왼쪽화살표� 단어별�왼쪽으로�선택�

Ctrl+오른쪽화살표� 단어의�끝으로�이동�

Ctrl+Shift+오른쪽화살표� 단어별�오른쪽으로�선택�

Ctrl+Alt+웃방향화살표� 현재�단락이나�선택된�단락을�한�단락�웃쪽으로�이동�

Ctrl+Alt+아래방향화살표� 현재�단락이나�선택된�단락을�한�단락�아래로�이동�

알아두기 
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�

Ctrl+A�

현재�세포가�비여있을�경우:�전체�표에�선택표시�

그외:�현재�세포를�내용에�선택표시,�다시�동작시키면�전체�표가

선택됨�

Ctrl+Home�

현재�세포가�비여있을�경우:�표의�시작으로�이동��

그외:�처음�누르면�현재�세포의�시작으로�이동,�다시�누르면�현재

표의�시작으로�이동,�세번째로�누르면�문서시작으로�이동�

�

Ctrl+End�

�

현재�세포가�비여있을�경우:�표끝으로�이동�

그외:�처음�누르면�현재�세포의�끝으로�이동,�다시�누르면�표의�

끝으로�이동,�다시�누르면�문서끝으로�이동�

Ctrl+Tab� 세포에�표쪽을�삽입�

Alt+화살표� 오른쪽/왼쪽�세포모서리에서�렬�및�행�척도조절�

Alt+Shift+화살표� 왼쪽/웃쪽�세포모서리에서�렬�및�행�척도조절�

Alt+Ctrl+화살표� Alt와�같지만�현재�세포만�수정�

Ctrl+Alt+Shift+화살표� 다음의�Alt와�같지만�현재�세포만�수정�

Alt+Insert�
삽입방식으로�설정하여�3초가�지나면�화살표건을�사용하여�행/렬을

삽입할수�있고�Ctrl건과�화살표건을�함께�눌러�세포를�삽입한다.�

Alt+Del�

삭제방식으로�설정하여�3초가�지나면�화살표건을�사용하여�행/렬을

삭제할수�있고�Ctrl건과�화살표건을�함께�눌러�해당�세포를�린접세포와

합칠수�있다.�

Ctrl+Shift+T�

선택된�모든�표에서�세포보호를�해제�

유표가�문서의�임의의�곳에�위치할�경우�즉�표가�선택되지�않았을

경우�모든�표의�세포보호가�해제된다.�

Shift+Ctrl+Del�

전체�세포가�선택되지�않은�경우�유표부터�현재�문장�끝까지�본문이

삭제된다.�유표가�세포끝에�있고�전체�세포가�선택되지�않은�경우�다음

세포의�내용이�삭제된다.�전체�세포가�선택되지�않고�유표가�표의�끝에

있는�경우�표의�아래에�나오는�문장이�삭제되고�단락의�나머지는�마지막

세포로�이동한다.�

표�다음에�빈줄이�나오면�빈줄이�삭제된다.�

하나이상의�세포가�선택된�경우�선택을�포함한�전체�행이�삭제된다.�

모든�행이�완전하게�또는�부분적으로�선택되였다면�전체�표가�삭제된다.�
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련습문제 

1. 자기�소년반명단을�아래와�같은�형식으로�만들어보아라.�

3학년�1반�제1소년반�명단�

�

(표의�칸수는�자기�소년반�인원수만큼�만들며�매�세포안의�글자들은�세포의�중심에�

정확히�놓이도록�배치하여라.)�

2.�다음과�같은�표를�작성하여라.�

학생�생활자료�

난�날� � 주�소� � 전화번호� �

관�계� 이�름� 직��장��직��위� 총���������평�

아버지� � � 성�적� 건�강 성�격� 특�기�

어머니� � � � � � �

모��������범� 락��������후�

학�����습� 조�직�생�활� 학�����습� 조�직�생�활�

3.�《삽입》차림표의�그림지령을�리용하여�문서에�임의의�그림을�삽입하고�객체의�편

성을�여러가지로�바꾸어보아라.�

 

 

제3절. 여러가지 기능을 리용한 문서만들기 

1) 페지번호붙이기 

- 페지머리부 및 바닥부설정 

여러�페지로�된�문서를�작성하거나�인쇄할�때에는�보통�페지의�여백에�페지번호를�

공통으로�붙이는것이�좋다.�

매�페지마다�공통적인�문자렬을�페지의�웃단여백에�붙인것을�페지머리부,�아래단여

백에�붙인것을�페지바닥부라고�부른다.�

페지의�머리부�또는�바닥부에는�페지번호를�표시할수도�있고�장,�절제목을�포함하

거나�저자이름�또는�년/월/일�등�기타�내용을�쓸수도�있다.�

페지의�머리부와�바닥부를�만드는�방법은�다음과�같다.�

아버지� 직장직위
번�호� 이�름� 성�별� 난�날� 집주소�

어머니� 직장직위

� � � � � � �

� � � � � � �
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①�《삽입》차림표의�《머리부(또는�바닥부)》→《표준》지령을�실행한다.�이때�페

지의�웃단여백(또는�아래단여백)에�편집구역(점선으로�된�4각형구역)이�나타난다.�

�

�

②�여기에�해당한�내용을�입력한다.�실례로�《화상처리기술》을�입력하고�해당한�

서식화를�진행한�다음�Enter건을�눌러�다음페지로�이동하면�그와�똑같은�문자렬이�페

지의�머리부나�바닥부에�표시된것을�확인할수�있다.�

- 페지번호붙이기 

문서에�페지번호를�붙이는�방법에는�여러가지가�있는데�그중�가장�간단한�방법은�

다음과�같다.�

페지의�머리부�또는�바닥부를�선택한�다음�《삽입》차림표의�《마당》→《페지번호》

지령을�실행하면�현재�설정된�머리부나�바닥부의�유표위치에�페지번호가�삽입된다.�

페지번호붙이기를�다른�방법으로도�할수�있다.�

페지의�머리부�또는�바닥부를�선택한다.�

①�《삽입》차림표의�《마당》→《기타》지령을�실행하여�마당대화칸을�열기한다.�

�
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②�《류형》목록에서�《페지》를�선택하고�《선택》목록에서�《페지번호》를,�《서

식》목록에서�해당서식(실례로�《아라비아식》)을�선택한다.�

《선택》목록에서�《이전�페지》를�선택하면�문서의�첫�페지에는�페지번호가�삽입

되지�않고�그�다음페지부터�페지번호가�삽입되며�《다음�페지》를�선택하면�첫�페지를�

2페지로�하여�페지번호가�삽입된다.�

③�설정이�끝나면�《삽입》단추를�찰칵하고�《닫기》단추를�찰칵하여�《마당》대화

칸을�닫는다.�

2) 차례표작성 

차례표를�작성하려면�차례내용등록하기와�차례표붙이기라는�두단계의�조작을�거쳐

야�한다.�

- 차례내용 등록하기 

차례내용의�등록은�차례에�포함될�내용들(례하면�장제목이나�절제목�등)에�미리�정

의된�격식을�적용하는것을�말한다.�

통합사무처리프로그람�《우리》《글》에서는�제목단락격식을�비롯한�격식들을�제공

하며�사용자가�자체로�정의하여�사용할수도�있다.��

다음의�그림은�차례를�작성할�문서의�실례를�보여주고있다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

머리말�

콤퓨터가�과학기술분야뿐만아니라�사회생활의�여러�분야에서�리용되고있다.�

…………………�

제1장.�콤퓨터에�대한�기초지식�

제1절.�콤퓨터의�일반개념�

1.�콤퓨터의�구성�
초기의�콤퓨터는�단순히�계산만�하는�기계인것으로�하여�계산기라고�하였다.�

…………………�

2.�콤퓨터의�기능�
콤퓨터가�현대과학과�기술의�최신성과로�사람들의�모든�일을�대신해주며�사람들로부터�환영받는

기계로�되는것은�그�기능이�매우�높기때문이다.�

…………………�

제2절.�하드웨어�
콤퓨터는�크기와�장비수준에�따라서�초대형,�대형,�소형,�망작업기용,�극소형으로�나눈다.��

우리가�지금�배우는�콤퓨터는�오늘날�많이�쓰고있는�극소형콤퓨터이다.�

…………………�

1.�중앙처리장치(CPU)�
중앙처리장치�CPU(Central�Processing�Unit)는�콤퓨터의�기본기능인�조종기능과�연산기능을

수행하는�장치로서�사람의�뇌수와�같은�아주�중요한�역할을�한다.�

2.�주기억기와�완충기억기�

1)�주기억기�

주기억기는�콤퓨터본체의�기본기판에�꽂혀있는�기억장치이다.�

…………………�
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①�차례내용을�선택한다.�

②�《서식》→《격식�및�서식》지령을�실행

하여�《격식�및�서식》대화칸을�펼친다.�

③�도구띠부분의�《단락격식》단추를�찰칵

하고�아래에�펼쳐지는�목록칸에서�《제목�1》을�

두번찰칵하여�격식을�적용한다.�

④�체계준위에�따라서�《제목�1》,�《제목

2》,�《제목�3》…격식을�차례내용들에�적용한다.�

실례로�장제목을�《제목�1》격식으로�설정하

려면�본문에서�장제목을�선택한�다음�《격식�및�

서식》대화칸에서�《제목�1》을�두번찰칵한다.��

같은�방법으로�절제목을�선택하고�목록칸에

서�《제목�2》를�두번찰칵한다.�

⑤�격식설정이�끝나면�해당한�장,�절,�소제목�

등을� 선택하고� 서식지정도구띠에서� 서체종류와�

서체크기�등을�자기의�의도에�맞게�설정해준다.�

- 차례표붙이기 

차례를�삽입하기�위해서는�다음과�같이�한다.�

①�차례를�삽입할�위치를�찰칵한다.�

②�《삽입》→《색인�및�차례》→《색인�및�차례》지령을�실행한다. 

그러면�《색인/차례�삽입》대화칸이�나타난다.�

�

③�《색인/차례》표쪽을�찰칵하고�《류형과�제목》부분에서�《제목》칸에�작성하려는�

차례의�제목(보통�표준이름그대로�《차례》로�한다.),�《류형》목록에�차례,�객체표,�표색
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인�…,�《평가단계》칸에�개수(실례로�장,�절,�소제목을�차례에�포함시키려면�3으로�한

다.)�등�해당한�설정을�진행한다.�

�

�

�

④�《추가적인�격식》을�선택하고�그옆의� 단추를�찰칵한다.�그러면�《격식할

당》대화칸이�나타난다.�

 

⑤�해당한�격식의�이름을�선택하고� 단추를�찰칵하여�해당한�준위로�옮긴다.�

준위를�잘못�설정하고�이동시켰다면�다시�해당한�격식이름을�선택하고� 단

추를�찰칵하여�이동할수�있다.�

⑥�설정이�끝나면�《확인》단추를�찰칵한다.�

⑦�《색인/차례�삽입》대화칸의�《확인》단추를�찰칵하면�유표위치에�다음과�같은�

차례가�자동적으로�붙여진다.�

�
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3) 그림번호와 그림차례붙이기 

- 그림번호붙이기 

문서안의�그림이나�표,�수식�등에�이름과�번호를�붙여�쉽게�갈라볼수�있게�할수�있다.�

그림이나�수식�등에�표제와�번호를�붙이는�방법은�다음과�같다.�

그림이나�수식을�선택하고�《삽입》차림표에서�《표제…》지령을�실행하거나�지름

차림표를�리용하여�《표제》대화칸을�열기한다.�

�

표제대화칸에서�해당한�설정을�진행하기�위하여�《표제》칸에�표시할�본문을�입력

한다.�실례로�객체의�표식자를�《그림1:�바른4각형》으로�지정하려면�표제칸에�《바른4

각형》을�입력한다.�

∙�범주�-�내리화살단추를�찰칵하여�표제범주를�선택하거나�새�범주를�입력한다.�

실례로�《삽화》로�입력하면�다음번에�선택한�객체도�자동적으로�《그림》표식자를�가

지게�된다.�

∙�번호매김�-�표제에서�사용할�번호매김형식을�선택한다.�

∙�구분기호�–�그림번호와�이름사이를�구분해준다.�

《확인》단추를�찰칵한다.�그러면�선택된�그림에는�《그림1:�바른4각형》의�표제가�

붙는다.�우와�같은�방법으로�다음�그림을�선택하고�표제붙이기를�하면�자동적으로�이름

과�번호가�계속하여�붙는것을�확인할수�있다.�

표,�수식,�본문도구를�리용하여�편집한�본문�등에도�표제를�설정할수�있으며�《표

제》대화칸의�《추가선택》단추를�찰칵하여�문서의�장번호와�제목에�따르는�표제를�설

정하여줄수�있다.��

�

�

�

�

�

탐 구 

《추가선택》대화칸에서�문서의�장번호와�제목에�따르는�표제를�설정하여

보아라.��
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- 그림차례붙이기 

차례표만들기와�같이�그림차례행의�격식작성과�

그림차례붙이기는�두단계로�진행한다.�

①�차례행의�격식작성�

《서식》→《격식�및�서식》지령을�실행한

다.(또는�F11건을�누른다.)�

그러면�《격식�및�서식》대화칸이�나타난다.�

대화칸의� 단락격식목록들에서� 해당한� 격식을�

선택한다.�

실례로�그림표제를�《제목�1》격식으로�설정하

려면�그림표제를�선택한�다음�대화칸의�《제목�1》

을�두번찰칵한다.�같은�방법으로�다음�그림표제를�

선택하고�목록칸에서�《제목�1》를�두번찰칵한다.�

격식설정이�끝나면�《격식�및�서식》대화칸의�

《닫기》단추를�찰칵하여�대화칸을�닫는다.�

②�그림차례붙이기�

차례를�삽입하기�위해서는�다음과�같이�한다.�

차례를�삽입할�위치를�찰칵한다.�

《삽입》→《색인�및�차례》→《색인�및�차례》지령을�실행하여�《색인/차례�삽입》

대화칸을�열기한다.�

《색인/차례》표쪽을�찰칵하고�《류형과�제목》부분에서�《제목》칸에�이름(작성하려

는�그림차례의�제목�실례로�《그림차례》로�한다.),�《류형》목록에서�해당한�형태(실례로�

삽화색인)를�선택�등�해당한�설정을�진행한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

대화칸의�《내용》부분에서�표제를�선택하고�《범주》칸에서�해당한�선택(실례로�그

림)을�한다.�

표시칸에서�차례표에�표시할�내용을�선택하고�《확인》단추를�찰칵한다.�
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4) 주해달기 및 찾아보기표와 책갈피만들기 

(1)�주해달기�

문서안에서�어떤�술어나�외래어단어들에�대한�설명까지�구체적으로�주자면�문서내용이�

길어지고�설명을�주지�않으면�사용자가�리해하기�어려운�단어들이�있다.�이때�문서의�일정

한�구역에�이런�단어들에�대한�설명을�주는것을�주해라고�한다.�

문서안에서�주해달기를�하자면�주해달기하려는�단어뒤에�유표를�옮기고�《삽입》차림

표의�《주해…》지령을�실행한다.�

�

�

�

�

�

�

유표위치에�고정점이�생기고�주해칸(페지의�오른쪽에�주해를�써넣을수�있는�구역)이�

선으로�련결되는데�이때�주해칸에�해당한�내용을�입력한다.�

만들어진�주해의�작성자이름과�생성날자는�주해칸의�아래부분에�표시된다.��

한문서안에서�저자가�다른�주해는�서로�다른�색으로�구별된다.��

저자이름은�《도구》차림표의�《추가선택》→《통합사무처리프로그람《우리》》→《사

용자자료》를�선택하여�표시되는�대화칸에서�이름을�입력하면�된다.�

�

주해칸에는�내리화살단추가�표시되여있는데�이것을�찰칵하여�

나타나는�《주해삭제》지령을�실행하여�주해를�삭제할수�있다.�

바닥주해달기는 다음과 같이 한다. 

바닥주해를�삽입할�위치를�선택하고�《삽입》차림표의�
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《바닥주해…》지령을�실행한다.�그러면�《바닥주해�삽입》대화칸이�나타난다.�

�
대화칸의�《번호매김》항목에서�자동을�선택하면�주해를�삽입하는�순서에�따라�자동적

으로�1,�2,�3,�…�번호가�붙여지며�문자를�선택하면�문자칸에�유표가�이동되여�해당한�문자

를�입력할수�있으며�《…》단추를�찰칵하여�《특수문자》대화칸을�열기하고�해당한�문자를�

입력할수�있다.�

�

《바닥주해�삽입》대화칸의�《류형》부분에서�《바닥주해》를�선택하면�페지의�아래에,�

《끝주해》를�선택하면�문서의�끝에�주해입력칸이�표시된다.�

해당한�선택을�진행하고�대화칸을�닫는다.�주해입력칸에�해당한�해설문을�입력한다.��

주해번호에�마우스지시자를�가져가면�지시자의�모양이�손모양으로�표시되고�화면에�주

해내용이�표시되며�마우스를�찰칵하면�해당한�주해입력칸으로�유표가�이동한다.�

�

�

(2)�찾아보기표(색인표)만들기�

일반적으로�도서의�맨�마지막에는�자모순으로�된�찾아보기표�혹은�색인표가�있다.�

여기에는�일반적으로�문서안에�있는�개념,�특수한�용어�등이�들어있다.�이러한�개념,�용

어�등을�항목으로�하여�찾아보기표를�만들면�아주�편리하다.�
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- 찾아보기항목의 등록 

찾아보기항목으로�하려는�문자렬을�선택하고�《삽입》차림표의�《색인�및�차례》→《항

목…�》지령을�실행하여�《색인항목삽입》대화칸을�열기한다.�

�

대화칸의�《색인》목록에서�내리화살단추를�찰칵하여�《자모순색인》을�선택한다.��

《항목》칸에는�이미�선택한�문자렬이�입력되여있는것을�확인할수�있다.��

《첫번째�건》부분에�첫번째�자모순을�입력한다.�

필요에�따라�두번째�자모순도�입력할수�있다.�

대화칸의�《삽입》단추를�찰칵한다.�이때�대화칸은�닫기지�않고�또�다른�찾아보기항목을�

등록할수�있게�여전히�표시된다.�

문서에서�찾아보기항목으로�등록하려는�다른�문자렬을�선택하고�《색인항목삽입》대화

칸의�《항목》칸을�찰칵하면�방금�선택한�새로운�문자렬이�표시된다.�이때�대화칸의�《삽

입》단추를�찰칵한다.�같은�방법으로�찾아보기항목으로�등록하려는�문자렬들을�련이어�선택

하여�등록한다.�등록이�끝나면�대화칸의�《닫기》단추를�찰칵한다.�

- 찾아보기표의 작성 

찾아보기표를�만들려는�위치에�유표를�옮기고�《삽입》차림표의�《색인�및�차례》→

《색인�및�차례…》지령을�실행하여�《색인/차례�삽입》대화칸을�열기한다.�

�
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대화칸의�《제목》칸에�《자모순색인》으로�입력하고�《류형》목록에서�《자모순색인》

을�선택한다.�기타�사용자의�의도에�맞게�여러가지�설정을�진행할수�있다.�

《렬》표쪽을�리용하여�2개의�렬로�편성한다.�

《확인》단추를�찰칵하면�대화칸이�닫기고�그림과�같은�찾아보기표가�작성된다.�

�

(3)�책갈피표식만들기�

만일�3절내용을�읽는�도중에�객체라는�용어가�나왔는데�그것을�구체적으로�다시�읽어보

려는�독자가�그�단어를�찰칵하여�2절에�있는�객체에�대한�내용이�나타나게�한다면�독자들에

게�매우�편리할것이다.�이와�같은�기능을�초련결�혹은�하이퍼련결(Hyperlink)기능이라고�하

며�이것을�만드는것을�책갈피만들기라고�한다.�

책갈피를�삽입하면�요구하는�위치로�빠르게�이동할수�있다.��

 

 

 

 

 

 

-�책갈피내용의 위치등록��

먼저�찾아가려는�내용전체를�선택하고�《삽입》차림표의�《책갈피…》지령을�실행하여�

《책갈피삽입》대화칸을�열기한다.�

�

이�대화칸에서�책갈피내용의�이름을�입력하고�《확인》단추를�찰칵하면�책갈피내용의�

위치가�등록된다.�이때�《책갈피》이름은�3글자이상이�되여야�한다.�

초련결이란 무엇인가? 

초련결이란�문서에서�다른�자원을�련결하는�기능이라고�말할수�있다.�

초련결을�리용하자면�초련결원천과�초련결목표를�지정해야�한다.�

여기서�초련결원천은�초련결을�현시하는�본문이며�초련결목표는�초련결원천과

련결되여있는�자원(문서,�파일,�책갈피�등)이다.�

알아두기 
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등록된�내용을�지우려면�이�대화칸의�책갈피이름목록에서�해당한�이름을�선택하고�《삭

제》단추를�찰칵하면�된다.�

- 책갈피표식만들기 

책갈피표식을�만들려는�범위(술어�또는�단어)를�선택하고�《삽입》차림표의�《초련결》

지령을�실행하여�《초련결》대화칸을�열기한다.�

�

이�대화칸의�왼쪽칸에서�문서를�선택하고�문서내부목표부분에서�문서내부대상그림기호

단추를�찰칵하여�《문서내부목표》대화칸을�열기한다.�책갈피+기호를�찰칵하여�해당한�책갈

피이름을�선택하고�《적용》단추를�찰칵한�다음�《닫기》단추를�찰칵한다.�

다시�《초련결》대화칸의�경로목록에서�내리화

살단추를�찰칵하여�현재�책갈피를�작성하는�문서의�

경로와�이름을�선택하고�《적용》단추를�찰칵하여�

대화칸을�닫기한다.�그러면�책갈피표식으로�선택하

였던�부분이�밑선이�그어진�푸른색으로�변하는데�

그우에�마우스지시자를�가져가면�《Ctrl건을�누른�

상태에서�초련결(Hyperlink)을�눌러서�엽니다.》

는�통보가�표시되며�Ctrl건을�누르면�마우스지시자

의�모양이�손가락모양으로�되며�이때�찰칵하면�해

당한�책갈피내용의�페지가�표시되면서�유표는�책갈

피내용의�첫머리로�옮겨간다.�

-�다른 문서와의 련결 

책갈피표식을�다른�문서와�련결시킬수�있는데�

이를� 위하여서는� 책갈피표식과� 내용을� 련결하는�

《초련결》대화칸에서�파일열기단추� 를�찰칵하

여�해당한�문서를�선택한다.��
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�

그러면�그�표식을�찰칵할�때�선택한�문서가�열린다.�

- 책갈피의 사용 

만들어진�책갈피에로�찾아가자면�《항행기》를�리용한다.�

①�차림표띠의�《편집》→《항행기》지령을�실행하거나�기능건�F5건을�누른다.�그러면�

《항행기》대화칸이�나타난다.�

�

②�도구띠의�내용보기단추� 를�찰칵하여�항목들을�구체적으로�표시한다.�
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③�항행기대화칸에서�《책갈피》항목옆의�더하기기호(+)를�찰칵하면�문서에�적용된�책

갈피이름들이�현시된다.��

④�책갈피이름을�두번찰칵하면�그�책갈피가�삽입된�위치로�유표가�이동하고�필요한�내

용이�화면에�현시된다.�

문서안에�있는�책갈피에서�다음(혹은�앞)의�책갈피로�넘어가자면�《항행》도구띠에서�

책갈피그림기호� 를�선택한�다음�이전책갈피그림기호� 나�다음책갈피그림기호� 를�

찰칵한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

5) 문서의 인쇄 

문서를�인쇄하기�전에�먼저�인쇄할�종이의�크기,�여백,�행간격,�전체의�균형�등을�확인

하여야�하며�필요하면�그�설정을�바꾸어주어야�한다.��

페지설정은�《서식》차림표의�《페지…》지령을�실행하여�한다.�

페지설정이�끝나면�《파일》차림표의�《페지미리보기》지령을�리용하여�인쇄될�문서의�

크기와�형태,�여백의�균형�등을�다시�확인할수�있다.�

-�인쇄방법 

편집한�문서를�인쇄하기�위하여서는�먼저�콤퓨터본체에�인쇄기케블을�련결하고�인쇄기

전원을�넣은�다음�인쇄기에�이상이�없는가를�확인한다.�

다음�《파일》차림표에서�《인쇄지령》을�실행시키면�《인쇄》대화칸이�표시된다.(또는�

Ctrl+P건을�누르거나�도구띠의�《인쇄》그림기호를�찰칵한다.)�

《항행》도구띠 

항행도구띠는�화면우에서�자유롭게�이동할수�있는�류동도구띠이다.�

항행도구띠에서�뛰여넘으려는�객체의�류형을�선택한�다음�2중화살단추를��찰칵

하면�지정한�류형의�객체사이를�문서안에서�간단히�뛰여넘을수�있다.�

�

�

�

�

실례로�문서안에�있는�그림에서�다음(혹은�앞)의�그림으로�넘어가자면�항행도

구띠에서�도형그림기호� 를�선택한�다음�항행기의�이전도형그림기호� 나�다음�

도형그림기호� 를�찰칵한다.�

표,�제목,�문절,�주해�등도�같은�조작으로�뛰여넘을수�있다.

알아두기 
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�

이�대화칸에서�대표적인�선택칸들의�기능은�다음과�같다.�

∙�《인쇄기》부분에서�《이름》칸에는�현재�콤퓨터에�설치된�인쇄기이름목록이�표시된

다.�여기서�해당한�인쇄기종류를�선택한다.�

∙�《인쇄범위》부분에서�인쇄범위를�지정한다.��

《모든�페지》를�선택하면�문서의�모든�페지가�인쇄된다.��

《페지》를�선택하면�지정한�페지만을�인쇄한다.�실례로�5페지를�인쇄하려면�《5》라고�

쓰고�5페지부터�인쇄하려면《5-》라고�입력한다.�만일�5페지까지�인쇄하려면�《-5》라고�쓴다.��

《12-36》이라고�쓰면�12페지부터�36페지까지�인쇄한다.�《3,�45,�78》이라고�쓰면�3,�

45,�78페지만�인쇄된다.�

문서에서�선택한�부분이나�객체만을�인쇄하기�위하여서는�《선택》을�찰칵한다.�

∙�《복사》부분에서�인쇄부수를�지정한다.�이때�문서단위로�지적한�부수만큼�인쇄하려

면�《순서맞추기》칸을�선택하고�페지단위로�지적한�부수만큼�인쇄하려면�선택표식을�없애

면�된다.�《속성》단추를�찰칵하면�인쇄속성설정대화칸이�표시된다.�이�대화칸은�인쇄기에�

따라�서로�약간씩�차이날수�있으나�인쇄용지,�인쇄방향,�인쇄질과�관련한�색방식�등을�설정

할수�있다.�속성설정이�끝나면�《확인》단추를�찰칵하여�다시�인쇄대화칸으로�돌아온다.�

 

�

�

�

�

�

�

�

�
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인쇄설정이�끝나면�《확인》단추를�찰칵하여�인쇄를�한다.�

- 문서의 흑백인쇄 

색으로�지정한�본문도�흑백색으로�인쇄할수�있다.��

①�《인쇄》대화칸을�펼친다.�

②�《추가선택》단추를�찰칵하여�《인쇄기추가선택》대화칸을�펼친다.�

�

�

�

�

�

�

�

�

�

�

�

�

③�《내용》부분에�있는�《흑백인쇄》검사칸을�선택하고�《확인》단추를�찰칵한�다음�

인쇄하면�된다.�

- 자료의 축소인쇄�

자료를�축소하여�인쇄할수도�있다.�이렇게�하면�인쇄시간을�단축할수�있다.�

①�《도구》→《추가선택》→《통합사무처리프로그람�《우리》》→《인쇄》를�실행한다.�

�

�

�

�

�

�

�

�

�

�

�

�
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②�투명객체를�일반불투명객체처럼�인쇄하기�위하여�《투명도�축소》검사칸을�선택한다.�

③�인쇄화질을�설정하기�위하여�《비트도�축소》검사칸을�선택한다.�

④�설정이�끝나면�《확인》단추를�찰칵한다.�

 

련습문제 

 

1.�콤퓨터교과서의�장,�절제목들을�교과서페지번호와�같은�페지들에�편집하고�문서에�페지번

호를�삽입하며�문서의�제일�앞페지에�차례표를�작성하여라.�

2.�수학교과서에�있는�수학식들을�편집하고�해당한�그림들을�그리기도구를�리용하여�문서에�

그려넣은�다음�그림번호를�붙여라.�

3.�3페지로�된�물리용어해설집을�만들고�해당한�위치에�주해,�찾아보기표,�책갈피표식을�삽

입해넣어라.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

《≤

문서변환기능 

문서편집프로그람�《글》에서�작성한�문서를�PDF문서로�변환할수�있다.��

①�차림표띠에서�《파일》→《PDF로�반출》지령을�실행하면�《반출》대화칸이

현시된다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

②�《파일이름》칸에�반출하려는�파일이름을�입력하고�《반출》단추를�찰칵한

다.�이때�《PDF반출》대화칸이�현시된다.��

알아두기 
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�

③�여기서�필요한�설정을�진행하고�《반출》단추를�찰칵하면�PDF문서로�변환

된다.�

우리�글/한자�변환기능은�문서편집프로그람�《글》에�새롭게�반영된�기능들중

의�하나이다.�선택한�우리�글�본문에�대해�우리�글을�한자로,�한자를�우리�글로�변

환하면서�그�변환위치까지도�설정해주는�강력한�기능이다.��

①�차림표띠에서�《도구》→《언어》→《우리�글/한자변환》지령을�실행하면

아래와�같은�대화칸이�현시된다.��
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콤퓨터상식 

 
 

프로그람작성자나 보고서와 같은 문서를 작성하는 사람들은 아침에 일어나면서 

켜놓은 콤퓨터를 퇴근하거나 잠자리에 들기 전에 보통 끄지 않는 습관이 있다.  

이것은 콤퓨터의 록색기능이라고 하는 전원차단방식(콤퓨터작업을 끝낸 후 일정

한 시간이 지나면 자동적으로 콤퓨터의 전류를 최소로 하는 방식)이 있기때문이며 빈

번한 시동으로 콤퓨터의 수명이 단축되는것을 방지할수 있기때문이다. 그러나 아직

많은 사람들은 콤퓨터를 사용할 때만 켜놓고 아주 작은 시간동안이라도 자리를 비우

게 되면 일단 전원을 꺼놓고 자리를 뜨는 경우가 많다. 이런 대조적인 두가지 사용자

의 습관들이 각각 어떤 우점이 있는가를 살펴보자. 

첫번째 경우는 콤퓨터의 수명에 도움이 되는 방식이라고 할수 있다. 즉 매번 기

동시킬 때마다 콤퓨터에 가해지는 전기적충격으로부터 벗어날수 있는 가장 효과적인 

방법이라고 할수 있다.  

두번째 경우는 소비되는 전기량을 줄여줌과 동시에 콤퓨터를 오랜 작업으로부터

휴식하게 해준다는 우점이 있다.  

콤퓨터도 다른 기계와 마찬가지로 오랜 시간 작업을 계속한다면 무리가 생길수

밖에 없다.  

따라서 콤퓨터를 사용하지 않을 때 전원을 끈다고 하여 수명이 단축되는것은 아

니며 작업시간과 자리를 비우는 시간을 고려하여 융통성있게 관리해주어야 한다. 즉

작업중에 잠시 자리를 비우게 된다면 콤퓨터를 켜놓고 빈번한 전기적인 충격을 가하

지 않는것이 좋으며 공백시간이 길것으로 예상된다면 콤퓨터를 꺼서 휴식할수 있게

하여주는것이 좋다. 

②�《치환》단추를�찰칵하면�《백》자가�《白》자로�변환되고�다음�글자로�이

행한다.��

③�《추천단어》목록칸에서�해당한�글자에�맞는�한자를�찾아�선택한�다음�《치

환》단추로�치환한다.��

한자로�변환된�문자도�우와�같은�방법으로�우리�글로�변환할수�있다.��
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제3장. 《표》를 리용한 자료관리 

제1절. 순위계산 

1. 《표》의 기본기능 

우리는�이미�《표》에서�주어진�자료들을�가지고�총점과�평점을�구하고�자료의�형식화

를�진행하는데�대하여�학습하였다.��

《표》에서는�계산뿐아니라�도표도�작성하고�자료의�검색�및�추출도�할수�있으며�반복

되는�자료도�간단히�처리할수�있다.�

통합사무처리프로그람�《우리》의�표계산프로그람�《표》는�계렬적이며�목록화된�자

료들을�쉽게�표로�작성하고�각이한�계산과�검색,�수정�등의�자료처리를�할수�있는�우수한�

기능들을�가지고있다.�

《표》의�기능은�크게�표계산기능,�도표작성기능,�자료관리기능으로�갈라볼수�있다.�

�

�

�

�

�

�

�

①�표계산기능�

표안에�입력한�자료에�기초하여�각이한�계산을�진행할수�있다.�

②�도표작성기능�

자료와�통계결과에�기초하여�도표를�작성할수�있다.�

자료와�도표가�련결되여있기때문에�쉽게�수정,�변경할수�있으며�각이한�형태의�도표형

태를�선택하여�제시할수�있다.�

③�자료관리기능�

표안의�자료에�대한�각이한�형태의�처리�즉�정렬,�추출,�통계를�할수�있다.�

2. 함수의 기능 

《표》에는�총점과�평점계산뿐아니라�수학,�날자�및�시간,�통계,�본문�등의�처리를�진

행할수�있는�함수들이�준비되여있다.�

함수란�수학에서의�어떤�공식처럼�주어진�자료들을�가지고�결과를�얻기�위한�식으로�

리해하면�된다.�

《표》에는�자료들을�가지고�많은�연산과�처리를�할수�있는�많은�함수들이�준비되여있

다.�대표적인�몇가지�함수들을�보면�다음과�같다. 
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함수의�리용은�함수조수를�통하여�한다.�

함수조수는�함수를�대화칸으로�만들어�리용할수�있게�해주는�도구이다.�

함수조수의�리용방법은�다음과�같다.�

먼저�함수조수를�리용하기�전에�수식이�삽입되는�세포범위를�선택한다.�

다음�《삽입》차림표띠의�함수를�선택하거나�Ctrl+Shift+9건을�누르든가�혹은�수식편

집도구띠의�함수그림기호� 을�선택한다.�이때�《함수�조수》대화칸이�펼쳐진다.�

 

그림에서�보는바와�같이�《함수�조수》대화칸에는�《함수》표쪽과�《구조》표쪽이

있는데�《함수》는�수식을�만드는데�사용되며�《구조》는�작성한�수식을�검사하는데�

리용된다.�《함수》표쪽의�《범주》목록에는�13개의�범주목록이�있으며�《함수》목록에는

이�범주목록에서�선택한�범주에�대한�함수목록이�표시된다.��

《다음》단추를�찰칵하면�이�대화칸이�다음과�같이�변하는데�오른쪽에는�선택한�함수

들의�인수들인�《값》,�《자료》,�《류형》을�주기�위한�입력칸과�수식입력칸이�나타난다.�

№� 함수이름� 함수의�기능�

1� SUM� 인수들의�합을�구한다.�

2� AVERAGE� 주어진�인수들의�평균값을�구한다.�

3� RANK� 주어진�수들의�순위를�구한다.�

4� COUNTIF� 조건에�맞는�인수들의�개수를�구한다.�

5� MAX� 주어진�수들가운데서�가장�큰�값을�구한다.�
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3. 함수조수를 리용하여 순위구하기 

여기서는�이미�작성한�《성적표》에�대하여�순위와�최우등생수를�구해보기로�한다.�

①�우선�첫�학생의�《순위》세포를�선택하고�《함수�조수》대화칸을�펼치고�순위를�구

하는�함수�RANK를�선택한다.�이때�《함수�조수》대화칸의�오른쪽에는�RANK함수의�형

식이�나타난다.�함수의�형식은�다음과�같다.�

RANK(값�;�자료�;�류형)�

②�《다음》단추를�찰칵하면�《함수�조수》대화칸의�오른쪽에는�RANK함수의�인수들

인�《값》,�《자료》,�《류형》을�주기�위한�입력칸과�수식입력칸이�나타난다.�

이�대화칸은�《함수�조수》대화칸을�펼치고�순위를�구하는�함수�RANK를�두번찰칵하

여도�나타난다.�

    

  
소년반성적표 

  

번�호� 이�름� 혁명력사� 수�학� 콤퓨터 외국어 총�점 평�점 순�위� 최우등생수

1� 김영철� 5� 4� 5� 5� 19� 4.75 � �

2� 김순희� 5� 3� 4� 5� 17� 4.25 � �

3� 리복남� 5� 5� 5� 5� 20� 5� � �

4� 박성길� 5� 5� 3� 5� 18� 4.5 � �

5� 한명옥� 5� 5� 4� 3� 17� 4.25 � �
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�

대화칸에서�《값》입력칸에는�첫�학생의�평점세포주소를�입력하고�《자료》입력칸에는

모든�학생들의�평점세포범위를�절대주소로�입력한다.��

절대주소는�세포가�어떤�계산에�참고될�때�상대적으로�주소값이�변하지�않는�주소를�

말한다.(자료범위선택단추�� 를�찰칵하여�해당�범위를�지정해줄수�있다.)�

《류형》입력칸에는�0�혹은�1을�값으로�줄수�있는데�0을�주면�마지막값으로부터�처음

값으로�정렬하는�내림순서이고�1을�주면�처음값으로부터�마지막값으로�정렬하는�오름순서

이다.�만일�《류형》입력칸에�아무것도�입력하지�않으면�1을�준것과�같은�효과를�가진다.�

③�다음�《확인》단추를�찰칵하면�첫�학생의�순위가�표시된다.�

첫�학생의�순위를�기준으로�하여�련속으로�채우기기능으로�모든�학생들의�순위를�단번

에�계산하여�표시한다.�

    

  
소년반성적표 

  

번�호� 이�름� 혁명력사� 수�학� 콤퓨터 외국어 총�점 평�점 순�위� 최우등생수

1� 김영철� 5� 4� 5� 5� 19� 4.75 2� �

2� 김순희� 5� 3� 4� 5� 17� 4.25 4� �

3� 리복남� 5� 5� 5� 5� 20� 5� 1� �

4� 박성길� 5� 5� 3� 5� 18� 4.5 3� �

5� 한명옥� 5� 5� 4� 3� 17� 4.25 4� �
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성적표에서 최우등생수를 구하여보자. 

①�최우등생수를�표시할�세포를�선택하고�《함수�조수》대화칸을�펼치고�조건에�맞는�

인수의�개수를�구하는�함수�COUNTIF를�두번찰칵한다.�

②�대화칸에서�《범위》입력칸에서�평점�혹은�총점세포범위를�지정하고�《기준》입력

칸에는�5라는�수값을�입력한다.�

 

《표》에서�세포에�소수점을�입력할�때에는�수자형식:소수부추가그림기호�

를 선택하여야�한다.�수자형식:소수부추가그림기호를�리용하지�않으면�옹근수로�삽

입된다.�수자형식:소수부삭제그림기호� 를�찰칵할�때마다�소수부자리는�한자리

씩�삭제된다.�

세포에�분수를�입력하는�방법은�다음과�같다.�

①�분수를�입력하려는�세포를�선택한다.�

②�《서식》→《세포》지령을�실행하거나�오른쪽찰칵하여�나타나는�지름차

림표에서《세포》지령을�실행한다.�이때�나타나는�《세포서식지정》대화칸에서

《수자》표쪽을�찰칵한다.�

 

③�《범주》목록에서�《분수》를,�《서식》목록에서�해당한�형태를�선택

한다.�

④�해당�설정을�진행하고�《확인》단추를�찰칵한다.�

알아두기 
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다음�《확인》단추를�찰칵하면�최우등생수가�표시된다.�

    

  
소년반성적표 

  

번호� 이름� 혁명력사� 수학� 콤퓨터 외국어 총점 평점 순위� 최우등생수

1� 김영철� 5� 4� 5� 5� 19� 4.75 2� 3�

2� 김순희� 5� 3� 4� 5� 17� 4.25 4� �

3� 리복남� 5� 5� 5� 5� 20� 5� 1� �

4� 박성길� 5� 5� 3� 5� 18� 4.5 3� �

5� 한명옥� 5� 5� 4� 3� 17� 4.25 4� �

몇가지 보충적인 함수들 

№� 함수이름� 함수의�기능�

1� ABS� 수자들의�절대값을�구한다.�

2� COUNTA� 인수목록에�있는�값들의�개수를�구한다.�

3� COUNTBLANK� 지정한�범위에서�빈�세포의�개수를�구한다.�

4� INT� 가장�가까운�수로�반내림한다.�

5� LEN� 본문문자렬의�길이를�구한다.�

6� MAXA� 인수목록에서�최대값을�구한다.(본문은�0으로�한다.)�

7� SIGN� 수자의�부호를�구한다.�

8� SUMIF� 조건에�맞는�인수들의�총합을�구한다.�

9� UPPER� 본문을�대문자로�변환한다.�

10� VALUE� 본문을�수자로�변환한다.�
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련습문제 

1.�성적표에서�총점에�관하여�순위를�계산하여라.�

2.�성적표에서�평점에�관하여�순위를�계산하여라.�

3.�최우등생수,�우등생수를�각각�구하여라.�

4.�평점이�4.5이상인�학생수를�구하여라.�

5.�최우등생평점,�우등생평점을�구하여라.�

6.�성적이�가장�높은�학생과�가장�낮은�학생의�성적을�구하여라.�

�

 

 

제2절. 경쟁도표만들기 

표자료는�도표형식으로�만들어�표시하면�보기도�좋고�리용하기도�편리하다.��

《표》에서는�주어진�자료를�간단히�도표로�작성함으로써�직관적으로�보여줄수�있다.�

1. 도표만들기 

도표를�작성하려면�우선�자료가�행과�렬의�형식으로�정리된�자료여야�한다.�

1절에서�리용한�실례문제에�대한�경쟁도표만드는�방법에�대하여�보기로�하자.�

우선�작업표에서�도표를�표시할�위치를�선택하고�도구띠의�《도표》그림기호를�찰칵한

다.�그러면�《도표조수》대화칸이�나타난다.�

 

①�대화칸의�첫�단계에서�표시할�도표류형을�선택한다.�

실례자료에서는�렬도표류형을�지정한다.�《다음》단추를�찰칵한다.�
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②�대화칸의�다음단계에서�자료범위를�선택한다.�

자료표의�이름항목부터�외국어항목까지�끌기로�지정한다.��

 

자료범위선택은�《자료범위》입력칸의�오른쪽에�있는�《자료범위선택》그림기호를�찰

칵하고�이때�나타나는�입력칸에�자료범위를�입력하거나�표에서�직접�그�범위를�선택하는�

방법으로�진행한다.��

《다음》단추를�찰칵한다.�

③�대화칸의�다음단계에서�련속자료형식을�설정한다.��

기정으로�설정된�방식으로�지정한다.�

 

《다음》단추를�찰칵한다.�

④�대화칸에서�도표제목,�X축제목,�Y축제목을�입력한다.�

《제목》칸에는�《소년반성적표》,�X축칸에는�《이름》,�Y축칸에는�《성적》이라고�

각각�입력한다.�
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《끝내기》단추를�찰칵한다.��

그러면�대화칸이�사라지고�도표가�용지에�삽입된다.�

�
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《 

도표의 류형 

 

축도표�

 
원형도표�

 
령역도표�

 
선도표�

 
(XY)분산형도표�

 
망도표�

 
주가도표�

 
렬과�선도표�

알아두기 
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2. 도표구성요소의 서식화 

도표의�구성요소들도�자유롭게�변경할수�있다.�

그러자면�도표에서�변경할�대상을�두번찰칵하거나�도표를�선택한�다음�《서식》차림표

에서�변경할�항목을�선택한다.��

- 도표제목의 서식화 

도표의�제목을�변경하기�위해서는�다음과�같이�한다.�

①�제목을�변경할�도표를�두번찰칵한다.�그러면�도표의�테두리가�회색으로�변하고�도

표의�객체를�편집하기�위한�그림기호들이�표시된다.�

②�기본제목으로�되는�본문을�두번찰칵한다.�이때�본문의�테두리가�사선의�회색테두리

로�변하면�변경을�할수�있다는것을�의미한다.�

③�기본제목의�내용은�《서식》→《제목》→《기본제목》지령을�실행하여�펼쳐지는�대

화칸에서�변경할수�있다.�또한�기본제목의�서식편집은�《서식》→《객체속성》지령을�실행

하고�이때�펼쳐지는�대화칸에서도�진행할수�있다.�

�

④�《문자》표쪽을�찰칵하여�서체속성을�설정한다.�

⑤�《확인》단추를�찰칵한다.�도표의�편집방식에서�탈퇴하려면�도표의�바깥구역에서�

찰칵한다.�

-�주의환기표식의 서식화 

도표의�주의환기표식바탕에�색갈을�줄수도�있다.�
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①�도표를�두번찰칵한다.��

②�《서식》→《주의환기표식》지령을�실행한다.�그러면�《일반실례》대화칸이�나타난다.�

�

③�주의환기표식의�배경을�변경하려는�경우에는�《령역》표쪽을�찰칵한다.�《채우�

기》칸에서�《색갈》�혹은�《경사도》를�선택하고�여기서�해당한�설정을�진행한다.�

④�《확인》단추를�찰칵한다.�

그러면�다음과�같이�나타난다.�

�

�

�

�

�

�

�

�

�

�

�

주의환기표식을�선택하려면�먼저�도표를�두번찰칵하고�그다음�주의환기표식을�찰칵

한다.�

주의환기표식은�끌기로�이동할수�있다.�
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주의환기표식을�도표의�다른�객체우에�놓으면�두번찰칵하여�속성대화칸�즉�주의환

기표식의�서식화를�주기�위한�《주의환기표식》대화칸을�열수�없다.�이때�속성대화칸을

열려면�《서식》→《주의환기표식》지령을�실행하거나�주의환기표식을�선택한�다음�오

른쪽찰칵하여�나타나는�지름차림표에서�《객체속성》지령을�실행한다.�이것은�도표의�

다른�객체에�대해서도�같다.�

- 도표축의 서식화 

도표의�Y축에�대한�변경은�다음과�같이�진행한다.�

①�도표를�두번찰칵한다.�

②�《서식》→《축》→《Y축》지령을�실행하거나�Y축을�두번찰칵하여�《Y축》대화칸을�

펼친다.�여기서�Y축에�대한�서식을�변경할수�있다.�

�

③�《삽입》→《제목》지령을�실행하여�나타나는�《제목》대화칸에서�제목과�보조제목,�

축들의�이름을�변경할수�있다.�

④�이름을�변경한�다음�《확인》단추를�찰칵한다.�그러면�Y축의�제목이�변경된것을�볼

수�있다.�

�

�
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3. 도표에 자료의 추가와 삭제 

1) 자료삭제 

도표에서�어떤�자료�실례로�《콤퓨터》과목성적자료를�없애려면�다음과�같이�한다.��

①�도표를�두번찰칵한다.�

②�삭제하려는�자료계렬을�선택하고�Delete건을�누른다.�또는�《서식》→《자료범

위》지령을�실행하여�나타나는�《자료범위》대화칸에서�《련속자료》표쪽을�찰칵한다.�

�

③�《련속자료》에서�《콤퓨터》를�선택한�다음�《제거》단추를�찰칵하고�《자료범

위》대화칸의�《확인》단추를�찰칵한다.�그러면�선택한�자료가�없어진다.�

2) 자료의 추가 

우의�도표에서�삭제하였던�《콤퓨터》과목성적자료를�다시�추가하려면�다음과�같

이�한다.�

①�도표를�두번찰칵한다.�

②�《자료범위》대화칸에서�《련속자료》표쪽을�찰칵한다.�

③�《추가》단추를�찰칵한다.�그러면�《련속자료》에�《이름없는�계렬》이�나타난다.�

④�《자료범위》에서�《이름》을�선택하고�《이름�범위》의�오른쪽옆에�있는�자료선택

그림기호를�찰칵한�다음�표에서�《콤퓨터》가�입력된�세포를�선택한다.�

⑤�《자료범위》에서�《Y-값》을�선택하고�《Y-값범위》의�자료선택그림기호를�찰칵

한�다음�표에서�《콤퓨터》성적이�입력된�세포령역을�선택한다.�

그러면�《콤퓨터》과목계렬이�도표에�추가된다.�
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도표안에서�하나의�자료계렬을�앞�또는�뒤로�이동시킬수�있다.��

자료계렬의�정렬순서를�변화시키려면�자료계렬의�지름차림표에서�《배치》지령이나�

《서식》차림표의�《배치》지령을�사용한다.�

련습문제 

1.�6명의�소년반성원들에�대한�수학,�물리,�외국어성적자료를�가지고�렬도표를�작성하

여라.�

2.�총점에�관하여�원도표를�작성하여라.�

3.�도표제목을�변경하여라.�

4.�경쟁도표에�국어,�콤퓨터성적자료를�추가하여라.�

5.�1번문제에�대한�자료를�가지고�꺽인선도표를�작성하여라.�

6.�1번문제자료에�2명학생자료를�더�추가하여�도표를�작성하여라.�

7.�이미�작성된�도표에서�일부�자료를�없애고�도표를�바꾸어보아라.�

 

 

 

 

 

 

 

 

�

�

제3절. 간단한 자료관리 

1. 자료의 정렬 

다음과�같은�학급명단에서�자료를�정렬하는�방법을�보기로�하자.�

�

탐 구 

작성된�표와�도표를�복사하여�문서편집프로그람�《글》에�가져다붙이여라.�

수학과�물리성적에�관한�원도표를�작성할수�있는가를�생각해보고�실행해보

아라.�
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이름이�자모순서로�되도록�정렬하는�방법을�보기로�한다.�

먼저�표자료전체를�끌기로�선택한다.�

다음�차림표의�《자료》→《정렬》지령을�실행하여�《정렬》대화칸을�펼친다.�

 

대화칸에서�《첫째�기준》목록칸을�내리펼치면�선택된�표자료의�항목들이�등록되여있

다.�목록에서�《이름》항목을�선택하고�정렬방향을�《오름순서》로�설정한다.�

《확인》단추를�찰칵하면�자료가�이름자모순서로�정렬되여�표시된다.�

 

자료를�성적순위,�3학년성적이�높은�순위로�정렬하는�방법을�보기로�한다.�

우와�같은�방법으로�표자료전체를�선택한�다음�《정렬》대화칸을�펼친다.�

대화칸에서�첫째�기준을�《순위》로,�둘째�기준은�《3학년성적》으로�설정한다.�
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첫째�기준에�대하여서는�정렬방향을�《오름순서》로�정하고�둘째�기준에�대하여서는�

정렬방향을�《내림순서》로�정한다.�

 

《확인》단추를�찰칵하면�자료가�요구에�따라�정렬한다.�

 

2. 자료의 추출 

자료를�추출하는�기능은�어떤�조건에�맞는�자료들만을�표시하는�기능을�말한다.�

《표》에서는�지정된�범위의�자료에�대하여�임의의�값을�조건으로�선택하여�추출할수�

있다.�

자료를�추출하는�기능에는�자동려과의�방법과�함께�표준려과의�방법이�있다.�일반적으

로�자동려과의�방법을�많이�리용하기때문에�그�방법을�보자.�

자료의�모든�항목들에�값목록을�표시하여�조건으로�될�값을�직접�선택함으로써�해당한�
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자료들을�추출하는�기능이다.�

자동려과기능을�실현하자면�우선�자료범위를�선택하고�차림표띠의�《자료》→《려과

기》→《자동려과기》지령을�실행한다.�

자료려과의�과정을�실례를�들어보기로�하자.�

앞의�표자료에서�남학생이면서�집주소가�보통강구역이며�3학년성적이�5점인�학생들을�

추출하여보자.�

①�우선�표자료를�선택한다.�

 

②�다음�차림표띠의�《자료》→《려과기》→《자동려과기》지령을�실행하여�표자료에�

려과기능을�추가한다.�

 
③�문제의�조건에�있는것처럼�집주소항목에서�보통강구역을�선택하고�성별항목에서�남

자를�선택하고�3학년성적에서�5를�선택하면�결과자료가�현시된다.�
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3. 간단한 통계처리 

표에서는�자료를�묶음화하여�부분합을�얻는�방법으로�간단한�통계처리를�할수�있다.�

내용이�같은�항목만을�묶어서�합이나�평균�등을�얻는�방법을�보기로�하자.�

 

12-2월 꼬마계획표 

날자� 유휴자재명� 수량(kg)� 금액(원)� 이름�

12월� 파철� 6� 60� 김순희�

12월� 파철� 3� 45� 김영철�

12월� 파철� 2� 40� 리복남�

12월� 파철� 5� 50� 박성길�

1월� 파유리� 5� 75� 리복남�

1월� 파유리� 2� 20� 박성길�

1월� 파유리� 13� 130� 김순희�

1월� 파유리� 7� 105� 김영철�

2월� 파지� 4� 80� 김영철�

2월� 파지� 5� 50� 김순희�

2월� 파지� 7� 105� 박성길�

2월� 파지� 7� 135� 리복남�

①�자료범위를�선택한다.�

②�《자료》→《부분합》지령을�실행한다.�

③�이때�나타나는�《부분합》대화칸에서�묶음기준을�설정한다.�실례로�그림과�같이�

《이름》을�선택한다.�
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�
④�《부분합을�계산하는�렬》에서�해당�항목(날자,�유휴자재명,�수량,�금액)을�선택한다.�

⑤�《함수사용》에서는�어떤�함수들을�사용하겠는가(실례로�합계)를�선택한다.�

⑥�《확인》단추를�찰칵한다.�그러면�이름을�기준으로�묶음화되고�묶음별로�수량과�금

액의�합계가�계산되여�현시된다.�

�

12-2



�

�102�

그림에서�보는바와�같이�행번호의�왼쪽에는�조작단추가�나타난다.�거기에는�어느 행이�

같은�묶음으로�묶어져있는가가�표시된다.��

그림의�왼쪽부분에�있는�덜기기호단추�� 를�찰칵하면�묶음안의�매�항목이�가리워�

지고�부분합만이�표시된다.��

또한�제일�왼쪽우에�있는������������단추를�찰칵하면�묶음표시를�간단히�변경할수�있

다.�례를�들어�1을�찰칵하면�전체합계만이,�2를�찰칵하면�전체합계와�부분합계,�3을�찰칵

하면�모든�행이�표시된다.�

�

련습문제 

1. 《학급명단》을�임의의�이름순서로�작성하고�자모순서로�정돈하여라.�

2. 《학급명단》에서�집주소가�모란봉구역인�학생들을�추출하여라.�

3. 《성적표》에서�총점순서대로�자료를�정렬하여라.�

4.  총점이�높으면서�수학성적이�높은�순서대로�정렬하여라.�

5.  남자이면서�5점생인�학생들을�추출하여라.�

6.  추출된�자료를�보관할수�있는가를�생각해보고�실행시켜보아라.�

7.  집주소가�서성구역이면서�평점이�최우등인�학생들을�추출하여라.�

8.�학급명단에서�이름을�자모순서로�정돈하면서�성적이�높은�순위로�정렬하여라.�

9.� 조건부함수를� 리용하여� 개수를� 구하는� 방법을� 말하고� 최우등생수,� 우등생수를�

구하여라.�

10.�성적표에서�콤퓨터가�우등이상인�학생들의�평점을�구하여라.�

11.�경쟁도표만들기에서�자료를�바꾸면서�도표를�만들어보아라.�

12.�분조별�꼬마계획수행정형을�원도표로�작성하여라.�

�

�

�

�

�

�

1���2���3�

탐 구 
학급학생들의�월별성적이�서로�다른�용지에�기록되여있다.�이것을�종합하여�

학기간�총점과�평점을�구하고�순위를�결정하여라.�



�

� 103

�

�

콤퓨터상식�

                     

현대의�거의�모든�콤퓨터들에는�음성기판,�음성합성�및�음성인식체계가�설치

되여있다.�이것은�곧�콤퓨터에�《인공입》과�《인공귀》를�설치한것과�같은것으로

서�콤퓨터가�말하고�들을수�있게�한다.�

콤퓨터가�말할수�있게�된것은�콤퓨터음성합성에�대한�연구성과의�결과이다.�

실례로�어떤�다매체작품들에서는�인위적인�록음해설방법이�아니라�콤퓨터음성

합성기술을�리용하고있다.�즉�전통적인�록음해설방법에�의해서가�아니라�문자인식

기술과�음성합성체계에�의해서�자동해설이�진행되고있다.�

콤퓨터음성합성체계는�콤퓨터와�함께�전용으로�설계된�장치를�리용하여�사람

들이�충분히�알아들을수�있는�소리를�재현한다.�

록음편집방식은�보통�리용하는�음성합성방법의�하나이다.��

이�방식을�보면�우선�합성에�필요한�모든�음성정보를�록음하여놓고�음성상사

신호를�수자신호로�변환한�다음�일정한�편집방식에�따라�파일로�만들어�디스크와

같은�기억기에�보존한다.��

필요할�때�콤퓨터는�직접�기억기로부터�해당한�음성정보를�읽어내여�수자신호

형태를�상사식음성신호형태로�변환한�다음�음성기판,�음향설비,�고성기�등과�같은

장치들에�내보내며�재현쏘프트웨어를�통하여�출력한다.��

이렇게�하여�콤퓨터는�《말》하며�사람들은�그�음성을�듣게�된다.�

콤퓨터음성합성과�콤퓨터음성인식은�콤퓨터음성처리분야에서의�중요한�두�기

둥인�동시에�이것들은�서로�보충해준다.�

콤퓨터음성인식과�함께�콤퓨터음성합성에�대한�연구에서는�이미�비교적�많은

성과가�이룩되였다.��

일상생활에서�우리들이�리용하는�웃기도�하고�울기도�하는�갓난애기발성인형,�

세탁기를�비롯한�가정용전기기구들에서의�정시발음체계,�미묘한�음악을�내는�8음

통,�전자악기류�등은�다�음성합성기술을�리용하여�만든것들이다.��
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제4장. 자료기지의 활용 

자료기지란�무엇이며�자료기지를�구축하는�방법에�대하여서는�이미�학습하였다.�

자료기지를�만드는�방법을�아는것도�중요하지만�자료기지를�자유롭게�여러�측면에서�

리용하는�수법을�체득하는것도�중요하다.�

《자료기지》프로그람에는�자료기지를�여러�측면에서�편리하게�리용할수�있는�양식

(form),�질문(query),�보고서(report)와�같은�객체들이�제공된다.�

�

�

�

�

�

�

�

�

�

�

�

�

제1절. 양식만들기와 리용 

�

�

�

�

양식은�사용자의�요구에�맞게�대화화면을�설계하는�객체이다.��

양식은�자료를�쉽게�찾아보고�추가,�삭제,�변경할수�있게�하는�편리한�형태나�효과적

인�구조를�마련하는�기능을�가지고있다.�

자료를�찾아보는�견지에서�본다면�표는�모든�레코드를�한꺼번에�표형태로�표시하지만�

양식은�한개�레코드씩�개별적으로�표시할수�있다.��

양식을�리용하면�표를�기초로�하여�매개�레코드들을�개별적으로�확인하고�편집�및�수

정할수�있으며�표에�새로운�레코드를�입력하고�계산결과를�표시하는�등�다양한�목적을�실

현할수�있다.��

물론�양식의�원천으로�되는것은�표이기때문에�양식우에서의�작업결과는�표에�반영된다.�

 

우리가�살고있는�세계에서�모든�대상-실체들은�자기가�가지고있는�고유한�속성

에�의하여�구별되며�어떤�외적인�작용이�가해지면�거기에�행동으로�대답할수�있는

능력을�가지고있다.��

현실세계에�존재하는�실체와�마찬가지로�자기의�고유한�속성과�외적인�작용에

대한�행동을�가지고�프로그람속에서�하나의�덩어리로�존재하는�프로그람적실체�즉

양식이나�질문,�보고서와�같은것을�객체라고�한다.��

알아두기 

양식은�어떤�기능을�가지는가?�

생각하기 
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1. 설계보기에서 양식의 만들기 

양식을�새롭게�설계하려면�《자료기지》의�기본창문을�펼치고�자료기지목록에서�《양

식》을�선택한다.�

�
다음�《작업》항목의�《설계보기에서�양식만들기》를�두번찰칵한다.�그러면�《자료기

지�양식설계》창문이�펼쳐진다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

《양식》조종도구띠�
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《자료기지�양식설계》창문이�펼쳐질�때�왼쪽에�하나의�도구띠가�함께�표시되는데�이

것은�양식설계를�하는데�필요한�객체들을�지원하기�위한�양식조종도구띠이다.��

사용자는�《자료기지�양식설계》창문에서�양식조종도구띠를�리용하여�양식설계를�진행

하게�된다.�여기서�중요하게�리용하는�도구들은�양식조종도구띠의�도구들이다.�

양식조종도구들에는�본문을�표시하는�도구도�있고�단추를�창조할수�있는�도구도�있으

며�표식어를�담는�도구들도�있다.�

사용자는�이러한�도구들로�본문칸,�항행단추�등을�만들어�자료기지를�편리하게�볼수�

있는�양식을�설계하게�되는것이다.�그러면�이미�작성된�학급자료기지의�《학급명단》을�보

기�위한�양식을�설계하면서�구체적인�리용방법을�보기로�하자.�

《학급명단》표자료는�다음과�같이�준비되여있다.�

1� 김신념� 주체83(1994)년�3월�12일� 락랑구역�관문동� 934-8956�

2� 김일남� 주체83(1994)년�6월�28일� 모란봉구역�개선동� 434-3484�

3� 김효심� 주체83(1994)년�5월�12일� 모란봉구역�북새동� 432-4536�

4� 김효진� 주체83(1994)년�12월�5일� 만경대구역�광복동� 756-3453�

5� 리성남� 주체83(1994)년�3월�17일� 중구역�련화동� 331-4536�

6� 리국봉� 주체83(1994)년�9월�24일� 중구역�외성동� 335-4539�

7� 박수정� 주체83(1994)년�2월�19일� 보통강구역�신원동� 457-1853�

8� 한성영� 주체83(1994)년�5월�20일� 모란봉구역�개선동� 434-5467�

9� 허윤미� 주체83(1994)년�1월�26일� 평천구역�봉지동� 435-0125�

10� 조성진� 주체83(1994)년�6월�30일� 서성구역�하신동� 453-2938�

우선�페지장식을�진행한다.�

이를�위하여�페지의�임의의�위치에서�오른쪽찰칵하여�지름차림표를�펼치고�《페지》지

령을�실행한다.�

�

�

�
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그러면�《페지:표준》대화칸이�펼쳐지는데�여기서�사용자는�페지의�배경색이라든가�

서체�등의�속성들을�설정할수�있다.�

�

실례에서는�배경색을�노란색으로�설정하기로�한다.�

다른�속성들은�표준그대로�적용하기로�하고�대화칸을�닫는다.�

양식조종도구띠에는�양식설계에�필요한�도구들이�있는데� (기타�조

종)그림기호를�찰칵하여�기타�조종도구띠를�표시한다.�

기타�조종도구띠에� (표조종)도구가�나타나는데�이것을�찰칵하고�설계화

면에서�끌기를�진행하면�먼저�《표요소�조수-자료》대화칸이�나타난다.��

�

�

�

�

�
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《취소》단추를�찰칵하면�다음과�같은�표형태가�나타난다.�

�

다음�자료기지의�표자료를�양식에�련결하는�양식속성을�설정한다.�

양식속성을�설정하자면�페지의�아래부분에�있는�도구띠에서�양식속성도구를�리용하여

야�한다.�

�

양식속성도구를�찰칵하면�《양식속성》대화칸이�펼쳐진다.�

이�대화칸에서�사용자는�양식에서�현시하게�되는�내용류형과�내용이�들어있는�구체적

인�표자료를�설정한다.�즉�《내용류형》목록에서는�표자료를�보여주겠는가�아니면�질문형

식의�자료를�보여주겠는가를�선택하며�《내용》목록에서는�표자료를�보여주는�경우�어느�

표자료를�보여주겠는가를�설정한다.�

《양식》속성도구
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�

내용설정을�위한�단추를�찰칵하면�그림에서�보는바와�같이�현재�자료기지파일에�있는�

표자료들이�다�현시된다.�

실례에서는�《학급명단》을�선택한다.�그리고�《양식속성》대화칸을�닫는다.�

다음�자료들을�표시하기�위한�객체들을�창조한다.��

그러기�위하여�양식조종도구띠에�있는�

본문마당도구� 를�찰칵하여�선택하고�

페지의�적당한�위치에�배치한다.�

본문마당도구를�리용하여�창조하는�객

체에서는�표자료에�있는�《이름》,�《성

별》,�《집주소》와�같은�본문형식의�자료

들을�표시하게�된다.�

결국�사용자는�한개�레코드에�대하여�

본문으로� 표시되는� 자료마당의� 개수만큼�

본문마당객체를�창조하여야�한다.��

그리고�창조된�본문마당객체들에�대하

여�각각�《이름》,�《성별》,�《집주소》�

등�해당�마당들을�정하여야�한다.��

그러자면�페지에�창조된�객체를�선택

하고�양식조종도구띠에�있는�조종속성도구를�찰칵하여�조종속성대화칸을�펼쳐야�한다.�

조종속성도구�
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조종속성대화칸에서�사용자는�표시하려는�자료마당을�설정한다.�

《자료》표쪽을�찰칵하여�자료크기나�형식�등을�설정할수�있다.�

�

《번호》,�《난날》과�같이�수값자료�혹은�날자자료를�표시하자면�본문마당도구를�리

용하지�말고�서식있는�본문마당도구� 를�리용하여�객체를�창조하는것이�좋다.�

�

그리고�조종속성대화칸에서�서식지정을�위한�단추를�찰칵하여�서식대화칸을�펼치고�

자료의�서식을�설정하여야�한다.�
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�

다음�사용자는�양식조종도구띠에�있는�표식자마당도구� 를�리용하여�매개�객체들

에�대한�설명문을�표시할수�있다.�

표식자마당도구를�리용하여�창조한�객체의�조종속성대화칸에서�표식자입력칸에�《번

호》,�《이름》과�같은�설명문을�입력하여�이미�창조된�본문마당객체앞에�배치하면�된다.�

우의�방법을�리용하여�실례의�《학급명단》을�마당별로�보여줄수�있는�6개의�본문마당객체

를�창조할수�있다.�그리고�매�본문마당객체앞에�《번호》,�《이름》,�《성별》과�같은�설

명문을�표식자마당객체를�리용하여�만들어줄수�있다.�

다음�이행단추를�만드는�방법을�보기로�하자.�

현재의�《학급명단》표자료에는�10명�학생의�자료�즉�10개의�레코드가�있다.�

이�레코드들을�하나씩�현시하는�조건에서�이행단추를�만들어주어�이전�레코드에로�혹

은�다음레코드에로�그리고�첫�레코드와�마지막레코드에로�넘어갈수�있게�한다.�

이행단추를�만들자면�양식조종도구띠에�있는�누름단추도구� 를�찰칵하여�페지의�

적당한�위치에�창조하고�그의�조종속성대화칸을�펼치고�필요한�속성을�설정한다.�

실례로�이전�레코드에로�넘어가는�이전단추를�만들려면�객체를�선택하고�그의�조종속

성대화칸에서�표식자항목에�《이전》이라는�이름을�입력한다.�

�

�

�

�

�

�

�

�

�

�
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다음�작업항목의�내리화살단추를�찰칵하여�이전기록을�설정한다.�

�

그러면�이전�레코드에로�넘어가는�단추가�완성된다.�

같은�방법으로�다음레코드에로�넘어가는�단추(다음),�첫�레코드에로�넘어가는�단추(처

음),�마지막레코드에로�넘어가는�단추(마지막)들을�만든다.�

이렇게�되면�《학급명단》표자료를�위한�양식이�간단히�완성된다.�

�

양식이�완성되면�《자료기지�양식설계》대화칸을�닫으면서�양식을�보관한다.�
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자료기지기본창문에는�새로�만든�양식이�표시된다.�

�

여기서�새로�만든�《학급명단》양식을�두번찰칵하여�실행하여본다.�

�

사용자는�이�환경에서�이행단추들을�리용하여�임의의�레코드를�볼수�있으며�자료값들

을�수정하거나�새로�추가,�삭제할수�있다.�
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이�방법은�사용자의�요구에�맞게�양식을�설계할수�있다는�우점을�가지고있다.�그러나�

이�방법은�조작이�어렵고�작성방법이�유연하지�못하다.�

양식의�작성은�대체로�양식조수에�의한�방법으로�만드는것이�쉽고�보편적이다.��

2. 양식조수를 리용하여 양식만들기 

이�기능은�양식설계를�이미�준비되여있는�표본설계에서�선택하여�만들기때문에�매우�

쉽다.�

양식조수를�리용하면�현재�존재하는�표에�신속히�양식을�결합하기때문에�작성과�리용

에서�매우�편리하다.�

우에서�리용하였던�《학급명단》표의�양식을�양식조수를�리용하여�만들어보기로�한다.�

표는�우의�실례표를�그대로�리용한다.�

우선�《자료기지》창문에서�《표》항목을�선택하고�《학급명단》을�선택한다.�

①�오른쪽찰칵하여�지름차림표를�펼치고�《양식조수》지령을�실행한다.�

�

그러면�《양식조수》대화칸이�펼쳐진다.�대화칸에서�우선�마당선택을�진행한다.�
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�

양식에서�리용하려는�마당은�하나씩�선택하여�화살표를�찰칵하는�방법으로�이동시킨다.�

만일�표의�마당을�그대로�다�리용하려는�경우에는�화살표가�2개�겹쳐있는�단추�

를�찰칵하여�단번에�이동시킨다.��

마당선택이�끝나면�《다음》단추를�찰칵하여�다음단계에로�넘어간다.�

②�부분양식설정에서는�부분양식의�사용여부를�지정하고�부분양식의�속성을�입력한다.�

부분양식은�다른�양식에�삽입되는�양식이다.�

�
③�다음은�부분양식을�추가하는�단계로서�만일�다른�표에서�부분적으로�마당을�더�추

가하려면�이�단계에서�추가해줄수�있다.��
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실례에서는�이미�존재하는�다른�자료�성적표에서�번호마당을�비롯한�몇개의�마당을�더�

추가하기로�한다.��

�

부분양식추가가�끝나면�《다음》단추를�찰칵한다.�

④�다음은�부분양식을�결합하는�단계로서�기본양식(《학급명단》)과�부분양식(《성적

표》)에서�추가한�마당들을�결합하는�단계이다.�실례에서는�번호마당을�각각�결합하고�나

머지�마당들은�결합하지�않기로�한다.�

�
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양식결합이�끝나면�《다음》단추를�찰칵한다.�

⑤�다음은�양식의�형태를�지정하는�단계로서�이미�설계된�표본양식들가운데서�지정한다.�

�

실례에서는�기본양식은�《렬형식�왼쪽에�표식자》로,�부분양식은�《렬형식�웃쪽에�표

식자》로�지정한다.��

양식지정이�끝나면�《다음》단추를�찰칵한다.�

⑥�다음은�자료입력방식을�지정하는�단계로서�대화칸의�항목에�있는�내용에�맞게�임의

로�설정할수�있다.�실례에서는�표준설정을�그대로�한다.�

�

자료입력방식설정이�끝나면�《다음》단추를�찰칵한다.�
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⑦�다음은�양식의�격식을�지정하는�단계로서�양식의�배경색이라든가�객체들의�모양형

식을�주는�단계이다.�

실례에서는�표준설정을�그대로�하기로�한다.�

�

격식설정이�끝나면�《다음》단추를�찰칵한다.�

⑧�다음은�양식의�이름을�설정하는�단계이다.�

실례에서는�양식의�이름을�《학급명단과�학기성적》이라고�입력한다.�

《끝내기》단추를�찰칵한다.�

�

그러면�양식창문이�펼쳐진다.�

이�양식창문에서�매개�레코드들을�볼수�있고�수정할수�있으며�새로운�레코드를�삽입할

수�있다.�레코드의�이행은�대면부의�아래에�표시된�이행단추를�리용한다.�
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�
양식조수를�리용하여�양식을�만드는�방법은�이상과�같다.�

이�방법은�손쉽게�양식을�만드는�우점으로�하여�사용자들이�많이�리용하는�방법이지만�

이미�마련된�양식표본대로�설계되기때문에�사용자의�개성에�맞는�설계를�하지�못하는�결함

이�있다.�양식의�설계를�수정하기�위해서는�다음과�같이�한다.�

①�이미�작성된�양식을�편집방식으로�열기를�진행한다.�

�

�

�

�

�

�

�

�

�

�

�

�

②�《도구띠》→《양식조종체》지령을�실행하여�《양식조종체》도구띠를�현시한다.�

�

�

�

이�설계방식에서�임의의�객체�즉�본문편집칸,�표식칸,�화상표시칸�등�각종�조종체들을

선택하고�이동시킬수�있으며�칸의�크기변경,�서체변경,�그림표시방식의�변경�등�매�객체의

속성을�설정�또는�변경시킬수�있다.�

이행단추�
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제2절. 질문만들기와 리용 

질문은�자료기지에�포함되는�하나의�객체로서�표의�자료가운데서�필요한�자료를�찾아

내기�위하여�사용하는�객체이다.��

물론�려과기를�리용해서도�사용자가�지정하는�조건의�자료를�추출해낼수�있지만�질문

은�보다�능률적으로�자료기지에�축적된�정보를�분석하여�그�결과를�추출해낸다.�다시�말하

여�질문은�사용자로�하여금�자료기지에�복잡하고�다양한�질문을�던지고�그�답을�구할수�있

게�한다.�

1. 설계보기에서의 질문작성 

- 필요한 마당만을 표시하는 질문 

《학급명단》표자료에서�번호,�이름,�집주소만을�표시하는�표를�작성하여보기로�하자.�

①�자료기지기본창문에서�질문을�선택한다.�그러면�작업칸에�《설계보기에서�질문만

들기》,�《조수를�사용하여�질문만들기》,�《SQL보기에서�질문만들기》의�항목들이�나타

난다.�《설계보기에서�질문만들기》를�두번찰칵한다.�

�

그러면�《자료기지:질문설계》창문과�함께�《표�또는�질문추가》대화칸이�나타난다.�

②�《표�또는�질문추가》대화칸에는�현재�자료기지파일이�가지고있는�표들이�다�표시

되여있다.�이�표들중에서�질문을�만드는데�참고할�표들을�추가한다.�
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�

�

�

�

�

�

�

�

�

�

�

�

�

실례에서는�《학급명단》표를�추가한다.�

다음�《표�또는�질문추가》대화칸의�《닫기》단추를�찰칵한다.�

③�표가�추가되면�표의�마당들이�표시되는�작은�목록칸이�나타난다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

질문실행단추
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이�목록에서�필요한�마당만을�선택하여�질문을�만들수�있다.�

마당을�선택하고�끌기로�아래의�표에�차례로�떨구면�된다.�

실례에서는�《번호》,�《이름》,�《집주소》마당만을�표에�떨군다.�

④�필요한�마당을�선택하여�추가한�다음�질문설계창문의�도구띠에서�《질문실행》그

림기호를�찰칵하여�질문에�의하여�얻어진�새로운�표를�확인한다.�

�

�

�

�

�

�

�

⑤�질문설계창문의�도구띠에서�보관그림기호를�찰칵한다.�그러면�보관대화칸이�펼쳐

지는데�여기서�질문의�이름을�입력한�다음�《확인》단추를�찰칵한다.�

�
그러면�새롭게�만든�질문이�자료기지기본창문에�나타난다.�

�
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새로�만든�질문을�펼치면�표형태로�현시된다.�

- 조건질문 

표자료에서�어떤�조건에�맞는�자료들만을�얻어내는�질문이다.�

례들어�《학급명단》에서�집주소가�보통강구역인�학생들의�레코드만을�가지는�표를�작

성한다든가�성적이�4점이상인�학생들의�레코드만을�뽑아낸다든가�하는�경우에�적용하는�질

문이다.�그러면�《성적표》자료에서�콤퓨터성적과�수학성적이�4.5이상인�학생들의�레코드

만을�표시하는�질문을�작성해보자.�

�

번호� 이름� 성별� 난�날� 혁명력사 수학 콤퓨터� 외국어

1� 강진석� 남자� 주체82(1993)년�1월�12일 5� 5� 5� 5�

2� 김철국� 남자� 주체82(1993)년�4월�8일� 4.5� 5� 4� 4.5�

3� 리문성� 남자� 주체82(1993)년�8월�24일 5� 5� 4.5� 4.5�

4� 리순애� 녀자� 주체82(1993)년�5월�3일� 4.5� 5� 4� 5�

5� 원철남� 남자� 주체82(1993)년�7월�17일 5� 4� 4� 4�

6� 박명옥� 녀자� 주체82(1993)년�7월�19일 4.5� 4.5 4.5� 5�

�

①�자료기지기본창문에서�《질문》을�선택하고�《설계보기에서�질문만들기》를�두번찰

칵하여�질문설계창문을�펼친다.�

�

②�《표�또는�질문추가》대화칸에서�《성적표》를�선택하여�추가한다.�

③�모든�마당들을�끌기로�떨구어�아래의�표에�배치한다.�
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�
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�

�

�

�

혹은�아래의�표의�표항목에서�목록단추를�내리펼쳐�《성적표》를�선택한�다음�마당항

목에서�해당�마당을�선택하는�방법으로�배치할수도�있다.�

④�《콤퓨터》와�《수학》마당칸에서�《기준》입력칸에�《>=4.5》라고�입력한다.�

다른�조건을�더�주려는�경우에는�기준입력칸아래에�있는�《또는》 이라는�입력칸을�리

용하여�적용할수�있다.�

⑤�질문설계창문의�도구띠에서�《질문실행》그림기호를�찰칵한다.�그러면�요구하는�질

문이�표시된다.�

�

�

�

�

�

�

⑥�질문을�보관한다.�질문의�이름을�《콤퓨터성적우수생》이라고�달아준다.�

자료기지기본창문에서�새로�만든�질문을�펼쳐본다.�

- 다중표에 의한 질문 

다중표에�의하여�질문을�만든다는것은�2개이상의�표에서�필요한�마당들을�묶어서�새

로운�표를�얻어내는�질문을�작성한다는것을�의미한다.�

다중표에�의한�질문만들기를�실례를�통하여�보기로�한다.�

《학급명단》표와�《조직구성》표에서�일부�마당을�선택하여�새로운�표를�만드는�질

문을�작성하자.�

①�자료기지기본창문에서�《설계보기에서�질문만들기》를�두번찰칵한다.�

②�질문설계창문에�나타난�《표�또는�질문추가》대화칸에서�《학급명단》과�《조직구

성》표를�추가한다.�
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�
③�다음�《학급명단》표의�이름마당과�《조직구성》표의�이름마당을�끌기로�련결한다.�

�

④�다음�《학급명단》표에서�모든�마당들을�표에�추가하고�《조직구성》표에서는�

《열성자관계》마당을�표에�추가한다.�

�
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⑤�다음�《질문실행》그림기호를�찰칵하면�질문이�완성된다.�

�

⑥�질문의�이름을�《열성자명단》이라고�입력하고�보관한다.�

2. 조수를 사용하여 질문만들기 

조수를�리용하면�보다�쉽게�질문을�작성할수�있다.�

질문을�만들수�있는�범위나�형태는�설계보기에서�질문만들기와�같다.�

《성적표》표자료에서�혁명력사성적이�5점,�영어성적이�4.5이상,�콤퓨터성적이�5점인�

학생들을�표시하는�질문을�만들어보자.�

①�《자료기지》칸에서�《질문》을�선택하고�《작업》칸에서�《조수를�사용하여�질문

만들기》를�찰칵한다.�

�

�

�

�

�

�

�

�

�

�
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그러면�《질문조수》대화칸이�펼쳐지는데�여기서�우선�참고할�표를�선택하고�마당을�

선택한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

실례에서는�《성적표》를�선택하고�마당은�모두�선택한다.�

《다음》단추를�찰칵하여�다음단계로�넘어간다.�

②�다음은�마당별로�정렬을�진행하는�단계이다.�

�

사용자는�필요한�마당을�선택하고�오름순서�혹은�내림순서로�자료를�정렬할수�있다.�

실례에서는�정렬을�진행하지�않고�다음단계에로�넘어가기로�한다.�

《다음》단추를�찰칵한다.�

③�탐색조건을�설정하는�단계이다.�
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�
이�단계에서�혁명력사성적이�5점,�영어성적이�4.5점이상,�콤퓨터성적이�5점인�레코드

들을�추출할수�있다.�

《마당》목록을�내리펼쳐�《성적표.혁명력사》를�설정한다.�

다음�《조건》목록을�펼치고�《같기》를�선택한다.�

값입력칸에는�5라고�입력한다.�

아래의�《마당》목록에서는�《성적표.영어》를�선택하고�조건목록에서는�《크거나�같

기》를�선택한다.�그리고�《값》입력칸에는�4.5를�입력한다.�

같은�방법으로�콤퓨터마당에는�5점인�탐색조건을�준다.�

《다음》단추를�찰칵한다.�

④�다음단계는�질문의�류형을�선택하는�단계이다.�

�
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실례로�모든�레코드들을�다�표시하겠는가�혹은�상세한�정보를�표시하겠는가�등의�설정

을�위한�단계이다.�실례에서는�표준설정을�그대로�두고�다음단계에로�넘어가기로�한다.�

《다음》단추를�찰칵한다.�

⑤�다음단계는�세부정보를�선택하여�진행하는�경우�자료들의�묶음화를�진행하는�단계

이다.�여기서는�묶음화기준과�묶음화조건을�설정한다.�

묶음화준위를�설정할�필요가�없으므로�이�단계를�넘어가기로�한다.�

⑥�다음단계는�마당값들에�필요한�경우�별명을�달아주는�단계이다.�

별명을�달지�않고�넘어가기로�한다.�

�

⑦�마지막단계는�지금까지�설정한�내용들을�보는�개요와�질문의�이름을�입력하는�단계

이다.�

�
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사용자는�자기가�진행한�설정들을�개요항목들을�통하여�볼수�있으며�미흡한�부분이�확

인되면�《뒤로》단추를�찰칵하여�다시�설정할수�있다.�

질문의�이름을�확인하고�《끝내기》단추를�찰칵하면�완성된�질문이�펼쳐진다.�

�

조수를�사용하여�질문만들기는�이처럼�우와�같은�단계를�거치는�과정에�사용자의�요구

를�반영하여�임의의�질문을�작성할수�있다.�

�

�

�

제3절. 보고서만들기와 리용 

보고서는�어떤�자료를�개별적인�사람이나�단체�혹은�회의에�제출하는�문건이다.�

그러한�의미에서�보고서의�형태를�생각한다면�자료를�분석하기에�편리하며�한눈에�안

겨올수�있게�하며�그리고�일정하게�문화성도�갖추는것이�필요할것이다.�

앞에서�우리는�자료를�입력하기�위한�표를�작성하고�레코드별로�정보를�관리하기�

위해�양식을�만들고�요구하는�정보를�분석하고�선택하기�위한�질문들을�작성하는�방법

들을�보았다.��

이러한�자료들을�인쇄하여�리용하는�경우에는�일정한�형식으로�자료를�정리하고�보기

좋게�형식을�갖추는것이�필요할것이다.�

물론�자료표나�양식,�질문결과를�그대로�인쇄할수도�있다.�그러나�표의�자료가�입력되

는�자료표나�질문�등은�인쇄를�위하여�설계된것이�아니다.��

보고서는�전문인쇄를�목적으로�필요한�요구조건에�맞게�설계된것이다.�

1. 보고서만들기 

보고서를�만드는�방법은�조수를�리용하여�만드는�방법�하나뿐이다.�

먼저�자료기지기본창문에서�《보고서》를�선택하고�《조수를�사용하여�보고서만들기》

를�두번찰칵한다.�
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�
그러면�보고서를�만드는�전반적인�단계를�안내하여주는�《보고서조수》대화칸이�펼쳐

진다.�보고서작성방법도�실례조작을�하는�과정을�통하여�보기로�한다.�

우의�실례조작들에서�작성된�질문�《열성자명단》을�보고서로�작성하는�과정을�보기

로�하자.�

《보고서조수》대화칸의�첫�단계는�보고서를�만들�표를�선택하고�그의�마당들을�선택

추가하는�단계이다.�

�
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이�단계에서�현재�자료기지파일에�존재하는�표를�선택하고�필요한�마당들을�선택한다.�

다음은�마당표식자를�지정하는�단계로서�마당이름을�그대로�리용하든가�아니면�마당이

름을�달리�입력할수�있는�단계라고�할수�있다.�실례에서는�그대로�두기로�한다.�

�
다음은�마당의�묶음화준위를�추가하는�단계이다.�

�

이�단계는�자료들의�무게정도에�따라�준위별로�분류하는�단계라고�생각할수�있다.�

실례에서는�번호,�이름,�열성자관계마당을�묶음화하기로�한다.�

다음은�마당의�자료값들을�정렬하는�단계이다.�
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이�단계에서�필요한�마당을�선택하여�값들을�정렬하여�보고서페지의�순서를�결정할수�

있다.�

�

다음은�보고서의�자료들의�배치와�머리글,�바닥글배치�등을�설정하는�단계이다.�

이�단계에서�작성자는�자료들을�페지에서�어떻게�배치하겠는가를�항목에�따라�설정할

수�있다.�

�

다음은�마지막단계로서�보고서의�진행형식을�설정하는�단계이다.�
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�

보고서의�표시에는�보고서를�정적인�보고서로�표시하겠는가,�동적인�보고서로�표시하

겠는가의�설정과�현재�보고서로�표시하겠는가,�수정할수�있는�보고서로�표시하겠는가를�설

정하는�방법이�있다.�표시방법이�확인되면�《끝내기》단추를�찰칵하여�보고서작성을�끝낸

다.�그러면�보고서가�펼쳐진다.�

�
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2. 보고서의 인쇄 

《자료기지》에서는�구축된�자료기지의�구성요소들인�표,�질문,�양식,�보고서�등의�객

체들을�인쇄할수�있다.�인쇄하자면�자료기지창문의�해당한�객체를�선택하고�도구띠의�인쇄

그림기호를�찰칵해야�한다.�

《자료기지》에서�만든�자료기지의�모든�객체들에�대하여�인쇄는�가능하지만�보고서를�

제외한�나머지�객체들(표,�질문,�양식�등)에�대한�인쇄는�적당치�않다.�

실례로�많은�표객체에�대해서는�표전체(마당전체)를�인쇄하기�곤난한것이다.�이런�경

우�보고서를�작성하여�필요한�부분만을�인쇄하든가�여러개의�보고서를�작성하여�모두�인쇄

할수�있는것이다.�

보고서객체는�인쇄를�목적으로�한�객체이므로�인쇄물을�얻으려고�할�때에는�보통�보고

서객체를�리용하는것이�좋다.�다시말하여�인쇄하려고�하는�표나�양식,�질문�등을�참고한�

보고서를�만들어�인쇄하는것이�좋다.�

련습문제 

1.�번호,�학년반,�이름,�성별,�난날,�집주소의�항목을�가지는�《학급명단》자료기지를�만

들어보아라.�

2. 번호,�이름,�혁명력사,�수학,�외국어,�콤퓨터,�물리의�항목을�가지는�자기�소년반의�《1

학기성적》자료기지를�만들고�그에�기초한�양식을�만들며�새로운�레코드를�추가하거나�

삭제,�변경하여보아라.�

3.�《학생명단》자료기지에서�녀학생이면서�집주소가�같은�구역(군)인�학생들만을�표시하

는�질문을�작성하여라.�

4.�《학생명단》과�《1학기성적》자료기지에서�번호,�학년반,�이름,�성별,�혁명력사,�수학,�

콤퓨터성적항목을�가지는�다중표에�의한�질문을�작성하여라.�

5.�《1학기성적》자료기지에서�혁명력사성적과�콤퓨터성적이�4.5이상인�학생들만을�표시하

는�질문을�작성하여라.�

�

�

�

�

�

�

�

�

�

�



�

�136�

제5장. 동화상만들기 

제1절. 동화상작품만들기 

1. 여러개의 장면(Scene)을 가지는 동화상만들기 

프레임은�동화상을�만들기�위한�하나의�장면이다.��

Scene도�장면이라고�부르는데�프레임과는�의미가�다르다.�Scene은�공연을�할�때�무

대가�바뀌는것처럼�새로운�내용으로�바뀌는것을�의미한다.�

�

례 1.�여러개의�Scene을�가지는�동화상만들기�

�

1.�Flash를�기동하여�간단한�동화상을�하나�만든다.�

2.�Stage에�4각형을�하나�그린다.�

�

�

�

�

�

�

�

�

�

�

3.�15번프레임을�선택하고�오른쪽찰칵하여�Insert�Blank�Keyframe지령을�실행한다.�

�

�

�

�

�

�

�

�

�

�

4.�15번프레임에�원을�하나�그린다.�

5.�1번부터�15번프레임사이의�임의의�프레임을�선택하고�Properties�Panel의�Tween에

서�Shape를�선택한다.�
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�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

이렇게�하여�4각형이�원으로�변하는�동화상을�만들었다.�

6.�차림표띠에서�Insert→Scene지령을�실행한다.�

�

그러면�Stage우에�있는�작업창문표시띠에�Scene�2라고�표시된다.�

�

7.�Scene�2에서�간단한�동화상을�만든다.�

여기서는�글자가�이동하는�동화상을�만들었다.�
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�

Ctrl+Enter건을�눌러�실행해보면�두�동화상이�차례로�실행되는것을�볼수�있다.�

복잡한�동화상작품을�만들�때에는�내용에�따라�장면들을�만들어놓고�리용하면�편리하

다.�장면들의�관리는�차림표띠에서�Windows→Scene지령을�실행하여�나타나는�Scene관

리칸에서�할수�있다.�

�

�

�

�

�

�

�

�

�

�

�

�

어떤�장면의�이름을�바꾸려고�할�때에는�그�장면을�두번찰칵하여�새로운�이름을�입력

하면�된다.�그리고�끌기하는�방법으로�장면들사이의�실행순서를�변경시킬수도�있다.�

�

례 2.�Frame�Action을�리용한�동화상조종�

�

1.�앞에서�만든�여러개의�Scene을�가지는�동화상파일을�펼친다.�

앞의�례에서�만든�파일을�Ctrl+Enter건을�눌러�실행시켜보면�Movie가�멎지�않고�계

속�반복되는것을�알수�있다.�

2.�Stage우에�있는�작업창문표시띠의�Scene선택단추를�찰칵한다.�
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�

여기서�Scene�2를�선택한다.�

3.�Scene�2의�마지막�키프레임을�선택하고�오른쪽찰칵하여�Actions지령을�실행한다.�

�

그러면�Action�Panel이�열린다.�

�

4.�Action�Panel에서�Actions→Movie�Control→Stop를�두번찰칵한다.�
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�

Ctrl+Enter건을�눌러�Movie를�실행시켜보면�두번째�장면의�마지막프레임까지�재생되

고�정지되는것을�알수�있다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

《≤

Action Panel에 대하여 

�View�Options:�입력방식을�설정한다.�

여기에는�Normal�Mode(일반방식),�Expert�Mode(전문가방식)이�있다.�그리

고�View�Line�Numbers를�선택하면�행번호가�표시된다.�

 

�

�Debug� Options:� Action의� 오유를� 수정할� 때� 쓰이는� 중지점

(Breakpoint)을�설정,�삭제할�때�리용한다.�

 

�

알아두기 
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�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�Add�a�new�item�to�the�script:�Action을�추가할�때�리용한다.�

 

�

�Delete�the�seleced�action(s):�선택한�Action을�삭제할�때�리용한다.�

Normal�Mode에서만�리용할수�있다.�

�Find:�단어를�찾을�때�리용한다.�

 

�

�Replace:�단어를�치환할�때�리용한다.�

 

�

�Insert�a�target�path:�Movie�Clip�Instance들사이의�경로를�지정할�때

리용한다.�

�
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2. 단추에 의한 동화상조종 

Button�Symbol은�사용자와의�호상작용을�만들�때�리용한다.�

�

례 3.�Button�Symbol에�의한�동화상조종�

�

1.�앞에서�만든�동화상파일을�펼친다.�

이�파일은�두번째�Scene의�마지막프레임까지�재생되고�정지하게�되여있다.�

2.�차림표띠에서�Insert→New�Symbol지령을�실행하여�단추를�하나�만든다.�

Ctrl+L건을�눌러�Library�Panel을�펼치면�Button�Symbol이�만들어진것을�볼수�

있다.�

�

3.�Stage우에�있는�작업창문표시띠에서�Scene�2를�선택하여�Scene�2를�펼친다.�

�
4.�Timeline에서�새로운�Layer를�하나�만든다.�

�
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5.�Layer�2의�임의의�프레임을�선택하고�Library�Panel에서�Button�Symbol을�끌

기하여�Stage에�배치한다.�

�

6.�Properties�Panel에서�Instance이름을�Play라고�준다.�

�

7.�Action�Panel을�펼치고�Action�for�Play(Symbol�1)을�선택한다.�

�

8.�Action→Movie�Control→goto를�두번찰칵한다.�
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�
그리고�Scene항목에서�Scene�1을�선택한다.�

�

Ctrl+Enter건을�눌러�Movie를�실행해본다.�

단추를�찰칵하면�Movie가�다시�재생되는것을�알수�있다.�

련습문제 

1.�례�3에서�Action�Panel을�보면�Go�to�and�Play가�선택되여있는�상태이다.�만일�Go�

to�and�Stop을�선택하면�어떻게�되는가?�

�

2.�Action�Panel의�Frame항목이�1로�되여있는데�다른�수자를�넣으면�어떻게�되는가?�

3.�《재생》,�《정지》기능을�수행하는�단추를�만들어보아라.�

4.�여러개의�장면이�들어있는�동화상을�만들어보아라.�

5.�장면들의�이름을�변경시켜보고�또�실행순서를�바꾸어보아라.�
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제2절. ActionScript에 의한 동화상만들기 

ActionScript는�Flash의�script언어이다.�script언어로는�프로그람과�의사를�주고�받

는다.�즉�Flash프로그람이�무엇을�하겠는가를�알려주고�또�Movie가�재생되는�동안�무엇

이�일어났는가를�물어본다.�이것을�리용하여�대화형�Movie를�만들수�있다.�

�

례 1.�ActionScript를�리용하여�도형그리기�

�

1.�새�작업파일을�열고�Action�Panel에서�Expert�Mode와�View�Line�Numbers를�

선택한다.�

�
2.�다음�그림과�같이�입력한다.�

�

Ctrl+Enter건을�눌러�실행해보면�다음과�같은�도형이�그려진것을�알수�있다.�

�
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3.�다음�그림과�같이�수정한다.�

�
Ctrl+Enter건을�눌러�실행해보면�다음과�같은�도형이�그려진것을�알수�있다.�

�

4.�이번에는�다음�그림과�같이�수정한다.�

�
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Ctrl+Enter건을�눌러�실행해보면�다음과�같은�도형이�그려진것을�알수�있다.�

�
이와�같이�ActionScript는�Flash프로그람에게�무엇을�할것인가를�알려준다.�우의�례

에서는�그리기도구를�리용하지�않고도�도형을�그렸다.�

�

�

�
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계층구조에 대하여 

Movie�Clip을�만들�때�그안에�다른�Movie�Clip이�들어갈수�있다는것은�이미

배웠다.�

Flash에서는�이것들사이의�관계를�계층구조로�표시한다.�마치�파일열람기에서

어떤�파일을�찾자고�할�때�어느�등록부의�어느�파일이라고�하는것과�같다.�

차림표띠에서�Window→Movie�Explorer지령을�실행하면�파일열람기와�류사

한�Movie열람기가�펼쳐진다.�

�

그림을�보고�알수�있는바와�같이�Scene�1에�Symbol�1과�Symbol�2가�있다.�

_root는�제일�웃준위를�가리킨다.�이것을�/로�표시하기도�한다.�

같은�준위에�있는�Movie�Clip들은�Instance이름으로�구별된다.�어떤�Movie�

Clip안에�포함되여있는�Movie�Clip을�그의�자식이라고�한다.�

알아두기 
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�

�

모든�Script언어와�마찬가지로�ActionScript도�자기의�고유한�용어를�가지고있다.��

중요한�몇가지를�보기로�한다.�

�

Action(명령):�파일이�실행되는�동안�무엇을�해야�하겠는가를�서술하는�명령문이다.�

례를�들어�gotoAndStop()은�재생머리부를�지정된�프레임에�보내고�정지하게�한다.�일반

적으로�Action이란�용어와�명령문이란�용어를�같이�쓴다.�

Data�Type(자료형):�ActionScript�혹은�변수가�취할수�있는�자료형을�말한다.�

례 2.�ActionScript를�리용한�결과표시�

새로운�작업파일을�열고�Action�Panel에서�다음�그림과�같이�입력한다.�

�

Ctrl+Enter건을�눌러�Movie를�실행시키면�다음과�같이�Output칸에�결과가�표시된다.�

�

앞의�례에서�본�_root.createEmptyMovieClip(“Draw_mc”,�1)은�_root에

Draw_mc라는�Instance(실체)이름을�가지는�Movie�Clip을�계층�1에�만들라는�지

령이다.�

경로를�지정하는데�this,�_root,�_parent를�리용한다.�this는�현재�Movie�Clip�

혹은�모형�instance에�대한�참조이고�_root는�제일�웃준위�Timeline에�대한�참조이

고�_parent는�현재�Movie�Clip�혹은�모형을�포함하는�Movie�Clip�혹은�모형에�대

한�참조이다.�



�

� 149

여기서�123은�수값자료이고�abc는�문자렬자료이다.�

�

Flash의�자료형에는� String형,� Number형,� Boolean형,� Object형,�MovieClip형,�

Null형,�Undefined형이�있다.�

String형은�웃두�점안에�들어있는�문자,�수자,�구두점들이다.�

Number형은�말그대로�수자들이다.�

Boolean형은�참(true)과�거짓(false)가운데서�하나를�가지는�자료이다.�

Object형은�속성(properties)과�방법(method)을�통해서�값을�얻을수�있는�자료이다.�

MovieClip형은�실체(Instance)이름을�가지고있는�자료이다.�

Null형은�오직�하나의�값�0을�가지는�자료이다.�

Undefined형은�undefined라는�값을�가지는데�값을�할당받지�않은�변수의�경우�이�

자료형으로�된다.�

�

Event(사건):�파일이�실행되는�동안에�발생하는�Action을�말한다.�례를�들어�Movie�

Clip이�적재되거나�재생머리부가�어떤�프레임에�들어설�때�그리고�사용자가�단추나�Movie�

Clip을�찰칵할�때�혹은�건반을�누를�때�서로�다른�사건이�발생한다.�

Event�Handler(사건조종기):�마우스를�찰칵했다든가�Movie� Clip이�적재됐다든가�

하는�사건들을�관리하는�특수한�Action이다.�

�

례 3.�공백건을�누르면�시작되는�동화상만들기�

�

1.�새로운�작업파일을�열고�Insert→New�Symbol지령을�실행한다.�

2.�Create�New�Symbol대화칸에서�Button을�선택하고�OK단추를�찰칵한다.�

3.�Button편집칸에서�아무것도�하지�않고�Scene으로�나온다.�

4.�Library�Panel을�보면�Symbol�1이라는�Button�Symbol이�생긴것을�알수�있다.�

�
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5.�1번프레임을�선택하고�Action�Panel에서�다음과�같이�입력한다.�

�

6.�Library�Panel에서�Button�Symbol을�끌어서�Stage에�배치한다.�

Stage에는�아무것도�보이지�않는다.�

7.�Action�Panel에서�Action�for�[No�instance�name�assigned]�(Symbol�1)을�

선택하고�Action→Movie�Control→on을�두번찰칵한다.�

�

8.�keypress�“<Space>”를�선택한다.�

�

9.�다음그림과�같이�입력한다.�이것은�2번프레임에�재생머리부를�가져가서�실행하라

는것이다.�
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�

10.�2번프레임과�20번프레임에�공백키프레임을�설정한다.�

11.�2번프레임부터�20번프레임사이에�간단한�동화상을�하나�만든다.�

�

Ctrl+Enter건을�눌러�Movie를�실행시켜본다.�

공백건을�누르면�동화상이�재생되는것을�알수�있다.�

�

�

�

�
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Action의 종류 

ActionScript는� 크게� Object� Action과� Frame� Action으로�나눈다.� Object�

Action은�Stage에�놓인�Button�Instance,�Movie�Clip�Instance에만�적용할수�있

다.�그리고�Frame�Action은�프레임에만�적용할수�있다.�

앞에서�아무것도�없는�Button�Symbol을�만든것은�건반조종을�수행하는�on()�

Action이�프레임Action에는�없고�Button�Action에만�있기때문이다.�

알아두기 
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례 4.�건반에�따라�움직이는�동화상만들기�

�

1.�새로운�작업파일을�열고�Insert→New�Symbol지령을�실행한다.�

2.�Create�New�Symbol대화칸에서�Movie�Clip을�선택하고�OK를�찰칵한다.�

3.�Movie�Clip편집칸에서�적당한�도형을�하나�그린다.�

4.�Scene으로�나와서�방금�만든�Movie�Clip을�Stage에�배치한다.�

5.�Timeline의�1번프레임에�stop()�Action을�적용한다.�

6.�Movie�Clip을�선택하고�Action�Panel에�가서�다음과�같이�입력한다.�

�

Ctrl+Enter건을�눌러�Movie를�실행시킨다.�

→방향건을�누를�때마다�Movie�Clip이�이동하는것을�알수�있다.�

7.�Action�Panel의�내용을�다음과�같이�수정한다.�

�

Ctrl+Enter건을�눌러�Movie를�실행시킨다.�

그러면�↓방향건을�누를�때마다�Movie�Clip이�이동하는것을�알수�있다.�
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if명령문에 대하여 

if명령문의�일반형식은�다음과�같다.�

if(조건){�

� 명령문들;�

}�

여기서�조건은�참과�거짓으로�평가되는�표현식이다.�

명령문들은�조건이�성립할�때�실행되는�명령문들이다.�

on()과 onClipEvent()에 대하여 

on(mouseEvent)�Action은�마우스사건이�일어나면�실행된다.�

마우스사건에는�다음과�같은것들이�있다.�

press:�마우스지시자가�단추우에�있는�동안�마우스단추를�눌렀을�때이다.�

release:�마우스지시자가�단추우에�있는�동안�마우스단추를�놓았을�때이다.�

releaseOutside:�마우스지시자가�단추에�있을�때�마우스단추를�누르고�단추밖

에서�마우스단추를�놓았을�때이다.�

rollOut:�마우스지시자가�단추령역밖으로�나갈�때이다.�

rollOver:�마우스지시자가�단추로�들어올�때이다.�

dragOut:�마우스지시자가�단추우에�있을�때�마우스단추를�누르고�단추령역밖

으로�나갈�때이다.�

dragOver:�마우스지시자가�단추우에�있을�때�마우스단추를�누르고�단추령역밖

으로�나갔다가�다시�들어올�때이다.�

keypress:�지정된�건이�눌리웠을�때이다.�

onClipEvent(movieEvent)는�movieEvent가�일어나면�실행된다.�

사건에는�다음과�같은것들이�있다.�

load:�Movie�Clip이�실체화되여�Timeline에�나타날�때이다.�

unload:�Movie�Clip이�Timeline에서�없어진�다음이다.�

enterFrame:�Movie의�어떤�프레임에서부터이다.�

mouseMove:�마우스가�움직일�때이다.�

mouseDown:�마우스단추가�눌리웠을�때이다.�

mouseUp:�마우스단추를�놓을�때이다.�

keyDown:�건을�누를�때이다.�

keyUp:�건을�놓을�때이다.�

data:�loadVariables�Action이나��loadMovie�Action에서�자료를�받을�때

이다.�

알아두기 
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�

Function(함수):�다시�리용할수�있는�명령들의�블로크이다.�

Instance(실체):�어떤�모형의�실제적인�구현이다.�

Variable(변수):�어떤�자료형의�값을�보관하기�위한�식별자이다.�

�

례 5.�Action을�리용하여�동화상의�재생시간구하기�

1.�례�3에서�만든�파일을�펼친다.�

2.�2번프레임을�선택하고�다음과�같이�입력한다.�

�

3.�20번프레임을�선택하고�다음과�같이�입력한다.�

�

Ctrl+Enter건을�눌러�Movie를�실행해본다.�그러면�Output칸에�동화상재생시간이�

ms(미리초:�1/1000초)로�표시된다.�

�

탐 구 
례�4에서�만든�동화상을�임의의�방향건을�선택할�때의�경우로�완성해보아라.�
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례 6.�건반을�리용하여�물체를�회전시키기�

�

1.�새로운�작업파일을�열고�Insert→New�Symbol지령을�실행한다.�

Create�New�Symbol대화칸에서�Movie�Clip을�선택하고�OK단추를�찰칵한다.�

2.�Movie�Clip편집칸에서�다음과�같은�도형을�하나�만든다.�

�

3.�Scene으로�나와서�Movie�Clip을�Stage에�배치하고�Instance�Name을�block로�

준다.�

�

4.�아무�내용도�없는�Button�Symbol을�만들고�Stage에�배치한다.�

5.�1번프레임에�stop()�Action을�적용한다.�

6.�Button�Symbol의�Action을�다음과�같이�작성한다.�

�

Ctrl+Enter건을�눌러�Movie를�실행해본다.�

←방향건을�누르면�도형이�회전하는것을�알수�있다.�
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례 7.�Action을�리용하여�초시계만들기�

�

1.�새로운�작업파일을�열고�도구칸에서�문자도구를�선택한다.�

2.�Properties�Panel에서�Dynamic�Text를�선택한다.�

�

3.�Stage에서�끌기하여�Text�Field를�창조한다.�

�

Text�Field를�만들�때�Font의�크기에�맞게�크기를�조절해주어야�한다.�만일�Text�

Field가�작게�되면�글자가�잘리울수�있다.�

4.�1번프레임을�선택하고�Action�Panel에�다음과�같이�입력한다.�

�

Ctrl+Enter건을�눌러�Movie를�실행해본다.�

그러면�수자가�1초간격으로�변하는것을�알수�있다.�
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�

례 8.�Action을�리용한�문자렬입력�

1.�새로운�작업파일을�열고�문자도구를�선택하고�Properties�Panel에서�Input�Text

를�선택한다.�

�
2.�Stage에서�끌기하여�문자를�입력할�령역을�지정한다.�

�
3.�입력마당의�테두리를�Line도구로�그려준다.�

Properties�Panel에서�Show�Border�Around�Text단추를�선택해도�Movie를�

재생할�때�입력마당이�표시된다.�

4.�도구칸에서�Text도구를�선택하고�Text�Type를�Static�Text로�지정한다.�

5.�적당한�설명문을�달아준다.�례를�들어�《문자렬을�입력하시오》라고�입력한다.�

�

탐 구 
바늘이�회전하는�기계식시계와�시간,�분,�초가�표시되는�전자시계를�만들어

보아라. 
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6.�도구칸에서�Text도구를�선택하고�Text�Type를�Dynamic�Text로�한다.�

7.�Stage에�문자렬을�표시하기�위한�Text�Field를�만든다.�그리고�적당한�설명문을�

달아준다.�례를�들어�《입력된�문자렬》이라고�입력한다.�

�
8.�도구칸에서�선택도구를�선택하고�입력마당을�선택한다.�

9.�Properties�Panel의�Var에�s라고�입력한다.�

�

10.�다음�Dynamic�Text를�선택하고�Var에�s라고�입력한다.�

Ctrl+Enter건을�눌러�Movie를�실행한다.�

문자렬을�입력하면�그것이�그대로�표시되는것을�알수�있다.�

�

례 9.�Action을�리용하여�보이기속성조절하기�

�

1.�새로운�작업파일을�열고�적당한�Movie�Clip을�하나�만들고�Stage에�배치한다.�

2.�Action�Panel에�다음과�같이�입력한다.�

�
Movie를�재생해보면�마우스로�Movie�Clip을�찰칵할�때�그�Movie�Clip이�없어지는

것을�알수�있다.�
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3.�Action�Panel에�다음과�같이�입력한다.�

�

Movie를�재생해보면�마우스단추를�누를�때�Movie�Clip이�없어졌다가�마우스단추를�

놓으면�뿌옇게�되는것을�알수�있다.�

�

 

 

�

�

�

례 10. Action을�리용하여�여러개의�같은�Movie�Clip만들기�

1.�새로운�작업파일을�열고�Insert→New�Symbol지령을�실행하여�Movie�Clip편집

칸으로�들어간다.�

2.�자동차바퀴가�회전하는�Movie�Clip을�만든다.�

3.�Scene으로�나와�Stage에�Movie�Clip을�배치하고�Instance이름을�wheel이라고�

준다.�

�

4.�새로운�Layer를�하나�만들고�action이라고�이름을�준다.�

프레임Action을� 줄� 때� 이� Layer에� 있는� 프레임들에� 주려고� 한다.� 그렇게� 하면�

Action관리가�편리하다.�

5.�Action�Panel에�다음과�같이�입력한다.�

탐 구 

특정한�문자렬을�입력하면�동화상이�시작되게�하여라.�this._alpha의�값을�

변화시키면서�어떻게�되는가를�알아보아라.�
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�

여기서�duplicateMovieClip은�지정된�Movie�Clip을�복사하라는�Action이다.�

setProperty는�Movie�Clip의�속성을�설정해주는것이다.�그리고�random()은�우연수

를�발생시키는�함수이다.�

ramdom(300)은�1부터�300까지의�우연수를�생성한다.�

“wheel”+i라고�하였기때문에�wheel� Movie� Clip을�복사한�Movie� Clip의�이름은�

wheel0,�wheel1,�…,�wheel4로�된다.�

Movie를�실행시켜보면�자동차바퀴가�5개�더�생겨서�회전하는것을�알수�있다.�

6.�wheel�Movie�Clip의�_visible속성을�false로�설정하여�보이지�않게�한다.�

�

자동차바퀴를� 이동시키려고� 하는데� 복사본들의� 이름은� wheel0,� wheel1,� …,�

wheel4와�같이�되여있다.�그런데�원본에는�첨수가�없으므로�동시에�조종하기가�불편하므

로�보이지�않게�하였다.�

7.�wheel�Movie�Clip편집칸에�들어가서�1번프레임을�선택하고�Action�Panel에�다

음과�같이�입력한다.�
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�

Movie를�실행시켜보면�자동차바퀴가�회전하면서�이동하는것을�알수�있다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�
련습문제 

�

1.�례�10에서�자동차바퀴가�화면밖으로�나가면�반대쪽에서�다시�나오게�하여라.�

2.�자동차바퀴들이�겹치지�않게�하여라.(그러자면�두�바퀴사이의�거리가�바퀴의�크기

보다�크면�된다.)�

《≤

for명령문에 대하여 

for명령문의�일반적형태는�다음과�같다.�

for(초기값;�조건;�다음){�

� 명령문렬;�

}�

�

초기값에�있는�표현식을�한번�실행하고�조건이�참이면�명령문들을�실행하고�다

음에�있는�표현식을�평가한다.�

다음의�Action은�for명령문을�리용하여�1부터�100까지의�합을�계산한다.�

 

�

알아두기 
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실  습 
1. 간단한 오락만들기 

날아가는�비행기를�마우스로�찰칵하면�비행기가�폭파되는�오락을�만들어본다.�

1.�새로운�작업파일을�열고�Insert→New�Symbol지령을�실행한다.�

Create�New�Symbol대화칸에서�Movie�Clip을�선택하고�Name에�《비행기》라고�입

력한다.�

2.�비행기�Movie�Clip편집칸에서�비행기의�폭파장면을�Shape�Tweening을�리용하

여�만들려고�하므로�부분품을�서로�다른�Layer에�그린다.�

�

3.�매�Layer의�10번프레임에�빈�키프레임을�설정한다.�

4.�매�Layer의�10번프레임에�적당한�선들을�그려�비행기의�잔해를�만든다.�

�

그림에�있는�비행기는�1번프레임에�있는것이다.�

5.� 매� Layer의� 1번부터� 10번프레임사이의� 임의의� 프레임을� 선택하고� Shape�

Tweening을�적용한다.�
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�

6.�임의의�Layer의�1번프레임을�선택하고�stop()�Action을�적용한다.�

7.�매�Layer의�11번프레임에�빈�키프레임을�삽입한다.�

8.�임의의�Layer의�11번프레임에�stop()�Action을�적용한다.�

Library�Panel에서�Play단추를�찰칵하여�비행기폭파장면을�검사해본다.�

�

9.�Scene으로�나와서�1번프레임을�선택하고�Action�Panel에�다음과�같이�입력한다.�

�

Movie를�실행해본다.�
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2. Spot l ight만들기 

1.�배경으로�쓰일�화상을�불러오기�위해�차림표띠에서�File→Import지령을�실행한다.�

2.�My�Document→My�Pictures→Shed�in�Field.jpg파일을�불러온다.�

�

3.�화상의�크기와�위치를�조절하여�Stage에�맞춘다.�

�

4.�마스크로�쓰일�객체를�만들기�위해�새로운�Layer를�하나�만든다.�

5.�4각형도구를�선택한다.�

6.�Fill�Color는�Radial�Gradient로�설정한다.�

7.�경사도무늬의�시작색은�R=G=B=0,�Alpha=0,�끝색은�R=G=B=0,�Alpha=100으로�

설정한다.�
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�

8.�Spotlight의�크기만큼�Stage에�4각형을�그린다.�

�

9.�Transform�Fill도구를�리용하여�경사도무늬령역을�약간�줄인다.�

�

10.�경사도무늬바깥부분을�검은색으로�칠한다.�

여유를�많이�두는것이�좋다.�왜냐하면�마우스를�따라�움직이므로�가로,�세로가�Stage

의�2배가�되여야�하기때문이다.�
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�

11.�Layer�2의�모든�객체들을�선택한다.�

12.�mask라는�Movie�Clip으로�보존한다.�

13.�Properties�Panel에서�Movie�Clip의�Instance이름을�mask라고�달아준다.�

�

14.�Layer�2의�1번프레임을�선택한다.�

15.�Action�Panel에서�Actions→Movie�Clip��

Control→startDrag를�두번찰칵한다.�

16.�Insert�a�target�path를�찰칵하여�Insert�

Target�Path대화칸을�펼친다.�

17.�Notation에서�Dots,�Mode에서�Absolute

가�선택되여있는가를�확인한다.�

18.�mask를�선택하고�OK단추를�찰칵한다.�

�

�

�

�

�

�

�

�

�

�

�

�
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19.�Lock�mouse�to�center를�선택해준다.�

�

Movie를�재생해본다.�Mask�Movie�Clip이�마우스를�따라�움직이면서�배경그림이�보

인다.�

3. 마우스지시자 표시/숨기기 단추만들기 

1.�단추로�쓰일�4각형을�하나�만든다.�

2.�Text도구를�리용하여�Show라고�입력하고�4각형안에�배치한다.�

�

3.�4각형과�Text를�선택하고�show라는�Button�Symbol로�보존한다.�

4.�Button�Symbol편집방식으로�들어간다.�

5.�Hit에�키프레임을�추가한다.�

6.�Hit에�있는�Text를�선택하고�삭제한다.�

7.�Scene으로�나간다.�

8.�Library�Panel에서�show를�선택한다.�

9.�오른쪽찰칵하여�Duplicate지령을�실행한다.�
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�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

10.�hide라는�Button�Symbol로�보존한다.�

11.�hide단추를�Stage에�배치한다.�

12.�Button�Symbol편집방식으로�들어가서�Up프레임에�있는�Text를�Hide로�바꾸어

준다.�

13.�Scene으로�나간다.�

14.�4각형도구를�찰칵한다.�

15.�Fill�Color는�검은색,�Stroke�Color는�No�Color로�설정한다.�

16.�Stage에�바른4각형을�하나�그린다.�

�

17.�4각형을�45゜회전시킨다.�
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18.�4각형의�아래절반부분을�선택하고�삭제한다.�

�

19.�Free�Transform도구를�리용하여�3각형의�가로길이를�절반으로�줄인다.�

20.�다음�Option에서�Envelope를�선택하고�3각형을�변형한다.(아래왼쪽그림)�

�

�

�

�

�

�

�

�

21.�이�도형을�시계바늘반대방향으로�45゜회전시킨다.(오른쪽그림)�

22.�이것을�arrow라는�Graphic�Symbol로�보존한다.�

23.�이것을�다시�mouse라는�Movie�Clip으로�보존한다.�

24.�mouse�Movie�Clip을�선택하고�오른쪽찰칵하여�Edit�In�Place를�실행한다.�

25.�10,�20번프레임에�키프레임을�추가한다.�

26.�10번프레임에�있는�마우스지시자의�Alpha값을�40으로�설정한다.�

27.� 1~19번프레임을�선택하고�오른쪽찰칵하여�

Create�Motion�Tween을�실행한다.�

28.�Scene으로�나간다.�

29.� Properties� Panel에서� mouse� Movie�

Clip의�Instance이름을�pointer라고�달아준다.�

�

�

�
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30.�Action�Panel에서�startDrag를�두번찰칵한다.�

31.�Insert�a�target�path를�찰칵하여�나타나는�대화칸에서�pointer를�선택하고�OK

를�찰칵한다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

32.�Lock�mouse�to�center를�선택해준다.�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

33.�show단추를�선택하고�Action�Panel

에서� Objects→Movie→Mouse→Methods→�

Show를�두번찰칵한다.�

�

�

�
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�

�

�

�

�

�

�

�

34.�hide단추를�선택하고�hide를�두번찰칵한다.�

Movie를�실행해본다.�hide단추를�찰칵하면�마우스지시자가�없어지고�show단추를�찰

칵하면�다시�나타난다.�

4. 마우스지시자만들기 

1.�Movie의�배경색을�000033(R=G=0,�B=33H)으로�설정한다.�

2.�원형도구를�선택한다.�

3.�Fill�Color를�Radial�Gradient로�설정한다.(시작색은�R=G=B=255,�Alpha=100,�

끝색은�R=G=B=255,�Alpha=0)�

�

4.�Stroke�Color는�No�Color로�설정한다.�

5.�Stage에�적당한�크기의�원을�그린다.�
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�

6.�Free�Transform도구를�리용하여�원을�가로방향으로�축소한다.�

�

7.�원을�선택하고�Graphic�Symbol로�보존한다.�

8.�Graphic�Symbol을�복사하고�회전시켜�별모양을�만든다.�

�

9.�모두�선택하여�star라는�Movie�Clip으로�보존하고�Properties�Panel에서�star라

고�Instance이름을�정한다.�

10.�2,�3번프레임에�키프레임을�추가한다.�

11.�1번프레임을�선택하고�Action�Panel을�펼친다.�

12.�startDrag�Action을�적용한다.�
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�

13.�2번프레임을�선택하고�Actions→Variable→set�variable을�두번찰칵한다.�

�

14.�Variable에�CopyStar라고�입력한다.�

15.�Value에는�Number(CopyStar)+1이라고�입력한다.�그리고�Expression을�선택

해준다.�

�
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16.�Actions→Conditions/Loops→if를�두번찰칵한다.�

17.�Condition에�Number(CopyStar)>5라고�입력한다.�

�

18.�set�variable을�두번찰칵한다.�

19.�Variable에�CopyStar라고�입력한다.�

20.�Value에는�1이라고�입력하고�Expression을�선택한다.�

�

21.�Actions→Movie�Clip�Control→duplicateMovieClip을�두번찰칵한다.�

�

오른쪽�Script칸에�Action이�적혀진것을�알수�있다.�

Target는� 복사할� Movie� Clip의� Instance이름을� 의미하며� New� Name은� 복사된�

Movie�Clip의�새로운�Instance이름,�Depth는�복사된�Movie�Clip의�깊이이다.�

22.�Target에는�star,�New�Name에는� “star”+CopyStar,�Depth에는�CopyStar를�
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입력한다.�New�Name에서는�Expression을�선택한다.�

�

23.�setProperty를�두번찰칵한다.�

24.�Property에서는�_rotation(Rotation)을�선택하고�Target에는�“star”+CopyStar,�
Value에는�random(72)을�입력한다.�

�

이것은�새로�복사된�Movie�Clip을�회전시키라는�뜻이다.�

25.�3번프레임을�선택하고�goto를�적용한다.�

26.�Frame을�2로�설정한다.�



�

�176�

�

Movie를�재생해보면�별모양이�마우스를�따라다니는것을�알수�있다.�

5. 음성조절단추만들기 

1.�단추로�쓰일�4각형을�하나�그린다.�

2.�On이라는�Text를�만들고�4각형안에�배치한다.�

�

3.�4각형과�Text를�모두�선택하고�On이라는�Button�Symbol로�보존한다.�

4.�Button�Symbol편집방식으로�들어가서�Hit프레임에�키프레임을�추가하고�Text를�

삭제한다.�

5.�Scene으로�나간다.�

6.�Library�Panel에서�On단추를�하나�복사하여�Off라고�이름을�단다.�

7.�Off단추를�Stage에�배치한다.�

8.�Button�Symbol편집방식으로�들어가서�On을�Off로�바꾼다.�
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�

9.�차림표띠에서�File→Import지령을�실행하여�음성파일을�하나�불러온다.�

Library�Panel을�보면�방금�불러온�음성파일이�있는것을�볼수�있다.�

�

10.�차림표띠에서�Insert→New�Symbol지령을�실행한다.�

11.�Create�New�Symbol대화칸에서�sound라는�Movie�Clip으로�설정한다.�
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�

그러면�Movie�Clip편집방식으로�들어간다.�

12.�1번프레임을�선택하고�Properties�Panel의�Sound에서�앞에서�불러온�파일을�선

택한다.�

�

13.�Loop값을�100으로�지정한다.�

여기서�지정한�값만큼�음성이�반복된다.�

14.�Sound가�Off되는�부분을�만들기�위해�2번프레임에�키프레임을�추가한다.�

15.�2번프레임에�stop�Action을�적용한다.�

16.�Scene으로�나간다.�

17.�Library�Panel에서�sound�Movie�Clip을�끌어서�Stage에�배치한다.�보이지�않

으므로�적당한�위치에�배치한다.�

18.�Properties�Panel에서�sound�Movie�Clip의�Instance이름을�sound라고�설정

한다.�

19.�On단추를�선택하고�Action�Panel에서�Deprecated→Actions→tellTarget를�두

번찰칵한다.�

�
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20.�Insert�a�Target�Path를�찰칵한다.�

21.�Insert�Target�Path대화칸에서�sound를�선택하고�OK를�찰칵한다.�

�
22.�goto�Action을�적용한다.�

�
23.�Off단추를�선택하고�tellTarget를�적용한다.�

24.�앞에서와�같이�sound�Movie�Clip을�선택한다.�

25.�goto�Action을�적용한다.�

26.�stopAllSound를�적용한다.�

�

Movie를�재생해보면서�단추들의�기능을�확인한다.�
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6. Act ion을 리용하여 그리기도구만들기 

�

ActionScript를�리용하여�선도구와�4각형도구의�기능을�수행하는�Movie를�만들어본다.�

�

1. 단추만들기 

�

1.�새로운�작업파일을�열고�Insert→New�Symbol지령을�실행한다.�

2.�Create�New�Symbol대화칸에서�Name에�line_tool이라고�입력하고�Behavior에서�

Button을�선택하고�OK를�찰칵한다.�

�

3.�선택되지�않은�상태의�선도구로�쓰일�Button�Symbol을�만든다.�

�

4.�Scene으로�나가서�다시�Insert→New�Symbol지령을�실행한다.�

5.�line_tool_selected라는�이름의�Button�Symbol을�하나�만든다.�

�



�

� 181

이것은�선택된�상태의�선도구로�쓰일�Button�Symbol이다.�

6.�같은�방법으로�4각형도구로�쓰일�Button�Symbol들을�만든다.�

�

2. ActionScript작성 

�

1.�선도구로�쓰일�두개의�단추를�같은�위치에�배치한다.�그리고�Instance이름을�단추이

름을�그대로�준다.�

�

같은�위치에�두개의�단추를�배치하여놓은것은�선택되였을�때는�선택된�단추가�보이게�하

고�선택되지�않았을�때에는�그에�해당한�단추가�보이게�하기�위해서이다.�

2.�4각형도구로�쓰일�두개의�단추도�Stage에�배치한다.�

3.�《시작》이라는�단추를�하나�만들어�Stage에�배치하고�Instance이름을�start라고�

준다.�

�
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4.�start�Button�Symbol을�선택하고�Action�Panel에�다음과�같이�입력한다.�

�
5.�Timeline에서�1번프레임을�선택하고�Action�Panel에�다음과�같이�입력한다.�

�
which_tool이라는�변수를�만든것은�어느�도구가�선택되였는가를�식별하기�위해서이다.�

6.�line_tool단추를�선택하고�Action�Panel에�다음과�같이�입력한다.�

�
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두개의�도구가�동시에�선택되는�현상을�없애기�위하여�line_tool단추에서�rectangle_�

tool과�rectangle_tool_selected에�대하여�조작하였다.�

7.�line_tool_selected단추를�선택하고�Action�Panel에�다음과�같이�입력한다.�

�

8.�같은�방법으로�4각형도구로�쓰일�단추들에도�Action을�적용한다.�

�
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Movie를�실행시켜보면�선도구나�4각형도구가�한번�찰칵하면�선택되고�다시�찰칵하면�

해제되는것을�알수�있다.�

start�Button�Symbol을�만들어놓은것은�이�단추를�찰칵하면�모든�단추도구들이�선택되

지�않은�상태로�만들기�위해서이다.�

9.�empty라는�이름을�가지는�빈�Movie�Clip을�만들어�Stage에�배치한다.�

�
그림에서�가운데�있는�흰�원이�empty�Movie�Clip이다.�

10.�empty�Movie�Clip을�선택하고�Action�Panel에�다음과�같이�입력한다.�

�
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Movie를�실행시켜�선도구와�4각형도구가�정확히�동작하는가를�확인한다.�

11.�start�Button�Symbol을�선택하고�Action�Panel에�다음과�같이�입력한다.�

�
draw.clear()는�그리기지령으로�그린것들을�모두�지우라는�뜻이다.�

이렇게�하여�Movie가�완성되였다.�

�

�

�

�

�

�

�

�

�

�

�
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�
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�

�

탐 구 

빈�작업파일을�열고�다음�그림과�같이�Action�Panel에�입력하여라.�Movie를�

실행하면�어떻게�되는가?�
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콤퓨터상식             �

《싸이버공간(CyberSpace)》이라는� 단어는�1984년�어느�한�나라의�과학

환상소설가가�자기가�쓴�환상소설에서�콤퓨터망이�만들어내는�《세계》를�가리키

는�개념으로�지어낸�말이다.�그로부터�10년이�지나�인터네트와�같은�물리적기반

을�통하여�이�싸이버공간은�현실적으로�생성되고�발전하게�되였다.�

지금까지�인류는�륙로(철도,�자동차),�바다길(선박),�항공로(비행기)�등�물리적

공간에�있어서의�사람과�물건의�활동수단을�발전시켜왔다.�이것은�과학기술이�발전

한�결과이며�지구상에는�건축물이나�생산품�등의�《인공물》로�가득차게�되였다.�

인터네트와�같은�콤퓨터망은�인류에게�새로운�활동마당을�만들어내고있다.�

인간은�콤퓨터를�계산만을�위한�도구로가�아니라�여러가지�의도와�목적을�실

현하는�수많은�사람들의�활동공간으로서의�기능도�수행하게�하고있다.�

말하자면�지난�시기�공업화가�물리적공간을�인공물로�가득채움으로써�오늘

우리에게�도시와�같은�생활공간을�형성해준것과�같이�정보화에�의하여�싸이버공

간안에�많은�인공물들�례를�들어�《가상상점》,�《가상미술박물관》,�《가상도서

관》,�《전자상업거래》�등�《가상현실세계》라는�생활공간을�형성해나가고있다.��
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콤퓨터(제1중학교 제3학년용) 
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